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1 About this Manual

Saia PCD® Supervisor is a supervisor tool for Saia PCD devices. It is based on the
powerful Niagara 4.3 software framework and uses the Saia PCD® S-Bus over Ether-
net.

This manual describes how to install Saia PCD® Supervisor and configure the SaialP-
Network to allow Saia PCD devices data to be made accessible to the Niagara frame-
work.

It consists of the following main sections:

2 About Saia PCD® Supervisor
This section gives an introduction to basic system principles and the
Saia PCD® Supervisor user interface.

3 Securing Saia PCD® Supervisor
This section provides guidance on security issues to be considered when in-

stalling and using Saia PCD Supervisor.

4 Installing Saia PCD® Supervisor
This section describes how to install Saia PCD® Supervisor

5 Licensing Saia PCD® Supervisor
This section describes how to obtain and install Saia PCD® Supervisor license

files.

6 Creating/Enginering a project
This section describes the process of engineering Saia PCD® Supervisor.

6.1 Initial Setup
This section covers the procedures that must be followed to get Saia PCD®

Supervisor ready for use.

6.2 Manual creation of data points
This section covers the process to create communicated datapoints manually.

6.3 Using the “Saia PG5 Data Import Wizard”
This section covers the process to import the datapoints from the PG5 project

using the Saia PCD Data Import Wizard.

6.4 General functions
This section describes general function can be used inside of the Saia PCD
Supervisor. For example how to configure Saia PCD® Supervisor to control
schedules times in the Saia Burgess Controls system.

6.5 Connect to 3rd Party Systems
This section covers the process to import the datpoints and communicate with

third party Devices. For example BACnet devices.
6.6 Creating Schematics (Operator Views

This section gives basic guidance on creating dynamic operator views that en-
able end users to navigate and access the system.

Manual Saia PCD® Supervisor | Document 27-651 ENG01 | 2017-09-27 1-1
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6.7 Set Up for Saia PCD® Supervisor Users
This section describes how to configure users in Saia PCD® Supervisor to

n ensure each user only has access to the appropriate information.

6.8 Backup & Restore
This section describes how to backup/restore the Saia PCD® Supervisor con-

figuration.

7 Using Saia PCD® Supervisor
This section covers general day-to-day operating procedures aimed at end
users.

It is assumed that you understand how to use Niagara 4.3. For further in-

ﬂ formation you should refer to the Niagara documentation which is installed
during the Saia PCD® Supervisor installation. It can be accessed from the
Saia PCD® Supervisor Help menu.
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Conventions Used in this Manual

1.1 Conventions Used in this Manual

There are numerous items and instructions in this manual, the conventions below are
designed to make it quick and easy to find and understand the information. n

- Menu commands are in bold type.
- Buttons, and options in dialogue box that you need to select are in bold type.
- The names of text boxes and dialogue boxes are in bold type.

- Key combinations that you should press appear in normal type. If joined with a plus
sign (+), press and hold the first key while you press the remaining one(s). For ex-
ample CTRL+S indicates holding down the control key while pressing S.
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Contacting Saia Burgess Controls
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2 About Saia PCD® Supervisor

Saia PCD® Supervisor is a supervisor tool for Saia PCD Control Systems. It is based

on the powerful Niagara 4 software framework. This section describes the key features

of Saia PCD® Supervisor and its user interface, and introduces some of the terminology n
used.

Using the supplied SaialPNetwork (SBC Communication Driver), Saia PCD® Supervi-
sor can connect to multiple Saia PCD devices and access device data in order to moni-
tor or adjust the operation. System data is held within a database and is accessible in
raw format or presented in specially-designed graphical pages known as schematics or
Operator Views (PX view).

Saia PCD® Supervisor connects to the Saia PCD devices network over Ethernet. This
gives access to the Saia PCD devices on the associated LAN (Local Area Network)
and through S-Bus Gateway functionality serial networked devices.

Ethernet T

PCD1.M2220-C15 PCD7.D410DT5F
as Gateway PG5 programmable
MB Web-Panel

{Q

PCD1 E-Line programmable I/O modules PCD1.M21 10Ri as Sub-Station

» Ethernet communication to PCD’s and on PCD'’s over RS-485 which are connected behind a gateway.
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21.1

21.2

2-2

Saia PCD® Supervisor Architecture

Saia PCDe® Supervisor Architecture

Platform

In computing, a platform describes some sort of hardware architecture or software
framework (including application frameworks), that allows software to run. Typical
platforms include a computer’s architecture, operating system, programming languages
and related runtime libraries or graphical user interface

The Platform is the topmost level of configuration and may be compared to the control
panel on a PC. In this area of Saia PCD® Supervisor where you can set up:

- Communications

- Install Licenses

- Find fault issues

- Start / Stop stations

- Copy stations

- Backup stations

- Handling certificates

- Handling Lexicons for multilingual projects

- Checking the TCP/IP configuration of the Host computer
- Accessing Remote File system

Access to the Platform requires the user to login, using the same credentials required
to login to the Windows PC. In case of some modification Passphrase is also needed.

Station

Software running on a Niagara platform that is the main unit of server processing in
the Niagara architecture. A station runs the components of the Niagara framework and
provides the access to view and control these components via the Workbench or web
browser. Think of the station as the application built by the engineer to integrate the
data and design a user interface.

The Station manages communications with the Saia Burgess Controls system(s) and
acts as a ‘container’ for all other configuration settings and functions. These include:

Services  such as alarm listening and monitoring and the Saia PG5 Data Import

Wizard

Drivers for managing access to data in the Saia Burgess Controls system(s)
and other systems.

Files schematic/Operator Views used to present system information on

remote client devices
many other services are possible

Manual Saia PCD® Supervisor | Document 27-651 ENG01 | 2017-09-27
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214

2.1.5

Access to the Station settings requires the user to login (different to platform login).
Initial system configuration is achieved using a default admin/engineering user account
which is set up when the Station is created. Once configuration is complete further
accounts can be added that grant different users specific access rights according their

role (see 6.7 Set Up Saia PCD Supervisor Users).

Platform Daemon
A program that is executed as service in the background.
In an other way it is compact executable program that enables a user to access plat-

form tools through the Workbench. The Platform Daemon enables to run the stations
on the local PC.

SBCIpNetwork driver

The SBClpNetwork driver defines the communication settings to a Saia Burgess Con-
trols system and provides access to data held in its controllers and devices, including:

Points Input, Output, Register, Flag, Timer, Counter, DataBlock and text Block.
Histories  values logged in HD log modules.
Alarms for monitoring alarm messages generated within the

Saia Burgess Controls system.

Other Drivers (open points)

The Saia PCD® Supervisor is based on the Tridium Niagara N4 framework. Therefore

it supports a wide range of additional drivers, suitable for interfacing with other manu-

facturer’s building automation systems and products. This enables the monitoring and
control of these systems to be fully integrated with the management of a Saia Burgess
Controls system within a common supervisor.

Support for other drivers requires one or more additional open driver packs. For de-
tails of order codes and point counts refer to the Saia PCD® Supervisor Data Sheet
(34-001_DS_Saia-PCD-Supervisor).

e such an open driver can be: BACnet, Modbus etc.
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2.2 User Interface Application (Host PC)

This section introduces the main features of the Saia PCD® Supervisor user interface.

Menu Bar
Tool Bar ——a
Locator Bar —

View Changer

Nav Tree —lo
202 .
supervisor View Pane
Saia PCD*
Palette o
2.21 Nav Tree (navigation panel)

The Nav tree (or navigation panel) provides navigation around the elements, folders
and files in Saia PCD® Supervisor. It is configurable under “user” by “user”. Once con-
figured, you can view devices and points in a Saia Burgess Controls system.

For help on using the Nav tree, refer to chapter 7.2.2.2 Nav Tree.

2.2.2 Palettes

It is a collection (or library) of components in a hierarchical view that can be copied
and pasted where needed — Wire Sheet, Property Sheet, Px View or Palette side bar.

Palettes are useful when configuring certain elements in the system. There are many
Palettes available, but the most commonly used in Saia PCD® Supervisor are:

o Alarm . for configuring Alarm handling

* Schedule ......cccccceeiiinnnin for configuring Time Schedules

* History ..o for configuring Histories (Plots)

+  kitControl ........ccceeeiiiieenn. for creating control logic in Saia PCD® Supervisor

* bajaui.....iiiiii for configuring Graphics and accessing default images.
o KitPXeoiiiiiieiieee for configuring Graphics and accessing default images.
o KitHVAC .......ooovviivieeeeee, for configuring Graphics and accessing default images.
o KitPXN4Svg.....cceeeeeiinnn for configuring Graphics and accessing default images.
* WebChart.....cooovvvvvvieenen. for configuring Graphics and accessing default images.

+ SBCOfflineEngineering .... service to import easily resources of a Saia PCD device
......................................... from PG5 project

* SDBC.iiiiii e, for devices and points.
+ sbclconGallery.................. for images to build user screens.
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224

* honBACnetUtilities ........... for getting detailed information of BACnet points.

For help on opening and closing Palettes, refer to chapter 7.2.2.3 Palettes

Locator Bar

There is a fundamental navigation model in the Workbench which is similar to the URL
navigation used in the Web browsers.

When the URL is changed the URL referenced content is shown in the browser. A re-
membered history of the URLs is allowing back & forward navigation.

The ORD (Object Resolution Descriptor) is the universal identification system of Niaga-
ra and it is used throughout the Niagara framework. It unifies and standardizes access
to all information. And it is designed to combine different naming systems into a single

string.

The ORD can be:

absolute station:|slot:/Drivers/SBC$20Systems/SBCIpNetwork_Demo/Device1/
points/Heating1/Outside/Temperature/PhysVal”

relative slot:Outside/Temperature/PhysVal”

The locator bar provides similar functionality to the Nav tree. As you navigate around
the file system the locator bar will update to show the current location and view. It
shows the ORD (Object Resolution Descriptor)

For help on using the locator bar, refer to chapter 7.2.2.4 Locator Bar

View Pane & View Changer

The view pane is the principle work space for Saia PCD® Supervisor. When you first
run Saia PCD® Supervisor it will display the home page (shown above). As you navi-
gate through the system and select different items in the Nav tree, the view pane will
change to show different information or configuration pages.

Some elements may provide more than one type of view. For help on selecting the
required view, refer to chapter 7.2.2.5 View Pane & View Changer
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2.2.5 Client Devices

Saia PCD® Supervisor can be accessed via web clients while an IP connection is pos-
sible between the client device and the PC running Saia PCD® Supervisor.

ence to the user as when it is accessed on the main PC depending on the device being

n Once accessed Saia PCD® Supervisor via Web client, it provides a similar user experi-
used to access. The Web Server - Client connection can use JAVA or HTML5.

4 Config X+ = el
€ | ® 28 https//ocalhost/ord/stations c Search %8 ¥ A9 E =
Config [e}NC] 4 PropertySheet  [v] (X

Octions & Topics [ lot etails

Display Name Value Commands

W Station Name
W Sysinfo ¢
@ services Service Container
© Drivers Driver Container

@ Apps App Container

Palette ®
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3 Securing Saia PCD® Supervisor

3.1 Introduction

The purpose of this section is to provide the information necessary for those involved
in the installation and maintenance of a product or system to understand the require-
ments for configuring and managing the security of the product or system. n

General Security Best Practice for Saia Burgess Controls IP Based Product manuals
,26-776_Manual_TCP-IP-Ethernet* and ,26-867_ Manual_TCP-IP-Enhancements®.

Both documents are available from the Saia Burgess Controls support web site
www.sbc-support.com.

3.2 Disaster Recovery Planning

It is a documented process or set of procedures to recover and protect a business IT
infrastructure in the event of a disaster. Such a plan, specifies procedures an organiza-
tion is to follow in the event of a disaster.

When developing the disaster recovery plan ensure that it includes ALL data required
to restore system operation, including:

- Configuration files for platform(s) and station(s)
- Database objects

- License and certificate files

- Station Backup

- Station Copies

See chapter 6.8 Backup & Restore for details.

3.3 Physical and Environmental Considerations

The PC running Saia PCD® Supervisor should, where possible, be secured against
unauthorised physical access.

34 Security Updates and Service Packs

Ensure the PC running Saia PCD® Supervisorr and any client devices have the latest
operating system updates installed, and the latest version of Saia PCD® Supervisor is
being used.

Saia Burgess Controls software is tested against the latest service packs and up-
dates applicable at the time of release. For significant operating system and Java
updates / service packs, please check the Saia Burgess Controls support web site

www.sbc-support.com for any compatibility issues.
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3.5

3.6

3.7

3.8

3-2

Virus Protection

Ensure the PC running Saia PCD® Supervisor and any client devices are running virus
protection software, and the virus definitions are kept up-to-date.

Some virus protection software may have an adverse impact on the performance of
Saia PCD® Supervisor. In such cases request that the Saia PCD® Supervisor directory
be excluded from on-access scan.

Further details can be found on the Saia Burgess Controls support web site
www.sbc-support.com.

Network Planning and Security

It is recommended that the Ethernet network used by the Building Management Sys-
tem (BMS) is separated from the normal office network using an air gap (separated wir-
ing and devices or layer 3 switches or virtual private network (VPN)). Physical access
to the Ethernet network infrastructure must be restricted. You must also ensure that the
installation complies with your company’s IT policy.

The use of a firewall and Intrusion Detection System (IDS) from a reputable provider
of security products is recommended for any Saia PCD® Supervisor installation. Fol-
low best practice for the products chosen as well as any corporate IT policy where the
installation is made. Lock down the products to the particular port you've configured for
Saia PCD® Supervisor HTTPS and HTTP.

Always follow the guidelines PDF-Documents:

manual..........cccveeeieeeeiieen 26-776_Manual_TCP-IP-Ethernet
manual..........cccccoeieeii 26-867_Manual_TCP-IP-Enhancements.
manual...........cccc 26-620_Manual_Security-Rules
manual.........cccoouveeeeeeieeeeee Niagara®™ Hardening Guide
instruction................................ 30-002_Internet-Security-Instructions_SBC

instruction for using VPN router .. 30-004_VPN-Router

You must also take steps to ensure the security of any other networks connected to
Saia PCD® Supervisor (e.g. BACnet).

Virtual Environments

Follow best practice for the products chosen as well as any corporate IT policy where
the installation is made.

Securing Wireless Devices

If a wireless network is being used it must be secured according to your company’s IT
policy.
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3.9

3.10

3.1

3.12

3.12.1

System Monitoring

For any Saia PCD® Supervisor installation, especially when connected to the internet,
Saia Burgess Controls recommends the use of an Intrusion Detection System (IDS)
from a reputable provider of security products. Follow best practice for the products
chosen as well as any corporate IT policy where the installation is made.

Saia PCD® Supervisor logs (Audit History) changes made to its own configuration
and adjustments to the Saia Burgess Controls control system. Many IDS and firewall
products offer a complete solution for recording all the traffic coming in and out of the
Saia PCD® Supervisor PC, providing users with the ability to record all activity at the
lowest level.

Securing Access to the Operating System

Ensure the PC running the Saia PCD® Supervisor and any PCs used for Saia PCD®
Supervisor clients are secured according to your company’s IT policy.

Access Control

All Saia PCD® Supervisor files should be protected from read and write access by
people and software not authorized. Saia Burgess Controls recommends following best
practice for securing system objects, such as files, and using access control appropri-
ately.

If Windows users are granted access to the filing system location of the Saia PCD® Su-
pervisor project then it is possible for them to inadvertently (or deliberately) open, de-
lete or edit any of the configuration and data files of independently of their Saia PCD®
Supervisor workgroup settings.

Securing Saia PCD® Supervisor

The Saia PCD® Supervisor software should be configured during installation and
operation following best practice. Follow the installation procedure as described in this
manual. In addition, refer to the Niagara 4 help system and Niagara 4 security guide-
lines.

Default Admin User of a Station

Initial system configuration is achieved using a default admin/engineering user account
which is set up with a strong password when a Station is created.
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3.12.2

3.12.3

3.13

34

Passphrase

The passphrase, specified during the Saia PCD® Supervisor installation process, pro-
tects sensitive data on any station that you create and will be required if the Saia PCD®
Supervisor station is to be moved to another PC e.g. moved to the site PC, or restored
after a PC failure.

Set up Other Users for the Station

Once configuration is complete (using the default admin user) further user accounts
must be added that grant different users specific access rights according their role.
Saia PCD® Supervisor enforces the use of strong passwords.

For further details, see chapter 7 Using Saia PCD® Supervisor

Saia PCD® Supervisor Security Check List

a
a

00

Latest version of Saia PCD® Supervisor is being used.

Saia PCD® Supervisor installation files, configuration files (including station back-
up), certificates and licenses are included in disaster recovery plan.

The PC running Saia PCD® Supervisor should, where possible, be secured against
unauthorized physical access.

The Ethernet network (and any other networks) that the PC is connected to is se-
cured, e.g. by the use of firewalls and intrusion detection systems.

The PC is running the latest version of the Windows operating system, with all
updates and service packs.

The PC is running virus protection software.

Appropriate user accounts are set up on PC and access to files is restricted to only
those who are authorized.

Saia PCD® Supervisor is configured to use HTTPS using a certificate from a trust-
ed Certificate Authority.

Saia PCD® Supervisor users are configured as required.

Ensure Saia PCD® Supervisor is configured to backup data regularly to a secure
location as per your company’s backup policy.
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Requirements, Optaining

4 Installing Saia PCD® Supervisor

This section describes how Saia PCD® Supervisor should be installed to ensure that it
operates correctly. The following steps are required to install Saia PCD® Supervisor:

41 Installation Requirements

4.2 Obtaining the Saia PCD® Supervisor Software n
4.3 Installing the Saia PCD® Supervisor Software

4.4 Installing the Platform Daemon

4.5 Configuring the Windows Firewall
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Installing the Software

4.1 Installation Requirements

Before installing, or upgrading, ensure that the PC meets the system requirements.
Refer to the Saia PCD® Supervisor Data Sheet (34-001_DS_Saia-PCD-Supervisor).

The PC on which Saia PCD® Supervisor is to be installed must have TCP/IP access to
the Saia Burgess Controls network.

4.2 Obtaining the Saia PCD® Supervisor Software

n Navigate to the Saia Burgess Controls Technical Support web site at
http://www.sbc-support.com --> Software / Saia PCD® Supervisor
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Installing the Software

4.3 Installing the Saia PCD® Supervisor Software

1. Log in to the PC as someone with Administrator rights.

It is recommended that you close all other programs before installing
Saia PCD® Supervisor. However, do not close any virus protection soft-
ware.

2. Presently the installer works from the local hard drive only. Therefore the installer
must be copied to a local folder first (e.g. C:\Temp)

3. Run ‘Installer_x86.exe’ (for 32-bit operating systems) or n
‘Installer_x64.exe’ (for 64-bit operating systems), and
wait for the first installation screen to appear.

@ Q | . v Computer » Local Disk (C:) » SBCSupervisor » SBC Supervisor »

Organize » Open Mew folder
I Favorites MName . Date medified Type Size
B Desktop J dev 4/18/2017 4:20 PM File folder
4 Downloads J dist 4/18/2017 4:20 PM File folder
2| Recent Places J docs 4/18/2017 4:20 PM File folder
J install-data 4/18/2017 4:20 PM File folder
74 Libraries J javadoc 4/18/2017 4:20 PM  File folder
3 Documents . modules 4/18/2017 4:20 PM File folder
J‘F Music | overlay 4/18/2017 4:21 PM File folder
&= Pictures |%I‘ Installer_x64 4/13/2017 11:15 AM  Application 518 KBl
B8 videos ?_x!' Installer_x86 4/13/2017 11:15 AM Application 480 KB
ﬁf Uninstaller_x64 4/18/2017 2:17 PM Application 395 KB
18 Computer ﬁf Uninstaller_x86 4/13/2017 11:15 AM  Application 366 KB
£, Local Disk (C)

4. Follow the on-screen instructions

@' User Account Control @

((j‘] Do you want to allow the following program to make
./

changes to this computer?

@ Program name:  Installer_x54.exe
= Verified publisher: Niagara (Tridium, Inc.)

File arigin: Hard drive on this computer

\:f Show details Yes ] [ Mo J

Change when these notifications appear
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4-4

®) an
supervisor soCc*

Saia PCD" Shu BURGESS CONTROLS

‘Welcome to the Saia PCD Supervisor Installl

This prograrm will install the Saia PCD Supervisor software
onto wour computer.

Build 4.3.58.18
Thu Jun 01 13:24:27 Eastern Daylight Time 2017

niagaratt

framework

Read and accept the license agreement.

") an
supervisor sSoC:

Sala PCO" SR BURGESS CONTROLS

Flease read the following license agreement:

End User License Agreement July 28, 2015 =

TRIDIUM, INC. (" TRIDIUM") HAS DEVELOPED A STANDARDIZED
ARCHTECTURE AND RELATED SOFTWARE FOR INTERCONMECTING
DEVICES AND CONMTROLLERS THAT INCLUDES ELEMENTS S0LD
UMNDER THE MNAME "MIAGARA FRAMEWORK(R)" THESE ELEMENTS
TOGETHERWITH THE PRINTED OR ONLINE DOCURMENTATION
FURMISHED BY TRIDIUM IN CONJUNCTION WITH THEM, WHETHER
ACQUIRED BYYOU AS A SOFTWARE ITEM OR EMBEDDED IN
HARDWARE ARE REFERRED TO BELOWY AZ THE "LICENSED
SOFTWARE" AND ARE LICENSED UNDER THIS END USERLICENSE | =

Do you accept this agreement? D%es @ No

< Back Mead =

Installing the Platform Daemon

5. Change the destination folder (if required). The default path is

"C:\SBC\SaiaPCDSupervisor".

n If you enter a new path it must not contain spaces
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Configuring the Windows Firewall

") i
supervisor socC:

sala PCO” SAuh BURGESS CONTROLS

Destination Falder
[CASBC\SaiaPCDSupervisor |

Default ][ Browse... ]
Space Renuired 1437690 K
Space Available 91997262 kK

This instance of Workbench will be used as an
installation tool
(1226293 K)

Install Documentation
(146 k)

< Back Next >

6. Add shortcuts to the Start Menu and Desktop.

S‘ai:PCDSu
®) ik
supervisor =tw [yl

Saia PCD” SR DURGESS CONTROLS

Install Start Menu Shorcuts
Install Deskiop Shortcuts

< Back Next >

7. Once the installation is complete the following screen is displayed.

—
Saia PCD Su

(")
supervisor —tw [wal

Sala PCO" AU BURGESS CONTROLS

Saia PCD Supervisor installation is completel

Would you like to?
Launch Saia PCD Supervsar
Install and Start Platform Dasmaon
[¥] Copy Daemon Data From Prior Version

niagaratt

framework
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44

4.5

4-6

Configuring the Windows Firewall

ensures sensitive data on any station that you create is protected. En-
sure that you remember it and keep it safe as it will be required to move
the configured Saia PCD® Supervisor to another PC.

n During the installation you will be prompted to create a passphrase which

Leave all three check-box checked and click the

Finish button. Then the software is installed and two %ﬂ) %&
icons are placed to the Desktop SellBtels) ol
¢

Installing the Platform Daemon

If there are other instances of Saia PCD® Supervisor (or Niagara) on the same PC then
the Platform Daemon must be installed. This will typically be set up during the installa-
tion process. It can also be installed and run manually.

1. Click Start and choose All Programs.
2. Navigate to the Saia PCD Supervisor folder.
3. Click Install Platform Daemon.

After a few seconds a command window should briefly appear with the following mes-
sage:

installdaemon: Niagara service successfully installed.

To check if the Platform Daemon is already running go to
Windows Control Panel - Administrative Tools = Services -
Niagara Services running

The running Niagara service can block communication ports depending on what type
of communication is configured.

Configuring the Windows Firewall

You may need to configure the Windows Firewall to allow Saia PCD® Supervisor to
communicate correctly.

To configure the Windows Firewall

1. Open the Windows Firewall.
- In Windows 10 or 8, type ‘Windows Firewall’ in the Search box

- In Windows 7, click the Windows Start button, type ‘Windows Firewall’ in the
Search box.

- Click Windows Firewall from the list of search results.

2. Click Allow a program or feature through Windows Firewall. The Allowed pro-
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Configuring the Windows Firewall

grams and features list is displayed.

Allow programs to communicate through Windows Firewall

To add, change, or remove allowed programs and ports, click Change settings.

What are the risks of allowing 2 program to communicate? ) Change settings
{0 For your security, some settings are managed by your system administrator.

Allowed programs and festures:

Mame Domain  Home/Work (Pri... Public  Group Policy *

Allow another program...

¥ Networking - Router Solicitation (ICMP.. [ Ves

¥ Networking - Timestsmp Requsst (ICM.. 0 = Ves

) Networking - Timestamp Request (CM... [ Ves

™ Niagers Runtime Leunchr 5] = No

@ Niagara Station Launcher o o No

I Niagara Workbench 5] = No

PTOTTIO0R T = = v

[ Performance Logs and Alets o O = No

¥iPoril O = Ves

: } Ves

Miagara Runtime Launcher O O No v
Miagara Station Launcher O O Mo | No =

. . R

Miagara Workbench O O No e

3. Scroll down the list and check that entries exist for Niagara Runtime Launcher,
Niagara Station Launcher, and Niagara Workbench for your Saia PCD® Supervisor
installation folder. If these programs do not appear in the list you will need to add
them (see procedure below).

Each installed instance of Niagara requires its own entries in the Firewall
settings.

4. If you need to change any settings click Change settings and edit the checkboxes
as required.

To add programs to the firewall:

1. Open the Allowed programs and features list as described above.

2. Click Change settings.

3. Click Allow another program. The Add a Program dialogue box is displayed.

Add a Program =)
Select the program you want to add, o cick Browse to find one thatis not
listed, and then cick OK.

Brograms:

B Access 2013

B8 Adobe Bridge cs5

| Adobe Device Central Cs5

$ Adobe ExtendScript Tookit CC

[ Adobe ExtendScript Tookit CS5

|8 Adobe Extension Manager CS5

B0 Adobe Help

[l Adobe Tlustrator CS5

I Adobe InDesign cs5

-L%-Adﬂbs LiveCydle Designer ES 8.2 8

path: C:\Program Files\Trend Control Systems|963

What are the risks of unblocking a program?

You can choose which netwark location types to add this program to.

[ etwork location types... [ add || cancel |

4. Click Browse and navigate to the Saia Burgess Controls Control Systems |
Saia PCD Supervisor | bin folder.

5. Double click the program to be added.

6. To add Niagara Runtime Launcher select nre.exe
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Configuring the Windows Firewall

7. To add Niagara Station Launcher select station.exe
8. To add Niagara Workbench select wb_w.exe

9. The program will appear highlighted in the Add a Program dialogue box. Click
Add to add the program to the firewall list. The dialogue box will close.

10. Repeat steps 3 through 6 to add the other programs.
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5.1

5.2

Licensing Saia PCD® Supervisor

Before Saia PCD® Supervisor can be used, it must be licensed. The license will allow
you to run the application on a single PC.

Obtain a Saia PCD® Supervisor License and Certificate

When an unlicensed installation of Saia PCD® Supervisor is run you will be prompted to
email certain details to Saia Burgess Controls in order for them to provide the relevant
license and certificate files.

To obtain a license:

1. Launch the Saia PCD® Supervisor ap-
plication, e.g. from the Start menu point
to All Programs > Saia Burgess Con-
trols Systems > Saia PCD® Supervisor
and then click Saia PCD® Supervisor.
The Request License dialogue box is
displayed. The pop up pictures shows
you the so called Host ID of the com-
puter. The Host ID is strictly connected
to that hardware of the PC. If the hard- =
ware is changed a new license must be
obtained.

nnnnnn

zzzzz

2. Email the requested information (list what is required....) to your local sales office
including the email address you would like the license files sent to.

3. Click Exit to close the dialogue box.

The Order Management Team will process your request, and email the license and
certificate files to the specified email address.

Install the Saia PCD® Supervisor License

Your Saia PCD® Supervisor license is mailed to you as a ZIP file containing a num-
ber of license and certificate files which need to be installed on the PC containing
Saia PCD® Supervisor, this can be done in two ways:

5.2.1 Automatic Licensing
5.2.2 Manual Licensing
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5.2.1 Automatic Licensing
Saia PCD® Supervisor can be licensed automatically via the [ . L - %
global license server providing the PC has internet access. |
If this is the case when Saia PCD® Supervisor is run after License Installed
your license request has been processed it will automati- .
cally be licensed and the files copied to the required folder. 1 | This machine is now licensed.

H 5.2.2 Manual Licensing

To install the license and certificate files:

1. Copy the ‘Licenses.zip’ file to the PC hard disc.

2. Extract all the files from ‘Licenses.zip’ to an empty folder. The folder should now
contain six files.

3. Copy the three ‘.license’ files to the
“C:\SBC\SaiaPCDSupervisor\security\licenses” folder.

4. Copy the three ‘“.certificate’ files to the
“C:\SBC\SaiaPCDSupervisor\security\certificates” folder.

5. You will now be able to launch the Saia PCD® Supervisor (Workbench) application.

5.3 Updating a License

If you purchase a license upgrade, e.g. for additional points, you will be emailed the
updated license files as a ZIP file containing a number of license and certificate files
and it will be necessary to upgrade the Saia PCD® Supervisor license. If the Saia PCD®
Supervisor PC PC is connected to the internet this should happen automatically - see
chapter 5.2.1 Automatic Licensing, alternatively the files can be copied manually -

see chapter 5.2.2 Manual Licensing.
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Initial Setup

6 Creating/Engineering a project (application, site, ..)

Building a site within Saia PCD® Supervisor involves creating a database that reflects
the structure, devices and points within the associated Saia Burgess Controls system.
In the Saia Burgess Control System mainly the S-Bus communication protocol is used.
However it is possible to use third party communication protocols depending on the
used license. A Point in the Saia PCD® Supervisor represents a value or state of an
item in the Control System (e.g. a point represents a value or state of a symbol from
the PCD controller).

For example:
“Outside_Air_Temperature_Sensor_Value” is the point name in the Saia PCD® Supervi-
sor, but it is actually communicated as “Register 100” from the proper PCD device.

The communication connection is based on Media type and Media address n
("Register 100") not on the symbol name.

There are two methods to build up the point database within Saia PCD® Supervisor:

* Manual creation of data points
* Using Saia PG5 data import wizard

You can use either one or both methods to build up your point database, according to
your requirements.

sor. Adding unwanted points will increase the memory usage and affect the remaining

n It is the best practice to only add the points required for use in the Saia PCD® Supervi-
license count. Keep in mind that the points for HDLogs are imported to get it working

properly.

Goto ..

6.1 Initial Setup

6.2 Manual creation of data points

6.3 Using the “Saia PG5 Data Import Wizard”
6.4 General functions

6.5 Connect to 3rd Party Systems

6.6 Creating Schematics (Operator Views
6.7 Set Up Saia PCD® Supervisor Users

6.8 Backup & Restore
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6.1

6.1.1

6.1.2

6-2

Initial Setup

Initial Setup

When Saia PCD® Supervisor is run for the first time you will need to work through an
initial setup procedure which involves the following steps:

Launch the Saia PCD® Supervisor Application
1. Click Windows Start button and choose All Programs.

2. Navigate to the Saia PCD Supervisor and open it.

3. Click Saia PCD Supervisor. The Saia PCD® Supervisor application window will be
opened. This program is called as Workbench in relation of Niagara N4 environ-
ment. (It can happen that the start of the program takes a bit more time, please be
patient.)

[« Saia PCD® Supenvizor - 5 X

< O- o Ao - B a3 #f

My Host: SZASLTIOSGNF2 globaldshoneywell.com  : SBChometml

Saia PCD®
- Palette [=a]
W X A |§ socofflinetngincering
3 sala PG Data Import Wizard
Host ID: erl?CEFVFASDGIGZ—ZCAé

Help Conteats 4
‘Third Party Licences niagara
End User Licence Agreement Version: 42,3634

Copyright Tridium, Inc 1996-2017

Open the Platform

1. In the Nav tree of the Saia PCD® Supervisor tree right-click on MyHost and choose
Open Platform. The Connect dialogue box is displayed.

<@ Saia PCD® Supenvisor

File Edit Search Bookmarks Tools Window Help

My Host: SZ43L TJ05GWF2.globaldshoneywell.com  © SBChomehtml

K O ) My Network

@ MyHost: SZ43LTI06GWF2.global.dshoneywell
Disconnect
@ My File System =

@ My Modules Open Platform

Open Station

M

sh Tree Node
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o Connect M Connect
Open Platform with TLS Open Platform with TLS
Connect to the host's cecure platform daemon Connect to the host's secure platform daemon
Session Session
Type gv Platform TLS Connection Type gv Platform TLS Connection

Host IP SZ43LTJ06GWF2. gl - ¥ . Platform TLS Connection -

7T Platf C cti
Port 5011 Port U‘“a orm Connection

OK Cancel OK Cancel

2. In the Type box select Platform TLS Connection. Leave other settings at their

default values. n
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Initial Setup

3. Click OK. The Authentication dialogue box is displayed.

< Authent

% Auth
Logon

entication
required for access

=

Realm
Mame
Scheme
Credentials
Username

Password

GLOBAL
HTTP-Basic

Eg1

[# Rememberthese credentials

oK | Canoel‘

If a ‘Cannot display page’ error appears, ensure that the Platform Dae-

mon has been installed.

See chapter “4.4 Installing the Platform Daemon”

4. Enter the Username and Password that you would normally use to login to the

Windows PC.

5. Click OK.

For security it is recommended that the Remember these credentials box
is left unchecked.

A “Platform” item will now appear in the Nav tree and various platform objects will

appear in the view pane.

® Saia PCD® Supervisor

File

Edit  Search

¥ o (%) My Network

) My File System
O myModules
&T Plstiorm

- Palette

B Ssia PG5 Data Impart Wizard

Bookmarks Window

My Host : S743L TJ0SGWF2.global.ds.honeywell.com

@ My Host: 5743 TJ06GWF2.global.ds.honeywell.com

W X B § sbeofflinetngineering

/  NavContainerView -

Platform

Name

@ application Director

€ Certificate Management
€ Lexicon Installer

@ License Manager

Q) Platform Administration
@ station Copier
 TCRiP Configuration

) Remote File System
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6.1.3 Create a New Station

1. From the Tools menu select New Station. The New Station Wizard is displayed.

<#> Saia PCD® Supervisor

< New Station Wizard X
File Edit Search Bookmarks - Window  Help
Options ﬂ New Station Wizard
: B
My Host : SZ43LTJO6GWF2.global.ds. honeywell.con  _ Station Name

Demo_Station
Station Directory
C:\Users\E814666\Niagarad.2\SBC\stations\Demo Stac:

- Nav
L C & My Network

@ My Host: 5243LTJ06GWF2.global.ds.ho
e My File System

Station Templates

© 1y Modules Mame Vendor Version Desi
& Platform {ml To
¥ - NewControllerStation.ntpl Tridium 1.0
- rsion Tool MewSu pervisorStationLinuwentpl Tridium 11
New Driver
New Module MNewsSu pervisorstationWindows.ntpl Tridium 1.1
SaiaPCDSupervisor.ntpl SBC 1.0

SBC_SUP_TrainingCenter_SBUS_template_Vintpl Tridium 1.0

Workbench J

Workbench ager
4 Back P Next I " Finish ¥ cancel

2. Under Station Templates click SaiaPCDSupervisor.ntpl to highlight it.

3. Type a suitable name in the Station Name box.

the existing station or you can go back and specify an other name for
your new Station. You must select Yes to proceed.

n If a station already exists with that name you will be prompted to delete

AW Mew Station Wizard *

ﬁ MNew Station Wizard
—

Station Name

Demn_Statinnl

Station Directory
C:\Users\Eg8l4666\Niagarad.2\tridium\stations\Demo_:

Delete existing station Demo_Station? . Mo

Station Templates

Name Vendor Wersion Description F
NewControllerstation.ntpl Tridium 1.0
NewSupervisorStationLinux.ntpl Tridium 1.1

MNewSupervisorStationWindows.ntpl  Tridium 1.1

SaiaPCDSupervizor.ntpl SBC 1.0 Saia PCD Supervis

4 Back P Next o Finish ¥ cancel
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4. Click Next.

)

ﬁ New Station Wizard
—

Username Role(s)] Modified?

admin admin

Set Password

‘When 'Finish' is pressed, save the station and

4 openitinuserhome

> closethe wizard

4 Back Next

< Set Password X

Reset Password for admin

Password:

reessses
Confirm:

0K Cancel

<> copy itto secure platform for "localhost" with Station Copier

 Finish | ¥ cancel |

Initial Setup

5. Type a password in the Password for admin User box.

least one capital letter, one lowercase letter and one numeral (digit).

n The password must have a minimum of 10 characters and include at

As example:

username: admin

password:

Manager123 (it can be later changed)

6. Retype the password in the Confirm Password for admin User box.

This password is for the ‘admin’ and should be reserved for engineers. It
grants access to everywhere and to everything inside of a Station.

7. Select the copy it to secure platform for “localhost” with Station Copier option.

8. Click Finish.

9. If you have not already logged in to the Platform the Authentication dialogue box is
displayed, go to step 10

@ Authentication

q\ Authentication
Logon required for access

Realm
Mame GLOBAL
Scheme  HTTP-Basic

Credentials

Username | FEH

Password LTITTTY T

[#] Rememberthese credentials

0K Cancel
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If you have already logged into the Platform, go to step 11.
10. Enter your Username and Password (login credentials of the PC) and click OK.

11. If a station with the same name already exists, you will first be prompted how to
proceed.

@ Station Transfer Wizard X

£ Transferring station *Demo_Station"
How do you want to deal with any existing files?

< Delete the existing "Demo_Station" directory before copying

<§ Overwrite existing station files with new files, while leaving other filesintact

d Back | ! Finish X cancel

12. Specify the required option. n

13. Click Next. A dialogue box enabling you to specify the start-up options is displayed.

<®» Station Transfer Wizard X

™ Transferring station "Demo_Station®
/S station Startup Options

[#] START AFTER INSTALL: Start the station immediately after it is copied

[ AUTO-START: Start the station every time the platform daemon starts

Back | ) Next Finish ¥ cancel

14. Select the required start-up options.

START AFTER  Select this option if you want to start the station as soon as
INSTALL it has copied (recommended).

AUTO-START Select this option if you want the station to be started when
the PC is restarted (recommended).

When developing several Supervisors other stations will need to be
stopped.

15. Click Next.

“®» Station Transfer Wizard X

™ Transferring station "Demo_Station®
Please review your changes

Allstation files will be copied from the local computerto "localhost”

Please select the "Finish" button to start the transfer.

4 Back next |/ Finish | 3¢ cancel
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16. Click Finish. A progress update is displayed.

«® Transferring station hd

e’ . .
Transferring station
/) =

Completingtransfer:

@ Trensferfiles  Success
@ stertstation(s)  Success
Transfer complete.

Tranaferring files...

Sending ~stations/Demo_Station/config.bog

FileStore::commit

Wrote "C:\ProgramData\Niagarad.2\tridium\staticns\Demo Station\config.bog”.
FileStore::commitInstance commit complete

Station "Demo_Station" starting.

Transfer complete.

Close

17. When the process is complete, click Close. The Open Application Director dialogue

box is displayed.

< Open Application Director? *

@ Open the Application Director now?

18. Click Yes. The Application Director is displayed. Check that a ‘Station Started’ mes-

sage is shown.

[«@ saia PcD® Supervisor

File Edit Seacch Bookmarks Tools Window  Help

My Host:5743LTJ06GWF2 global.dshoneywellcom  : Platform

- Nav Application Director
¥ C © y nework Connected to localhost
Name Type Status  Details Auto-Start  Restart on Failure ©
@ My Host: S243L TI0SGNF2 globalds.honeywellcom
= certlab_os ststion ldle  foxen/afoxs-n/z,http-n/ahttpsn/s flse tue
& uy File System
- 5 saceoe ststion ldle  foxen/afoxs-n/ahttp-n/ahttpsn/a  false irae
o S saceos._final station Idle  foxen/aforsniahtip=n/ahttpsnia  false true
= sec_saus Test1 station Idle  foxen/afors=4S1Lhttpen/ahitps=2d3  false e
B sBc_TM2016_workshop  station  Idle fox=n/a foxs=n/s,http=n/ahttps=nfa  false true
S stationsupos station ldle foxenfajfoxs=n/onttp=n/ahttps=nfa false [true
S Training_Center_ Vi station Idle  fox=n/a,foxs=4911 http=n/a,https=443  false tue
S Attlo_test2 ststion ldle  foxen/afoxs—4911httpon/a,https—443  false irae
= Demo_station station Running fox-1811 foxs=4911 http=n/a,https=243 _false BN
ac 1 sava:a7) L] Auto-Start
ac 4 _javazed)
=i fhma £ o: ce.java:1262) @ restorton Failure
at G i (i Java:165)
aC com.cTridium. fox.session. F (F Java:104) Start
ac dium, £ F 100 (F¢ Java:2s)
ac dium, = Java:3se) ===
(Thread. java:745) =
CEST] [fox] Unable to start foxs, enabling fox commectivity! —
SEVERE [09:09:28 11-Rpz-17 CEST] [fox] FOXS server Zailed to starc on port. [4911]

Reboot

cepcion: Unable to create socket: Addre. ly in use: JVAL
:28 11-Apr-17 CEST] [sy3] NIGQAre RUNCINE ENVIFOMEENT: 4.2 Kill
28 11-Apr-17 CEST] [sys] *** Station Started (1031ms) [6698ms total] ***

9:09:28 11-Apr-17

= 1 208 Dump Threads

~ Palette INFO [08:09:28 11-Apr-17 CEST] [fox] FOX server starced om\port [1911]

Java.net.BindException: Address already in use: JVM Bind __ saveBog |
sbeofflineEngineern at £ DualSzackel bind0 (Nacive Hechod) =
W X B |& sbeoffincengneering &= Dualscackel (a1 Tnpl.javai108) |
o = ketImpl.bind Il java:387)
Saia PGS Data Import Wizard at Pl ket Impl.bind (Pl ketImpl.java:190)

= Bind Java:375) _clear output_|
at Java:237) Pause Output
2t Java.net.ServerSocket.<init> (7 WNIEQELE FUUIIGIIN= CIIVIEUIINEIIG: S+ &+ J0s I R
at javax.net.ssl.5SLServerSocket. . Output Dialog
at sun.security.ssl.SSlServersoc) **% Station Started (1031ms) [6698m3 total] #*=**
at sun.security.ssl.SSLServerSoc) . Stream To File
at & T LEnar] moezTd s =
a2 Som. £ o > ce.yavai126%)
B e T 15 Java:165) Output Settings
e tom. = r Foxs (Foxserverqavaz1od)
at Jjava.util, (ThreadPoolExecutor.java:1142)
27 nTn 5ri1 cncnrrens. Threndbnnl FrecnrazSHarker ot (ThendBan] Fxomsmns dnon: 6171
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6.1.4 Open the Station
1. In the Nav tree right-click on MyHost and select Open Station. The Connect dia-

logue box is displayed.

® Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window Help

1
{
[AYORIY Open Platform

&T Platfor Open Station

2. In the Type box select Station TLS Connection. Leave other settings unchanged.

3. Click OK.
The Authentication dialogue box is displayed with the default ‘admin’ user

selected.

) Authentication x
q_\ Authentication

% Logon required for access
Realm

Name local:|foxs:
Scheme  Fox(n4digest)

Credentials . admin

Username

Change User
Password YTTTTYYTYS Manager'123
[] Rememberthese credentials

oK Cancel

4. Type the appropriate password in the Password box (i.e. the password specified
when the Station was created).

For security it is recommended that the Remember these credentials box
is left unchecked.

5. Click OK
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6. After a short delay, the chosen station name will appear in the Nav tree and the
view pane will show a summary of Station parameters (Station Summary view):

«®» Saia PCD® Supervisor - X

File  Edit E Tools  Window  Help

My Host: SZ43LTJ06GWF2.zlobal.dshoneywell.com (Demo_Station) ~ © Station (Demo_Station) /  station Summary ~

Station (Demo_Station) 6 objects

E’ O @ My Network Name Description B

A Hom Alarm Database
v Q My Host: SZ43LTJ06GWF2.global.ds.honeywell.com (Demo_Station) ~

» Q My File System
3 0 My Modules e Files File System accessed over Foxsession

@ Config The station configuration database

FT Platform o spy Diagnostics information for remate VM
’ Station (Demo_Station) E Hierarchy Hierarchy views of remote station

‘ Alarm @ History  History database
» @ Config
» 0 Files
» E Hierarchy

[ ] @ Histary

* Palette Summary Properties 10 abjects

[ ] [g] E i sbeOfflineEngineering Property Value B
b B Saia PG5 Data Impart Wizard StationName | Demo_Station

Host SZ43LTJ06GWF2.global.ds.honeywell.com/165.195.181.42

Host Model Workstation

Product Workstation

Hostld Win-BCEF-FABD-6162-2CA6

MiagaraVersion 4.2.36.34

Java Version Java HotSpot{TM) 64-Bit Server VM 25.92-b14

0SVersion amd64 Windows 10 10.0

Locale en_GB

Current Time 11-Apr-179:25 AM CEST
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6.2 Manual creation of data points

This chapter describes the manual creation of the point database.
The following steps are needed to create the data point:

1. Add a Saia Burgess Controls Driver (it is named as “sbc” in the Palette)

2. Configure the driver

3. Add device(s) manually (mainly PCD or other S-Bus communicating devices)
4

. Add the required points to the database. Take care of the conversion. Building au-
tomation mainly using integer numbers multiplied with factor 10 in the PCD control-
ler. While Saia PCD® Supervisor is using normalized floating point.

5. Check (or modify if necessary) the speed of the communication of the point n

This is a tedious process with the possibility to make mistakes easily. However it is
advantageous for every System Integrator to understand the process.

It makes sense to arrange a PCD controller - connected to Saia PCD® Supervisor - with
a simple user program to follow up the explanation.

The user program can be for example a simple PCD device with media mapped
PCD3.S100 Workshop Simulator Unit. (Who does not understand this sentence please
go through the SBC PG5 User Manual or better to take part of a Basic SBC PG5 work-
shop.)

Important: The communication connection is based on “Media type” + “Media Address”
(e.g. Register 100). Best practice is to use explicit addressing (so called “hard address-
ing”) in the PCD controller. Dynamic addressing can be also used (makes no so much
sense) but the System Integrator must understand, that the dynamically allocated ad-
dresses in the PG5 can be any time overwritten by the PG5 programming tool.

6.2.1 Add a Saia Burgess Controls driver (SBClpNetwork)

We need to define at least one SBClpNetwork for S-Bus over Ethernet communicated
devices. Under the SBCIpNetwork driver many PCD devices can be configured to com-
municate with. It is possible to define other SBClpNetwork networks in order to distrib-
ute the PCD devices better and decrease the load of each SBClpNetwork.

The Saia Burgess Controls Driver controls the communications and flow of data to and
from the PCD devices.

It is possible to communicate with serial S-Bus networked devices using the SBC
S-Bus gateway function in the PCD controllers.

On larger sites it may speed up data transfer to utilise two or more separate SBC
S-Bus drivers (SBCIpNetwork)
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6.2.1.2 Create a folder for Saia Burgess Controls Driver
1. In the Nav tree open the Station folder.
2. Open the Config folder.

3. Right-click on Drivers and select New > Folder. The Name dialogue box is dis-
played.

i Mame X

@ SBC
n OK Cancel

4. Type SBC and click OK. The new folder will appear in the Nav tree.

5. Right-click the SBC folder and select Rename. The Rename dialogue box is

displayed.
4 Rename *
@ SBC Systems
OK Cancel

6. Type SBC Systems and click OK.
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6.2.1.3

1. In the Nav tree open the Station folder.

2. Open the Config

Add the Saia Burgess Controls Driver

folder.

3. Double click on Drivers. The view pane will show a list of installed Drivers

(Driver Manager

).

4. Click on the New button. The New dialogue box is displayed.

File Edit Search  Bookmarks

ools  Window Manager Help

0 -

5.
6. Click OK. The following dialogue box is displayed

- Palette
w X A [§e

O sscipnetwork
@rco
@ Pcosubstation

Q AlarmList
A& HpLog
I PCODeviceFolder

In the Type to Add box select ‘SBCIpNetwork’.

Driver Manager
¥ O & My Network Name Type Status Enabled FaultCause ®
@ by Host: SZ4ILTI06GWF2. globaldshone: @ Niagaraetwork  NisgaraNetwork ok} true

@ My File System

@ My Modules

& Platform @ New X

& station (Dema_Station)

A rlarm TypetoAdd | AaPhp StarNetwork

Numberto Add | €3 ModbusAsyncNetwork

— 6 modbus Tep Gateway

6 ModbusTep Network
ve

© Rapid Eye Network
© RdbmsNetwork

SBCIpNetwark

# Edit | @, Taglt

1 objects

o Mew

Mame

F. MName
F] Type

Type

€ sBCIpNetwork_[ SBCIpNetwork  true

SBCIpNetwork Demo
SBCIpNetwork

F] Enabled . true

OK | Cancel |

Enabled

et

7. Change the default network Name to be a meaningful name for the site.
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8. Click OK. The Driver Manager will now show the Saia Burgess Controls driver.

<®r Saia PCD® Supervisor

File

My Host : SZ43L TJO6GWF2.global.ds.haneywell.com {Demo_Station)

- Nav

g

@ My Host : S743L TIDBGWF2.global.ds.honeywell.com (Demo_Station)
) iy File System

8]

B % @

: Station (Demo_Station) ~ : Config

Driver Manager
() My Network Name
3 niagaraNetwork

 secipNetwork_Demo

) vy Modules
& Platform

& station (Demo_station)

A dlam
© config
@) services
0 Drivers
e NiagaraNetwork
© seC systems
e SBClpNetwork_Demo
© apps
@ Files
E Hierarchy

@ History

- Palette
w E D [f=

 seciphetwark
[ - I

© rcosubstation
© alarmList

% HDLog

I PCDDeviceFolder
[ secPointFolder

0 Points

9. Right-click the driver and select Cut.

~ Nav

&

C

Q@ myH

- Palette

) iy File system

vy Modules

& Platform

& station (Demo_station)

() My Network

st : SZ43L TJOSGWF2.global.ds.honeywell.com (Demo_Station)

A alarm
© confiz
@ serviees
) rivers
 Niagarahetworlg
© see systems
9 sBCipNetwork,
@ Apps
&) Files
[&) Hierarchy

@ History

Views

Actions.

New

Edit Tags

Make Template

Cut

6-14
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10. In the Nav tree, right-click the SBC Systems folder and select Paste.

- Nav
B o & My Network

@ My Host: SZ43LTI06GWF2.globalds.haneywell.com [Demo_Station)
@ iy File system
O My Modules
BT Platform
& station (Demo_Station)
A Alsrm
© config
@ services
 Drivers
) Niagaran
© secsyst
SBCIpNet]

.
@ Files
ey
@ History ;

- Palette

=52 CETTEES O

It is possible to create folder to the points to make nicer structure.
However when the Saia PG5 Data Import Wizard is used the default
SBCIpNetwork folder is generated. This folder can be renamed. The
next import then will be done to the renamed folder. The target folder
of the import can not be freely chosen.

11. In the Nav tree, right-click to the SBClpNetwork_Demo in the SBC Systems
folder.

12. You now need to configure the communications of (each - if you have many)
Saia Burgess Controls Driver.
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6.2.2
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Configure the Saia Burgess Controls Driver(s)

Saia PCD® Supervisor connects to the Saia Burgess Controller network (Ethernet
networked PCD devices) using S-Bus over Ethernet communication. It is necessary

to configure Saia PCD® Supervisor with the IP Address (or hostname) and the S-Bus
station address of the device to communicate with. Inside of the PCD device the Media
can be addressed by specifying the type and memory slot.

At this point it is recommended to have a SBC PCD device (a controller with the cor-
rect application running inside, with the correct Ethernet parameters set in the PCD and
also in the PC) connected to the Saia PCD® Supervisor.

In the Nav tree right-click on the Saia Burgess Controls driver (e.g. SBClpNetwork_
Demo) and choose Views > AX Property Sheet. The view pane will show a list of driver

properties:

@ Saia PCD® Supervisor

Edit Search Bookmarks Tools Window  Help

My Host: SZ43LTJ06GWF2.global.dshoneywell.com (Deme_Station)
- Nav
K o ®) My Network

(@ My Host: SZ43LTI06GIF2. global.ds.honeywell.com (Demo_Station)
@ vy File System
@ vy Modules
T Platform
& station (Demo_Sstation)
A albrm
© config
@ services
6 orivers
6 nisgaraNetwork
© st systems
9 saCipNetwork_Demo
X TuningPolicies
© apps
& Files
[E] Hierarchy

@ hiistory

- Palette
W X A s

) sBCipetwork
@ro

© rcosubstation
©Q atsrmList

2% HDLog

I PCDDeviceFolder
A secpointFolder

Q roints

! Station (Demo_Station) @ Config  : Drivers

: SBCSystems @ SBClpNetwork_Demo

Property Sheet
ﬁ SBCIpNetwork_Demo (SBCIpNetwork)
r. Status {ok}
[ Enabled @ e
[ Fault Cause
3 Health Ok [11-Apr-17 1:52 PM CEST]
(Ml Down @ faise
(W Alarm @ false

(W Last Ok Time

11-Apr-2017 01:52 PM CEST

(W LastFail Time  [mall

[ Last Fail Cause
© Alarm Source Info
(W Alarm Class

ri Source Name
(W To Fault Text
(W To Offnormal Text

(M To Normal Text
ri Hyperlink Ord

ri Sound File
(W Alarm Icon
ri Alarm Instructions

(W Meta Data

L3 Monitor
ri Ping Enabled
r. Ping Frequency
(W Alarm On Failure

(W Startup Alarm Delay

¥ Tuning Policies

Alarm Source Info

Default Alarm Class

sparent.displaylanet ®
tlexicon(driver:pingFail) & ®
tlexicon (driver:pingSuccess)t ®
null

» O
null
null

Olnstructions 3

» O~

Ping Monitor

@ true

+00000h 05m 00s|3

@ e

+00000h 05m 00s|3

Tuning Policy Map

X Default Policy Tuning Policy

[l Min Write Time
[l Max Write Time
[ Write On Start

[ Write On Up

r. Write On Enabled

[ stale Time

00000h 00m 003)2 [0ms-=inf]
00000h 00m 003|% [0ms--+inf]

® true
@ e
® true

00000h 00m 00s]2} [oms-+inf]

@ - (Defaultview) - P

Basically the default parameters are good for starting.

The driver must be enabled. Status must be OK. It can happen that the status at the
beginning is “down” it will be “ok” right after the communication is established with the

SBC Device.
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6.2.3 Adding Device to the Saia Burgess Controls Driver(s)

Each physical networked SBC controller needs at least one PCD (device) added to the
Saia Burgess Controls Driver (SBCIpNetwork_Demo) with unique name.

1. Open the Palette sidebar if it not yet opened.
Menu bar — Window menu — Sidebars — Palette

2. Open the “sbc” palette.

- Palette (7
R

 saCipNetwork n
@ rco

© rcosubstation
OAlarmList

<% HDLog

I PCDDeviceFolder
A secPointFolder

O Points

3. Copy PCD from palette. Right click to PCD and select copy.
4. Right mouse click to the driver “SBClpNetwork_Demo” and paste it.

5. Name it as Device1 (- or CPU1 - or respectively to the app running in the device
e.g. AHU1 as Air Handling Unit 1).
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6. Double click to the Device 1 will bring up the following screen.

@ Ssia PCD® Supervisor

File Edit Search Bookmarks Tools Window Help

My Host: S743LTJ06GWF2.global.ds.honeywell.com (Dema_Station) . Station (Demo_Station) . Config . Drivers 1 SBCSystems . SBClpNetwork_Demo : Devicel

- Nav Property Sheet
K o © vy Network @ Devicel (SBCHeadStation)

m Status {down, alarm, unacked®.
v (@ MyHost: SZ43LTI6GIF2 global.ds.honeywelL.com (Demo_Station) 1l Enabled @

b @ nyFile ystem

(Wl Fault Cause
b @ uyModules

w [ Health Fail [11-Apr-17 2:31 PM CEST] Timed out 1.
b & Platform B Dovn O
v station [Demo_station)
Alarm @t
A Aam W
v © corie (W Last Ok Time  [null
@ li Last Fail Time 11-2pr-2017 02:31 PM CEST
b @ sewvices
GD li Last Fail Cause  Timed out waiting for response.
v rivers
» On o « @ Alarm Source Info Alarm Source Info
iagaraNetwor
i [ Alarm Class Default Alarm Class
v ems
sparent.parent.displayleme 3parent.dis
+ 6 saCipNetwork_Demo [ Source Name & e ey & LNO]
» X TuningPolicies T To Fault Text ®
+ @ Devicel
e [ ToOffnormal Text  $lexicenidziver:pingfail)s ®
b @ apps
by @ Files [l To Normal Text $lexicon (driver:pingSuccess)® 1)
b [ Hierarchy
® null W - (Defaultview) ~ P
’ HET [ Hyperlink Ord s
T -
- Palette
[ sound File null - )
w X 3§
[ Alarm lcon null - )
» 6 secipNetwork
Alarm Instructions  OInstructions
» @rco L »
» © Peosubstation [l Meta Data » O~
b Q aarmiist » B Poll Scheduler N Poll Scheduler
b A tidlog [ Poll Frequency Normal
» [ pCoDeviceFolder b (W IpAddress 127.00.1:5050
» 8 sBcrointFolder W station 1d i
b Q roints » @ Points SBCPoIntDeviceExt
b @ Alarms Alarms
» @ Histories Histories

] m Device Information  SBCDevicelnformation
m Fip Username
(W Ftp Password
(W Hitp Password
» Gl Data Poll Frequency  30secs {Sun Mon Tue Wed Thu FriSat}

JRefresh [ [7] save
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7. Setup the IP address and the S-Bus Station ID of the Device 1
The Device1 must be enabled.
Keep the default parameters in.

Property Sheet

. Status
Ml Enabled
[ Fault Cause
L Health
[l Down
[ Alarm
[l Last Ok Time
[l Last Fail Time
[ Last Fail Cause
© Alarm Source Info
(@ Alarm Class

(M Source Name

(W To Fault Text

[l To Normal Text
@ Hyperlink Ord

(M Sound File

U Alarm lcon

[l Meta Data
¢ Poll scheduler
@ Poll Frequency

@ Alarms
Histories

[l To Offnormal Text

© Devicel [SBCHeadStation)

[down, alarm, unacked®!

. true

Fail [11-Apr-17 2:36 PM CEST] Timed out ..
.true
.true
null
11-Bpr-2017 02:36 PM CEST
Timed out waiting for response.
Alarm Source Info
Default Alarm Class
jparent.parent.displayName$ $parent.displ @

%lexicon({driver:pingFail) % @
%lexicon{driver:pingSuccess) % @
null

> O
null
null

[@ Alarm Instructions  Olnstructions )

»> O
N Poll Scheduler

Mormal

@ I1p Address 127.0.0.1:5050

[ IpAddress  [172.23.13.13

(W Port [ unspecified |5050 [-1-65536]
[ Station Id 19|
& roints SBCPointDevicebxt

Alarms

Histories

[ Device Information
(W Ftp Username

(Ml Ftp Password

[ Http Password

SBCDevicelnformation

Gl Data Poll Frequency

30secs {Sun Mon Tue Wed Thu Fri Sat }

B - (DefaultView) - P

| IR 4
| IR 4

7 Refresh | [ save |

The FTP credentials and HTTP password need to be manually config-
ured here. If these credentials are missing, then the HDLog and Alarm
data retrieval are not working.

The status can be OK or Down. When it is OK the communication is well estab-
lished. When it is down it can happen that he initial telegrams were not correct
answered (wrong IP or S-Bus station number). Check and correct - if needed - the
settings. Save the settings. Press the Refresh button at the bottom of the page.

Disable the Device and save the settings. Enable the Device and save the settings.
These actions are initiating telegrams which must be answered by the Device.
Navigate to the Device Information. This will surely initiate telegrams to be sent
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in order to get back the basic information of the connected Device. After that the
“Status” of the Device must be OK. If not the parameter settings is not correct, or
the Device is not correctly connected to the network. Try to ping the Device (keep
in mind that the Windows firewall can block the ping). Step by step check of the

settings in the SBC Device and also in the Saia PCD® Supervisor is needed.

Last step is to restart the Platform Daemon,
See chapter 4.4 Installing the Platform Daemon

Creating/Engineering a project

<®» Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window  Help

My Host : S243LTJ06GWF2.global.ds.honeywell.com [Demo_Station) . Station (Demo_Station) . Config . Drivers ! SBC Systems ! SBClpNetwork_Demo
- Nav Property Sheet
{:@ o @ My Network (Ml Device Information (SBCDevicelnformation)
) Services li PCD Status Run
 orivers [ PCD Type FCD3.MG860
 niszarahetwork (W PCD Clock 17-04-11T14:47:17
Q sBCsystems (@ Firmware Version  [1.26.15
© sBCipNetwork_Demo (@ Time Zone uTC (<0}
1 Tuning Policies
° Devicel

o Alarm Source Info
B¢ Poll scheduler

ﬁ Points

@ Alarms

@ Histories

m Device Information
(a Data Poll Frequency
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6.2.4 Add Points to the Device to get the data from the PCD

First of all it is not possible to “Discover” the points from the PCD device.
The points must be added manually.

Let us create a “SBCRegister” and some “SBCFlag” type of points.

1. Navigate to the Points folder of the Device1. It is empty.

2. Navigate to the Palette — sbc — Points. In this folder there are templates for
every each possible type of points. This means these type of variables can be
found inside of the SBC Device depending on the user program. The template
points are nicely colored so it is easy to distinguish the different types.

3. Drag the “SBCRegister” type from the Plaette “sbc” and drop it to the Device1/ n
Points folder. In the pop-up window name it “Analoglnput_1”

am Mame >

OK Cancel

I name it like that because | would like to connect here the physical analogue
input 1 of the PCD3.S5100 workshop module. Of course there is a corresponding
program downloaded to the PCD device.
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4. The address has to be set for that point. | know that the first analogue input of
my Device is mapped to the Register 100. (In this application this is a potenti-
ometer of the PCD3.S100 simulator unit)

So double click to the Analoginput_1.

Open the Proxy extension.

Setup the Memory Address to 100.

Data Format can be as it was “Signed Integer”.
Save it.

OO~

File Edit Search Bookmarks Tools Window Help

My Host: S243LTJO6GWF2.global.ds.honeywell.com (Demo_Station) ~ © Station (Demo_Station) @ Config @ Drivers  : SBCSystems @ SBCIpNetwork_Demo -
- Nav eroperty Sheet
¥ o () My Network © Analoginput_1 (Numeric Writable)

— [ Facets units=null precision=1,min=-inf,max=-inf 3 D -
) orivers o
Proxy Bxt SBCProxyExt
O nisgaraMetwork oy el
ﬁ Status {ok}
© sBC systems
[ Fault Cause
© sacipietwork_Demo
Enabled true
X TuningPolicies m ®
@ Devicet [l Device Facets » ©-
© st sourceInfo (Wl Conversion 12 Default

Be pollscheduler [ Tuning Policy Name  [Default Policy

D sBCTextRam

& Points == Read Value 957.00 [ok}
) Analoginput_1 w—Write Value - {mull} @ def
(& Alarms [l Memory Address 100
© Histories [l Data Format Signed Int
[l peviceInformation - out 957.0 fok] @ des
gData Poll Frequency — - [null}
@ apps - Inz - {null} ¥
& Files - In3 ~ {null} hd
(& Hierarchy J—_— - {null} ¥
@ History - In5 - [null} ¥
- Palette 6 — it -
- In7 — {null} ¥
m X A |#e == Ing - {null}
©) PCoSubStation - Ing - [null} ¥
Q alarmist J—— ~ {nu11} ¥
& HDLog N1l ~ [null} ¥
I PCDDeviceFolder - In12 - {null} ¥
A sBcPointFolder - 013 - {null} ¥
Q roints - nld ~ {nu11} ¥
QO secrlaz - In15 ~ {nul1} ¥
@ sacrlagvolatile - 16 - [null} ¥
(0 sBCRegister = Fallback - {null} ¥
@ secregisterloat (W Override Expiration  Pull
O seoinput [l Media Type Register
© sscoutput (@l Comments
@ sBcTimer
-l @ 1con module: //sbc/rescurces/inages/register.png
(D sacoBRam
© sscom
) secText

7 Refresh [ save

5. The Status must be {ok}. It can be seen that the “Read Value” and the “Out” are
following the content of the “Device1/Register 100”.
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The Conversion is set automatically to 0.1. The Conversion is set to Linear

and the Scale is set to 0.1. This will remove the 10 multiplication factor we use
conventionally in the Building Automation. This scaling can be seen on the

“Read Value” and the “Out”.

Property Sheet

@ Analoginput_1 {Numeric Writable)

@L.

. Facets unite=null,precision=1,min=-inf,max=+i
[ Proxy Ext SBCProxyExt
. Status {ok]
(@il Fault Cause
(@il Enabled @ true
[l Device Facets » 0 -
(@l Conversion I Linear Scale|n.1

Ul Tuning Policy Name
Read Value
Write Value
(@l Memory Address
(@il Data Format
Out

85.

Default Policy
957.00 {ok}

- [null}] @ def
100

Signed Int

7 {ok} B def

It is possible to set the Engineering Unit, precision, and the limits of the value, in

the Facets.

o Config Facets
Key Type Value B
units Unit null [:]
precision Integer 1
min Double -inf
max Double +inf

o[ x| 6

0K Cancel
- X
temperature (K] celsius (°C) 19 -
0K Cancel

7. For the SBCFlag types. Copy the “SBCFlag” type of point from the Palette.
Right click to the Device1/Points folder. Select “Paste Special”.
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8. In the pop-up set the “Number of copies” to 8. Other settings must be un-
touched.

> Paste Special x

D Paste Special

Mumberof copies  g|

[ keepalllinks

[] keep allrelations

n OK | Cancel |

9. 8 points are generated with the name “SBCFlagx”

10. | want to change the names of the generated points. Select the points. Right
click to the selection. Select rename from the context menu. Fill up the “Search
for” and the “Replace with” fields. Press ok.

My Host : S743L TJ06GWF2.global.ds.honeywell.com (Demo_Station)  : Station [Demo_Station) ! Config  : Drivers  : SBCSystems  © SBCIpNetwork_Demo ! Devicel  : Points
- =
Nav Database
¥ O & My Network Name Type out Tuning Policy Name
% TuningPolicies © Ancloginput_1  NumericWritable 957.0{ok} @def  defaultPolicy
© devicer © scrlag Boolean Writable false [ok] @ def  defaultPolicy
© Alarm Sourceinfo © secrlagt Boolean Writable false [ok] @ def  defaultPolicy
F# Follscheduler © secrlaz Boolean Writable false[ok] @def  defaultPolicy
-
‘s Points © secross BooleanWritable  false[ok] @def  defaultPolicy
© analoginput_1 )
Q secrlagt Boolean Writable false ok} @,
0 secrlag ® Rename X
Q@ sBcrlags Boolean Writable false ok} @,
0 secriegt
© secroe Q secrlags BooleanWritable falsefok} @{ [y — =
SBCFlag? Boole Writable false {ok} @
© sacrices G secios coleantinitable TElOW ! sacFlag7 Digitalinput 7
© secrsgs SBCFlagl Digitallnput_1
0 secrlses
SBCFlag2  Digitallnput_2
@ secrlaes
SBCFlag3 Digitallnput_3
0 sacFlagr
@ Alarms SBCFlagd  Digitallnput_4
© Histories SBCFlag5 Digitallnput_s
[l Device Information SBCFlags  Digitallnput_6
Gl Data Poll Frequency SBCFlag  Digitallnput_
-~
~ Palette Search for:
SBCFlag
b
= x 3 & Replace with:
& PCDSubStation e TN
© warmtist [ Match Case
£& Hblog [ Match Word
I PcDDeviceFolder
[ sBcPointFolder OK Cancel
O paint:

11. Right click to the “Points” folder of the Device1 = Views -+ AX Property Sheet

12. Setup the address of each “Digitallnput_” points.
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13. The Status must be {ok}. The “Read Value” and the “Out” of the generated
points are following the content of the Flag 100 to 107 of the Devcie1.

[ Saiap

Edit Search Bookmarks  Tools  Window E

My Host: SZ43LTJ06GWF2.global.ds.honeywell.com (Demo_Station) : Station (Demao_Station) I Config  Drivers I SBCSystems I SBClpNetwork_Demo : Devicel I Points

- Nav Property Sheet
o © wyNework & Points [SBCPointDeviceExt)
- - © Analoginput_ 1 957.0 {ok} @ def
X TuningPolicies @ Digitalinput_  true {ok} @ def
@ Devicet [ Facets trueText=truefalseText=false 3 7D -
© Alsrm sourcelnfo 3 Proxy Ext SBCErowER
roxy roxy
B¢ poll scheduler .
L Status {ok}
& Points o
o Ll Fault Cause
Analoginput_1 e
(Ml Enabled @ true
@ oigitalinput_
© vigtalingut L [l Device Facets » O-
@ vigitalinput 2 [ conversion 12 Default
@ vigitalinput_3 @l Tuning Policy Name  [Default Policy
@ vigitalinput_4 == Read Value true {ok]
@ oigitalinput 5 - Write Value - {null} @ def
© oigitalinput 5 [ Memory Address 100
@ oigtslinput_7 W Data Format Boolean
[N]
@ Alarms - Qut true {ok} @ def
@ Histories -0l - {null}
[l Device Information -2 ~ maily ¥
@l Data Poll Frequengy . p— z

The same way it is possible to create every needed points and connect it to the corre-
sponding media element of the SBC PCD device.

Remember that Saia PCD® Supervisor is licensed for use up to a specific number of
points. It is good practice to only add points that are actually required. Adding points
that won't be used by Saia PCD® Supervisor will not only waste resources but also
generate unnecessary extra network traffic.

6.2.5 Add Alarming to a data point in the Saia PCD® Supervisor

In the Saia PCD® Supervisor there is an Alarm Service which can be used to set Alarms
for individual datapoints, regardless if the datapoint is considered alarm or not at the
start of the engineering.

For example the Outside Air Temperature can generate an alarm when it goes under
—20°C. For that we need to set the monitoring in the Saia PCD® Supervisor. So the
Alarm is generated in the Saia PCD® Supervisor not in the PCD controller.

There is an other way of alarming, which is described in details later in this manual.

The Alarms are generated in the PCD Device and the Saia PCD Supervisor takes
these alarms over.
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6.2.5.1 Steps to set alarming to a datapoint

1. In the Nav tree open the 127.0.0.1/Station(Demo_Station)/Config/Services folder.
And double click to the AlarmService.

®» Saia PCD® Supervisor

File  Edit Search Bookmarks Tools  Window  WireSheet Help

| oD O- o O 60 &~ [ O
127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config . . AlarmService
- Nav £ wire Sheet
¥ O () My Network
— - Alarm Db Config ™ l
File Alarm Db Config
@ services [ J
© Alarmservice Default Alarm Class ConsoleRecipient B
i Alarm Class 4 Console Recipient
@ BackupService Alarm Route Alarm
@ CategoryService
@ JobService
m RoleService
0 UserService

The default view (Wire Sheet) will be displayed with the default settings. (Alarm Db
Config, Default Alarm Class and the Console Recipient).

The Default Alarm Class is already used for system alarms (for those alarms which
is generated in the Saia PCD® Supervisor). Most of the cases we do not want to
see the Supervisory system generated alarms together with the alarms which is
coming from the controlled process. So we need a new alarm class to be placed.
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2. Place a new alarm class to the Wire Sheet from the palette. It can be named as
you it is proper. (here it is named Critical Alarms)

<% Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window  Wire Sheet

127.0.0.1 (Demo_Station) . Station (Demo_Station) I Config I Services . AlarmService
- Nav Wire Sheet
h@ o @ My Network
Alarm Db Config &
File Alarm Db Confi
@ My Host: 5743LTJ06GWF2.global.ds.honeywell.com
@ 127.0.0.1 {Demo_station) ———————
, Alam Class A
’ Station (Demo_Station) |mam|
! Alarm
eCUnflg Critical Alarms ‘q]
@ Services S AT
Alarm |
o AlarmService ]

A Default Alarm Class
A Critical Alarms

@ BackupService

® CategoryService

@ Jobservice @ Narne X
@ RoleService @ Critical Alarms

o UserService

0 AuthenticationService OK Cancel

Q’ DebugService
@ BoxService

8 FoxService

@ HierarchyService
@ HistaryService

O nuditHistoryService
. e

- Palette
[~} E] E ialarm

o AlarmService
A AlarmClass
o AlarmClassFolder
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3. There Console Recipient is already placed. It is possible to use this recipient (re-

name it to proper name) or place a new one.

plate file.

This Console Recipient is coming form the SaiaPCDSupervisor.ntpl tem-

The alarm console is one way to inform the User about alarm occurred in the sys-
tem. There can be other way like sending E-mail or SMS.

File Edit Search Bookmarks Tools Window  WireSheet Help

127.001(Demo_Station)  :© Station (Demo_Station) @ Config  © Services @ AlarmSenvice
- Nav
¥ O (D) My Network
- @5;rwces
0 alarmservice

A Default Alarm Class.
& Critical Alarms
E AlarmConsoleSbus
® BackupSenvice
@ CategoryService
@ sobservice
€ Roleservice
O userservice
© uthenticationservice
LT pebugservice
® Boxservice
¥ Foxservice
@ Hierarchysenvice
@ HistoryService
O rudithistoryservice
O LoghistoryService
@) Programservice
O searchservice

© Taepictionaryservice
A ——

- Palette
w X B #aem

Q alsrmservice
& AlarmClass

£ alarmClassFolder

Q) Recipients
bl ConsoleRecipient
£ StationRecipient

Q) exdensions

Q) rrinterRecipients

Wire Sheet

Alarm Db Config )
File Alarm Db Config
|

Default Alarm Class
Alam Class L

e 4
[Alam |
L )

AlarmConsoleSbus E
Console Recipiznt
Route Alarm.
Status {ok]
)
@ Name X
@ 2larmConsoleSbus
oK Cancel

4. Wire the Alarm console and the Alarm Classes together as the next image shows.
The system has to know what to do with the alarms so that the Alarm Classes

(container of alarms) and the Alarm Console
nected.

(a way to display them) has to be con-

Wire Sheet

Alarm Db Config [
File Alarm Db Config

Default Alarnm Class a
Alarm Class
[Aatarm

F
L |

Critical Alarms AlarmConsoleSbus E
Alarm Class - Console Recipient

[Alarm T Route Alarm

L | Status {dc}]

5. Copy the BooleanChangeOfStateAlarmExt from the Palette / Alarm / Extensions
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to the data point where alarm has to be added. (Boolean datapoint called: Points/
Heating1/Supply/Pump/Alarm)

In the pop-up Name field give a proper name (or just leave it default)

File Edit Search Bookmarks Tools Window  Help

€0 ip:127.0.0.1foxs:|station: |slot: Drivers/SBC5 20Systems/SBCIpNetwork_Demo/Devicel/points/Heating1/Sup
- Nav

hﬁ O Q My Metwark

IQ- Poll scheduler
@ Points

(=] Heatingl
° Ack
Q Proxy Ext
H opMode
H outside
E Return
mTemperature
A valve
o PI_Signal
o signal
o ThreePoint_close
e ThreePoint_open
E supply
31 ] Pump
o Alarm
B Proxy Ext
° Feedback
e MotarProtection

° Qutput

BT Tammnarstirs

- Palette
] E] @ ialarm

o AlarmService

A AlarmClass
o AlarmClassFolder
o Recipients
0 Extensions

@ Name X

@ Alarm
OK Cancel

Q OutOfRangeAlarmExt
Q StringChangeOfvalueAlarmExt
Q BooleanChangeOfStateAlarmExt
Q BooleanCommandFailureAlarmExt
Q EnumChange0fStateAlarmExt
Q EnumCommandFailureAlarmExt
Q StatusAlarmExt

0 PrinterRecipients
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6. Set up the properties of the Alarm Extension
Alarm inhibit false
Alarm Enable = x toOffnormal ; o toFault

[<®> Saia PCD'® Supervisor

File Edit Search Bookmarks Tools Window Help

0 m=- 2

4 o 0O-of o

127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config . Drivers . SBC Systems . SBClpNetwork_Demo : Devicel . Points . Heatingl . Supply
- Nav Property Sheet
P C &) My Network @ Alarm (Boclean Writable)
o ﬁ Facets trueText=true, falseText=false >> o -
F+ Pollscheduler
03 Proxy ext SBCProxyExt
@ Points
= Qut true [alarm,unackedAlarm} @ def
A Heating1
= Inl - {null}
eAck
- n2 - {null} ¥
G Proxy Ext
= |n3 - [null} ¥
E opMode
= nd - {null} 4
A outside
- N5 - [null} ¥
E Return
= nG - [null}
B Temperature
= n7 - [null} 4
H valve
= ng - [null}
o PI_Signal
= |ng - {null} S
o Signal
= |n10 — {null} ¥
Q@ ThreePoint_close
= nll - {null} 3
°ThrEEPnint_ann
- 12 - [null} 4
3 supply s .
== In - {null}
E Pump
- |ni4 - {null} 4
eAl.arm
- |n15 - [null} 4
G Proxy Ext
- |nl6 - [null} ¥
gAlarm
m= Fallback - {null} 3
° Feedback
0o (@ override Expiration null
MotorProtection
Y m Min Active Time +00000h 00m 00s|3
i i i +00000h 00m 0032
- Palette m Min Inactive Time =

O false

m Set Min Inactive Time On Start

] E E iatarm

m Ilcon module://sbc/resources/images/flag.png
Q slarmservice [ Media Type Flag
A AlarmClass [ Comments Error message pump

D AlarmClassFolder E Alarm Alarm Source Ext
O Recipients == Alarm Inhibit false [ok} ¥
Q extensions [i Inhibit Time 00000h 00m 005|% [Oms- +inf]

Q OutDfRangeAlarmExt [i Alarm State Offnormal

Q StringChangeOfValueAlarmExt li Time Delay 00000h 00m 003|2 [Oms- +inf]

&J Booleanchangz0fstateAlarmext 00000k 00m 00s|2) [oms-+inf]

[ tooffnormal [#] toFault

[ Time Delay To Normal
(W Alarm Enable

(@ To Offnormal Times
(M To Fault Times

(@ Time In Current State

Q BooleanCommandFailureAlarmExt
Q EnumChange0fStateslarmExt

b7 EnumCommandFailureAlarmExt
Q StatusAlarmExt

Alarm Timestamps
Alarm Timestamps
+00000h 00m 17s

o PrinterRecipients tparent.displayName$

g Refresh

@
-

m Save

@ Source Name
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Property Value Meaning
Alarm inhibit True/false Alarm is activated / deactivated
Inhibit Time hours / minutes / Stages of the alarms

seconds
Alarm state - Fault - Fault: value is invalid e.g hardware fault

- offNormal - offNormal: value is valid but out of the its

- Normal borders

- Normal: value is valid and inside of the border.

Time Delay hours / minutes / Delay before alarm is generated

seconds
Time Delay To hours / minutes / Delay before alarm state goes away (if the alarm
Normal seconds in the corresponding device is already cleared)

Alarm Enable

ToOffNormal / To Fault

Enables the Alarm stages to be monitored

To Offnormal Times

Alarm Timestamp

The details of the last occurred offNormal alarm

To Fault Times

Alarm Timestamp

The details of the last occurred Fault alarm

Time in the Current

hours / minutes /

The elapsed time since the state was changed

state seconds
Source name Y%parent.display- It takes the name from the parent object name.
Name%
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7. Set up additional parameters

To Fault Text — Pump fault (it is unchecked, we do not have info if the value is reli-
able or not. If there is communication error between the Saia PCD® Supervisor and
the PCD device then the state will be different)

To Offnormal Text = Pump Error (this will be the alarm)
To Normal Text = Pump OK (text when the alarm leaves)
Offnormal Algorithm / Alarm value = true
Alarm Class = Critical Alarm class (created earlier)
Property Sheet

&F Alarm (Alarm Source Ext)

m= Alarm Inhibit - [null} ¥

[l Inhibit Time 00000h 00m 00s|3 [Oms-+inf]

[l Alarm state Offnormal

[ Time Delay 00000n 00m 0032 [0ms-+inf]

Wl Time Delay To Normal ~ [00000h 00m 003 2} [0ms-+inf]

[ Alarm Enable [# tooffnormal [] toFault

[l To Offnormal Times Alarm Timestamps

Ml To Fault Times Alarm Timestamps

[l Time In Current State +00000h 02m 10s

. Source Name f(parent.displayName$ @

Pump Fault ®
Ml To Fault Text

Pump Error @
[l To Offnormal Text

Pump Ok @
M To Normal Text
- mall & - (Defaultview) =~ P
UMl Hyperlink Ord

» 0O-
[ Sound File null PN
[ Alarm Icon null [~ IR
[l Alarm Instructions Olnstructions 3
[l Fault Algorithm Fault Algorithm

[ Offnormal Algorithm Boolean Change Of State Algorithm
(@ Alarmvalue (@ true

[l Alarm Class Critical Alarms

[ Meta Data » O~

O Refresh D Save
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Property Value Meaning

To Fault Text Any text which refers to the state | User defined / can be seen in the Alarm Console

To Offnormal Text Any text which refers to the state | User defined / can be seen in the Alarm Console

To Normal Text Any text which refers to the state | User defined / can be seen in the Alarm Console

Hyperlink ORD ORD, BQL Query or path When an alarm is reported in the console, the Hy-
perlink button activates. Clicking this button links to
the location you specify here.

Sound File Path text Path of the sound file for audible alarm.

Alarm Icon Path text Path of the picture which is displayed in the "times-
tamp" column in the Console Recipient view.

Alarm Instructions Instruction text It is possible to define instructions what tod when
alarm occurs.

Fault Algorithm Fault Algorithm Algorithm to generate alarm on Reliability of the
associated point. This property when available,
displays fault parameters. Different options are
available here, depending on the alarm extension
being used.

Offnormal Algo- Boolean Change Of State Algorithm of generating the alarm. Inside it is possi-

rithm Algorithm ble to set parameters to define the way of the alarm
generation

Alarm Class Any proper Alarm Class Which Alarm Class is used to collect the alarm

Meta Data Text Allows you to enter new facets for the extension.

Manual Saia PCD® Supervisor | Document 27-651 ENG01 | 2017-09-27 6-33



Saia-Burgess Controls AG Creating/Engineering a project

Manual creation of data points

8. Open the Alarm console (double click on it).

It is possible to check the behavior of the Alarming of the
Points/Heating1/Supply/Pump point.

% Saia PCD'® Supervisor

File Edit Search

127.0.0.1 (Demo_Station)

Bookmarks  Tools

! Station {Demo_Station)

Window  Alarm  Help

: Config  © Services

© AlarmService

I AlarmConsoleSbus

Nav SBC Alarm Console
o ) My Network Time Range to? O
My Host: S243LTI06GWF2.globalds.h 1L,
O uyre AR Timestamp SourceState  Ack State Source Alarm Class Briority  Message Text

@ 127.0.0.1 (Dema_station)
& station (Demo_station)

A 13-Apr-17 3:38:00 PM CEST

offnarmal

1Acked /1Unacked 172.23.13.19:19 / myAlarmList/ 1

DefaultAlarm Class 255

Errorin Pump Heating

A 2o A 13-Apr173:3500PMCEST  Offnormal  OAcked/1Unacked 172.23.13.19:13/myhlarmList/4 DefaultAlarmClass 255 Window open
é Confie A 13400 173:36:27PMCEST  Normal LAcked /1Unacked  172.23.1319:19/myAlarmbist/2 DefoultAlarmClass 255 Shortdiraut
@ services A 13-Apr-173:36:20 PMCEST  Normal OAcked/1Unacked  172.23.1319:19/myAlarmList/3 DefsultAlsrmClass 255 Powerbreskdown
0 Aarmsenvice A 13-Apr172:3759PMCEST  Offnormal  OAcked /4 Unacked  Alsrm CriticalAlarms 255 Pump Error
A DefaultAlarm Class A 124pr172:43:00 AMCEST  Offnormal 1Acked /0Unacked  172.23.13.19:19 fmyAlarmList /6 Default Alarm Class 255 Error
A Crtical Alarms B 12-Apr172:4329AMCEST  Offnormal 1Acked/QUnacked  172.23.13.19:19/myAlarmList/5 Default Alarm Class 255 Generalerror

b AlsrmConsolesbus
@ Backupsenvice
© catezonyservice
D sobservice
@ Roleservice
O userservice
1® Authenticationservice
LT Debugservice
® Boxservice
¥ Foxservice
® HierarchyService
@ Historyservice

- Palette
W X 3 #odem

O alarmservice
A AlarmClass

£ AlsrmClassFolder

O Recipients
| ConsoleRecipient
£ StationRecipient

© extensions

© PrinterRecipients

P Notes | @ silence | 7 Filter ‘

' Acknowledge

B yperlink

When new alarm comes there is an audible sound to indicate it. This feature can
be deactivated with the Silence button.

The Alarm can be Acknowlwedged, the list is updated accordingly.
It is possible to add notes to the alarm stored in the Saia PCD® Supervisor.

Possible to define filter the Alarms, for example filter only the Alarms which is rele-
vant to the operator sitting front of the screen.
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6.2.6

6.2.6.1

Add History to a data point in the Saia PCD® Supervisor

In the Saia PCD® Supervisor there is a History Service which can be used to set history
log for individual datapoints.

For example the values of the Outside Air Temperature can be logged (history) then
later the logged values can be displayed as trend curve or just a plain text table with
the values in time order. It is also possible to export the values (in a defined time span)

to external file.

There is an other way of logging the history, which is described in details later in this
manual. The histories (called HD Logs) are generated in the PCD Device and the
Saia PCD Supervisor appends the content to history files located in the Saia PCD

Supervisor.

Steps to setup History for a datapoint in the Saia PCD® Supervisor

1. Check the History Service in the Services folder of the Station

<> Saia PCD@ Supervisor

File  Edit

127.0.0.1 (Demo_Station)

Search  Bookmarks Tools  Window

. Station (Demo_Station) . Config

- Nav
g O @ My Netwark
e Config
@ Services
o AlarmService

@ Backu pService

@ CategoryService

@ JobService

m RoleService

0 UserService

0 AuthenticationService
D’ DebugService

@ BoxService

v FoxService

@ HierarchyService

@ HistoryService

O suditHistoryService
o LogHistaryService

@ ProgramService

0 SearchService

o TagDictionaryService
TemplateService

@ WebService

n Saia PG5 Data Import Wizard

T PlatformServices

6 Drivers

o Services

History Ext Manager  Help

. HistoryService

History Ext Manager

Point  Extension History N
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2. Open the history Palette and copy the Numericlnterval extension to the datapoint
called Points/Heating1/Outside/Temperature/PhysVal.

In the pop-up window it is possible to rename the extension to a suitable name.

It is also possible to choose other type of history, for example Numeric COV or
Boolean Interval etc. Please check the different type of History Extensions in the

Niagara documentation.

File  Edit earch  Bookmarks Tools Window  History Ext Manager  Help

127.0.0.1 (Demo_Station) ~ : Station (Demo_Station)  : Config

K C (& My Network

X TuningPolicies
@ Devicel
© Alarm Sourcz Info
¢ Datapoints Poll scheduler
& Points
A Heatingy
Qs
A opMode
H outside
A Temperature
© Physval
2 oy Ext
B Return
A supply
H rump
@ alarm
3 Proxy Ext
&7 nlarm
@ Feedback
@ MotorProtection
- Palette

w X B | sy

@) Historyservice

© auditHistoryService

© LogHistoryService

© HistoryPointList

L HistoryPointListitem

© extensions
[ numericinterval
[F numericcov
[F Booleaninterval
[F Bocleancov
[ Enuminterval
[F Enumcov
[F stringinterval
[F stringcov

@ History Group

N History Nav Shortcuts

© Services

: HistoryService

| History Ext Manager

Point Extension History Name

> Name
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3. setup the parameters of the Numericlnterval extension.

Enabled =True

History name = %parent.parent.parent.name%_%parent.parent.name%__
%parent.name%

Interval =1 min

<® Saia PCD® Supervisor

File  Edit Search Bookmarks Tools Window  Help
mO- B a O - -
127.0.0.1 (Demo_Station) . Station [Demo_Station)  : Config  : Drivers  : SBCSystems  : SBClpNetwork _Demo : Devicel  : Points  : Heatingl  : Outside
- Nav Property Sheet
¥ o ) My Netwark [Z Numericinterval (Numeric Interval History Ext)

TRy Alarms r‘. Status {ok}
@ Histaries r‘. Fault Cause
ﬁ Device Information [—‘. Enabled .true

Qll Alsrms Poll Frequency (g Active Period Daysofweek [#] sun [#] Mon & Tue [# wed [# Thu [# Fri [# sat
ive Perio

OPseuduj—‘mnts Time Range |12:00:00 RM CEST 3 to |12:00:00 BM CEST |3
6 Bacnetiietwork [l Active @ true
© apps T History Name Sparent.parent.parent.name_tparent.parer (3)
a ? sehemeties (W History Config Interval: 15mins, Record Type: numeric t...
fles [ 1d fDemo_Station/Outside_Temperature_PhysVal
@ Hierarchy [
@ o ‘ Source station:|slot:/Drivers/SBC£20Systems/SBCIpNetwork |
= li Time Zone Europe/Berlin (+1/+2)
m Demo_Station
A ruditHistory [ Record Type history NumericTrendRecord -
A LogHistory (W Capacity Record Count 500 [0- max] records
A outside_Temperature_Physval [W Full Policy Roll
l—“ Interval regular +00000h 15m 00s
- Palette l—i System Tags
W X B # history (@l minRollovervalue null 0.00
i A [l maxrollovervalue null [0.00
D e (@i precision 32bit
°Aud\tHistoryService
O LogHistorySenvice [ valueFacets units="C,precision=3 *C,min=-inf “C,max==inf*c 3 D -
OHistoryPointList F] Last Record 12-Jun-2017 03:15 PM CEST |[] Hidden |o.00
L HistoryPointListitem [ Interval 00000k 15m 005/} [1ms-+inf]
Q Extensions [l Precision 32bit
[ numeridnterval r‘ Min Rellover value [ null |0.00
[ numericcov [ MaxRolloverValue [# null [0.00
[2 Booleaninterval
Property Value Meaning
Status Enabled/Disabled | Show if the history is enable or not. It is always dis-
abled after configuration. The user has to enable it.
Fault Cause Any kind of system | Error occurred during History creation. For example
generated fault the name of the history is too long (more than 67
chars)
Enabled true / false Switch to Enable / Disable the history of that point
Active period Days of Week / Possible to schedule when the historization of that
Time range datapoint should be switched on
History name Defined name of It is possible to give name to the history or generate
the history the name from the datatpoint name.
For example:

%parent.parent.parent.name%_%parent.parent.
name%_%parent.name%

will generate the following name
Outside_Temperature_PhysVal

History Config .. Summarized set- It is possible to navigate one step down and modify the
tings of the History | settings in detail.

..ID ID of the History Generated by the system, should be unique.

.. Source Source of the The full ORD of the history.
History
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.. Time Zone Time zone The configured time zone of the PC where the
Saia PCD® Supervisor is running

.. Record type Record type It is preconfigured in the Palette / Extensions

.. Capacity Record count / The number of the records allowed to create / unlim-

Unlimited ited. It depends where the History is created. Limit-

ed size of memory device can be used to store the
History.

.. Fill policy Roll/Stop Roll — the oldest history will be overwritten with the
newest log
Stop — when the record count is reached the logging is
stopped

.. Interval Interval of the It is possible to setup the interval between two logs

logging

creation.

.. System Tags

e.g.: NorthAmerica;
Region1; Cities.

This property allows you to assign additional metadata
(the System Tag) to a history extension.

.. minRolloverValue | number It takes over the settings from the same property
below.

.. maxRolloverValue | number It takes over the settings from the same property
below.

.. precision 32 bit / 64 bit It takes over the settings from the same property

below.

.. valueFacets

e.g.: units, pre-
cision, min, and
max.

Facets contain additional data applied to input and
output values.

Last Record

Date and time

The date and time of the last value is stored.

Interval Interval of the Same as above: It is possible to setup the interval

logging between two logs creation.

Precision 32 bit / 64 bit The same as above: Precision of the floating point
value which is used for that history.

Min Rollover Value | number Related parameter for "Delta" logging for e.g. electric
consumption for displaying the difference not the abso-
lute value. It is valid for NumericChangeOf Value and
for Numeric Interval. See Niagara documentation.

Max Rollover Value | number Related parameter for "Delta" logging for e.g. electric

consumption for displaying the difference not the abso-
lute value. Itis valid for NumericChangeOf Value and
for Numeric Interval. See Niagara documentation.

4. Save the settings
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5. The following History is created

> Saia PCD® Supervisor

File Edit Search Bookmarks Tools  Window

Help

4 O- o afa O 0 &= -

127.0.0.1 (Demo_Station) . Station (Demo_Station) . Histony . Demo_Station|
- Nav
L O ) My Network

3 @ My Host: SZ43LTI06GWF2.global.ds.honeywell.com
v (@ 127.0.0.1 {Demo_Station)
b # Station (Demo_Station)

‘ Alarm
b @ Config
» & Files
b E Hierarchy
v (D History
b ; Demo_Station
A ruditHistory
A LogHistory
A\ outside Temperature_Physval

6. Double click to the name of the History
The Chart of the logged values will be opened.

Additional features can be checked in the Niagara documentation.

[ SaizpcD

@A @ B Today @ QaADOO &
Outside_Temperature_PhysVal @ Outsige_Temperature_PhysVal

4.000

3.000

2.000

A outside Tempersture._Physval

1.000

000

- Palette B2 -1.000

= D [§ ey

2,000

-3.000

-4.000

334
61212017 pm

al
) E 3 :3
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Using the “Saia PG5 Data Import Wizard”

The import wizard an offline add-on tool to import the symbols from one or more SBC
PCD device(s) to the Saia PCD® Supervisor point database. The Import Wizard is in-
tegrated into the Saia PCD® Supervisor (it is not a standalone tool). The Import Wizard
gives the possibility to import the “symbols” from one or more SBC PG5 project, which
can content of course many PCD devices per each.

The symbols, to be imported, can be filtered by type, by name.

The symbols can be re-imported any time or after modification has been done in the
PG5 project. User can decide if the imported symbols are overwriting the points in the
Saia PCD® Supervisor, or not.

The import procedure can be cancelled and new-started any time.

During import an error check is done, which ensures that only the good formed sym-
bols are imported. The absolute necessity of using unique point names are ensured
through the PG5 symbol table. The PG5 project can be buildable if the symbol table is
correct. The downloaded PG5 program and the Saia PCD® Supervisor imported points-
must be all the time consistent.

When symbols from multi project are imported the System Integrator must make him-
self sure, that there no the very same named symbols (points) are getting imported.

For example there are two PG5 project created, one is called Building_A and the other
Building_B. Inside of both projects there are PCD devices called CPU1, CPU2, CPU3.
This happens because the Building_B project is just a copy of Building_A project. Let
us assume that the Building_A project has been already done. During import of the
Building_B project e.g. the CPU1 symbols from Building_A are getting overwritten while
the symbol name structure are the same in both projects. To avoid such a situation it is
recommended to have a unique ID for each PCD device in the projects to be imported.
Or use dedicated “Saia Burgess Controls Driver” for each PG5 project.

The points in the Saia PCD® Supervisor point database are structured hierarchically ac-
cording to the symbol groups in the symbol table of PG5 project.

The following different type of symbols and other information/data can be imported from
a PG5 project to the Saia PCD® Supervisor point database.

1. PG5 symboils or datapoints
2. Alarm list generated in the PG5 project

3. Historically logged data so called HD Logs.

Only SBC Web-Editor 8 generated Alarm lists are supported. SBC DDC Suite based
alarms are not supported. Before importing the Alarm list and the HD Logs the web
project in the Web-Editor 8 must be compiled. Take care to select the language for the
Alarm list before compile in the Web-Editor 8. The up to date configuration files (csv
files) must be available for import.
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6.3.1 Preparation

For importing the Symbols from PG5 project we need to use the Saia PG5 Data Import

Wizard tool.

The “Saia PG5 Data Import Wizard” is installed together with Saia PCD® Supervisor.

- Nav
¥ o D) My Network

@ My Host: SZA3LTJ06GWF2.global.ds.honeywell.com
(@ 127.0.0.1 (Demo_Station)
# Station (Demo_Station)
! Alarm
e Config
@ Services

° AlarmService
@ BackupService
@ CategoryService
@ JobService
@ RoleService
G UserService
G AuthenticationService
D-’ DebugService
@ BoxService
v FoxService
@ HierarchyService
@ HistoryService
° AuditHistoryService
° LogHistoryService
Ei ProgramsService
Q SearchService
o TagDictionaryService
TemplateService
@ WebService
T PlatformServices
n Saia PG5 Data Import Wizard
6 Drivers
6 NiagaraMetwork
© sBcsystems
@ Apps
Q Files
- Palette
[ E .@ i sbcofflineEngineering

n Saia PGS Data Import Wizard

3

It is a fact that the PG5 project (the program of the PCD controller) — from where the
symbols, to be imported - is developed in a completely different tool, and this tool is not
integrated presently in any way into the Saia PCD® Supervisor. Due to this fact at the
beginning the Saia PCD® Supervisor has no information about the PG5 project and its

symbols.

It is needed to copy the actual up to date and compiled PG5 project under to the Sta-

tion where it will be used.
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Typical shared folder of a station would be like this:

C:\ProgramData\Niagara4.3\SBC\stations\Demo_ Station\shared

So the complete PG5 project has to be copied there.

B9 - - [ 119 = shared - - o x
Home  Share  View e Home  Share  View (2]
S [ * B X =f [ [ o Fsetectan c T New item - Q) G B setectan
El 3 Copy path * a- e Select none Copy path £ ey access - E Selectnone
PintoQuick Copy Paste Move Copy Delete Rename  New Properties Pinto Quick Copy Paste by Delte Rename  New Properties
ADEras @ [ Pasteshortaut o o O B PEtes (@ History | @8 Invert selection ool [ Paste shorteut e o PErtes (& History | 2 Invert selection
. « 4 1> ThisPC » OSDISK(C) > 00.SBC > 10_PGS Projects » PGSV2.22m > Projects v o serchpects | € v 4[]« OSDISK(C) > ProgramData > Niagarad3 > SBC > stations > Searchshared P
b Music A Name Dat Type Size A A Name Size
Projects ke File Folder
=] Pictures . Jnﬁ i o) DDC Suite 27 EN Template Master
B Videos roje e older o
Project? 1 File Folder 9
L. 0SDISK(C) . NAY
Projects T File Folder o S
= EB14666 (\SZA3WO0D \Users) (P:) Projects 17 File folder onne >
| ryTransfer (\SZ43WO0OT) Projectl0 17 File folder ) Pictures P N
= s (WSZAZWOOOT) (5) Saia_PCD_Supenvisor_Shus_Demo R File Folder Y resources
- [ Videos Saia_PCD_Supervisor_Sbus_Demo_HC
= PROJECTS (\SZ4W0001) (%) T Filefolder T GRS
Samples 2 FileFolder = Customize thi folder
= Departments (\\SZ43W0001) (Z) P
e PR e - et = EB14666 (\\SZAIWOOO M Users) () —
| & Network WS Stotion02 . e folder U = TemporaryTranster nszaswooon ¢ e
v > = Applications (\SZ4WOOOT) (5) v
| = el h he Undo Copy Ctiz
| 2sitems 1 item selectes [E= | 7iems e A

The copy procedure has to be repeated at each time when modification was made.

(When compile of the PG5 project was happened, so the
could have been changed).

content of the symbol table

Naturally when the symbol table is changed, it is necessary to re-import the symbols
from the PG5 project to the Saia PCD® Supervisor point database.

During new import the Saia PG5 Data Import Wizard will retain all user defined con-
figuration of a datapoint, except memory address and comment. User can choose to
overwrite comment or address&comment during the process.

Manual Saia PCD® Supervisor | Document 27-651 ENG01 | 2017-09-27



Creating/Engineering a project Saia-Burgess Controls AG

Using the “Saia PG5 Data Import Wizard”

6.3.2 Importing symbols from PG5 projects

For importing symbols from the PG5 project the “Saia PG5 Data Import Wizard” has to
be started. This tool will do an offline symbol import. When the symbols are imported to
Saia PCD® Supervisor then we can call them "Points". Discovery of the symbols in the
SBC PCD device and do online symbol import is not possible.

1. Double click to the Saia PG5 Data Import Wizard under the currently used Sta-
tion. The Wizard opens.

At the beginning nothing is selected.

e
© Confi H s SaiaPGSDataImport Wizare /  Ssia PGS DataImport Wizard ~
2 . ® .
Saia PG5® Data Import Wizard

Scan Datapoints Alarm List HD Logs Import Finish

Choose the project to import data

null File

Enable all
Datapoints
Alarm List
HD Logs

1020000000 «®@H0000Q60

® X B & seofincengineenng

2] Ssia PGS Data Import Wizard Cancel

2. Chose the right PG5 project. Click to the “File” button and select the PG5 pro-
ject file of the project copied to the shared folder of the Station. Press OK.

D Saia PCD Supervisor Sbus Demo HC.saia5pj

file:"Sata PCD_Supervisor_Sbus Demo HC/Saia PCD_Supervisor_Sbus Dem

[l Station
© Config
@ Files
Q px
D resources
Q Saia_PCD_Supervisor_Sbus_Demo_HC
Q© CPUOOL
Q Libs
O _lastopen
» [ Saia_PCD_Supervisor_Shus_Demo_HC.saia5pj

OK Cancel

Manual Saia PCD® Supervisor | Document 27-651 ENG01 | 2017-09-27 6-43



Saia-Burgess Controls AG

Creating/Engineering a project

6-44

Using the “Saia PG5 Data Import Wizard”

Check the datapoints and press Scan

Saia PG5® Data Import Wizard

Scan Datapoints Alormlists HD Logs

Import Finish

Choose the project file (.saiaSpj) to import data

file:*Saia PCD_Supervisor_Sbus Demo_HC/Saia_PCD_Supervisor_Sbt File

Enable all
V| Datapoints
Alarmlists
HD Logs

At this window press Proceed

Verify Code Page

Code Page

1252 : Western European (Windows) R

Data Point Sample Text

Code page detected from PGS project

PROCEED CANCEL

n It is possible but please try to avoid accented or special characters.

Not supported characters $,# and %.

For others proper code page has to be selected then they are cor-

rectly visible.

The amount of the possible symbols are calculated. Press Next.

Saia PG5® Data Import Wizard

Datapoints Alarmlists HD Logs

Tmport Finish

Scanning complete

0

Datapoints Alarmlists

HD Logs
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5. The symbol list is populated.

Saia PG5® Data Import Wizard
4 5 6 7
Data Points Alarm HD Logs Import Finish
|
Choose datapoints to import
Device count: 1 Y Datapoints count: 219 Selected Poimts: 15
Device Point Name Media ~ Point Name Device
~ CPUODL
A A Alarm myAlarmList Flags F Heating] Ack cPUODL
Alarming A Alarm myAlarmList Handl R
Alarm myAlarmList Handle
EDL"E . Heating] OpMode Day cPU0L
IOE"““E A Alarm myAlarmList MyName TEX
< AHDLog DateTime Day R Heating] OpMode HeatPeriod €PU0D1
N
Web AHDLog DateTime HMSM R Heating] Outside. Temperature PhysVal CPU0O1
A HDLog DateTime Millisecond R
Heating] Return Temperature PhysVal cPU0O1
A HDLog DateTime Month R
AHDLog DateTime. YMD R Heating] Return Valve ThreePoint_close €PU0D1
Back Next Reset Selection

The top of the Wizard window can be seen that the procedure is at the stage of
datapoints.

Alarm Tist HD Logs Tmport Finish

The left side of the Wizard window the found Devices with the symbol groups
of the selected device. There is also a filter icon which pops up the possible
filter settings.

Device count: 1 Y

Device

A
Alarming
HDLog
Heating1
10

S

s
Web
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In the middle of the Wizard window the symbols are shown with full names and
details. It is possible to zoom the window by clicking the icon at the right top-
most corner.

Datapoints count: 219 =

Point Name Media Type Memory Address Data Format Comment

A Alarm myAlarmList Flags F 6166 Boolean = Alammflags
A Alarm myAlarmList Handle R 2175 Signed Int M Handle-ID
A Alarm myAlarmList MyName TEXT 3000 String = Name of list
A HDLog DateTime Day R 2334 Signed Int - Day
A HDLog DateTime HMSM R 2335 Signed Int = Hours/Minutes/S. ..
A HDLog DateTime Millisecond R 2336 Signed Int = Milliseconds
A HDLog DateTime Month R 2337 Signed Int = Month
A HDLog DateTime Sec1970 R 2338 Signed Int = Seconds since 1970
A HDLog DateTime. Week R 2339 Signed Int M Week of year
R 2340 Signed Int = Year
R 2341 Signed Int = Year/MonthDay

A HDLog DateTime. Year
A HDLog DateTime YMD

The symbols can be selected one by one by checking the checkbox beside the
symbol. Or at the top beside the Point Name by checking the checkbox all the
symbols are getting selected in the actual group.

The Data Format can be changed per Points. For example, when Register is
the data type from the PG5 project the format of the data in the register can be
Signed / Unsigned Integer or Motorola / IEEE float.

6. The right side of the Wizard window shows those symbols which are selected
therefore are getting imported. This window can also be zoomed. Beside the
symbol the big X icon is used to remove the symbol from the selection.

Selected Points: 3

Point Name Device

Heatingl Ack CPUO01
Heatingl OpMode Day CPUO01
Heatingl OpMode HeatPeriod CPU001
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7. Because in the middle window of the wizard shows all the symbols the System
integrator has to be able to select the symbols which are needed to be import-
ed. Filter can be defined, so only the interesting symbols will be shown.

Filter Data Points by X

Select All
v Registers
¥ Flags

Counters
I/'Os
Timers
DB

Text

Hide Data Points Starting with

A S 10 s

RESTORE DEFAULTS APPLY n

It is possible to select the type of the symbols to be filtered.

Or it is possible to define symbol groups not to be displayed. For that user must
click to the + icon at the right side of the list and define the Group name (e.g.
Web). There are some default symbol groups predefined.

Filter Data Points by X

Select All
o Registers
o Flags

Counters
L'Os
Timers

DB

Text

Hide Data Points Starting with

A 8. 10 s

Web|

RESTORE DEFAULTS APPLY

Click to Apply to make the filter settings effective.

Device count: 1 Y  Datapoints count: 2 E Selected Points: 17 E
Device v Point Name Media Type Point Name Device
CPU00L
A v Web HMS R
Alarming Heating1 Supply Pump Alarm CPU001
HDLog v Web YMD R
Heatingl Heating] Supply Pump Feedback CPU001
10
S Heating] Supply Pump MotorProtection CPUDO01
s
;
= Heating] Supply Pump Output CPU001
Heating1.Supply. Temperature PhysVal CPU001
Heatingl.Supply. Temperature. SetPt CPU001
Web HMS CPU00L
Web. YMD CPU00L
Back Next Reset Selection

Or you can Restore Defaults settings when it is needed.

8. We need the symbols from the Heating1 group and also from the Web group.
Select them and press the Next.
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9. Pop-up window is displayed to warn you to overwrite or not the datapoint (the
first one in the list).

It is possible to select the action for the remaining conflicts of the point data-
base.

Check the “Do this for all conflicts” and press Overwrite.

Presently it works this way
- Overwrite = it overwrites the addresses and also the comments

- Skip = it overwrites the addresses only

H Cnnf]rm

Do you want to overwrite datapoint (EnTrend) for the device (CPU001) duning import 1f exists?
OVERWRITE - Overwrite Memory Address & Comments
SKIP - Skip Comments only

Do this for all conflicts

Overwrite Skip

During new import the Saia PG5 Data Import Wizard will retain all
user defined configuration of a datapoint, except memory address and
comment.
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10. The SBCIpNetwork driver folder is automatically generated under the Drivers
folder of the Station. The datapoints were imported to the Points folder of the
SBClpNetwork driver. The datapoints are hierarchically structured as they are
in the PG5 symbol table. The main folder of the Points are named according to
the Device name in the PG5 project.

PCD device name can be the same in different PG5 Projects. Take
care of it and make it sure that the imported Device names are unique
in the Saia PCD®Supervisor.

The Import Wizard always put the points in the SBCIpNetwork folder.
This folder can be renamed. The next import then will be done to the
renamed folder. The target folder of the import can not be freely cho-
sen.

- Nav
E@ O @ My Metwork

@ HierarchyService
e HistoryService
o AuditHistoryService
o LogHistoryService
@ ProgramService
0 SearchService
° TagDictionaryService
TemplateService
@ WebService
T PlatformServices
n Saia PG5 Data Import Wizard
e Drivers
e NiagaraMetwork
Q) sBC systems
6 SBClpNetwork_Demo
x Tuning Policies
 sBCIpNetwork
: TuningPolicies
@ cruont
o Alarm Source Info
!0— Poll Scheduler
e Points
(1] Heatingl
o Ack
A opMode
H cutside
3 Retumn
A supply
H web
@ Alarms
@ Histories
. Device Information
“ Data Poll Frequency
@ Apps
e Files
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11. It can happen that the generated structure is not fitting to the predefined struc-
ture of the Saia PCD® Supervisor.

Then it is possible to move the points to an other “SBClpNetwork” with simple
cut and paste action.

* Nav (2 - Nav
¥ o ¥ G
© AuditHistoryService
© Loghistoryservice
T Platiormservices
Paste
§ Paste Special
8 Duplicate
u
Delete
Link Mark
O secipnetw
X TuningPolicies Relation Mark
© app
@ Files
Hierarchy
@ Hisory Rename

The not used “SBCIpNetwork” then can be deleted.

It is also possible to rename the element of the folder structure. It makes
mainly sense to rename the PCD Device (the top folder). The folders under are
having the right names since the PG5 project is also built up with structured
symbol names. Let us rename it to “Device1”

B ssia PGS Data Impgeey
O privers
O niagaranetwork

Duplicate

Delete

@ apps
@ Files
(&) Hierarchy
@ History Rename

Set Display Name

Presently the Saia PG5 Data Import Wizard is not capable to follow up
the Folder structure changes. So at the next import it will again import
the symbols under the SBCIpNetwork under Drivers.
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12. During the import a Conversion with factor 0.1 is applied automatically to
every Registers which has data type Signed or Unsigned Integer. This con-
version is used because the numbers in the Registers of the PCD device are
usually multiplied with 10. This multiplication is a kind of standard conven-
tion in case of Building Automation Projects. Of course the conversion can be
removed or modified by hand. For example, we need to modify the conversion
when we are working with time values. Then the division between minutes and
seconds would be 60.

figuration of a datapoint, except memory address and comment. User can choose to

n During new import the Saia PG5 Data Import Wizard will retain all user defined con-
overwrite comment or skip during the process.
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Properties of an imported datapoint

It can be seen in the AX Property Sheet of the datapoint that, there are many properties
available.

We already touched the “Conversion”.
In this chapter the others will shortly be described.
Let us double click to symbol which is “Numeric Variable” type.

For example:Device1/Points/Heating1/.Outside/Temperature/PhysVal.

The AX property Sheet will come up because this is the associated page (default by the
system, but changeable) to the datapoints.

- Nav  2a Property Sheet
P o ) My Network @ Physval (Mumeric Writable)
é . Faceis units=null,precision=1,min=-inf,max=<inf }) ’9 -
WebService
Proxy Ext SBCProxyExt
T PlatformServices f__-,! N Y o
Ll Status {ok}
n Saia PG5 Data Impart Wizard .
e Ll Fault Cause
Drivers
e MiagaraNetwork ‘Ml Enabled .trLE
© sBCSystems [M Device Facets » o -
 secipNetwork_Demo [ Conversion 7 Linear Scale|0.1 Offset[g.0
X TuningPolicies [M Tuning Policy Name  |Default Policy
© Devieet Read Value ~133.00 {ok}
© Alarm Source Info Write Value - {null} B def
E¢ Pollscheduler [l Memory Address 102
~ —
& Points [l Data Format Signed Int
A Heatingl
° & out -13.3 {ok} @ def
Ack
Pt In1 - {null}
OpMode
; In2 - {null} ¥
Da
G 4 In3 - {null} ¥
HeatPeriod
@ In4 - {null} ¥
Outside
In5 - {null} ¥
i) Temperature
o Ing - {null} ¥
Physval
M| L In7 - {null} ¥
Return
In8 - {null}
i) Temperature
o In9 - {null} ¥
Physval
4 In10 - {null} ¥
[2: ]
Valve
0 In11 - {null} ¥
PI_Signal
° e In12 ~ {null} T
signal
£ In13 - {null} ¥
G ThreePoint_clo:
Ini4 - {null} ¥
° ThreePoint_op
. In1s - {null} ¥
Suppl;
s In16 - {null} ¥
[2: ]
Web
@ Fallback - {null} ¥
A —
é Alarms [ Override Expiration  |mull
Histories =
= |l Media Type Register
Ll Device Information —
ll Comments Actual physical value outside air temperi
Q Data Poll Frequency
— Jl lcon module://sbe/resources/images/register.png
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Short description of the properties (top to down, row by row):

1. Name of without group structure and the type in bracket. The type of the
the data- datapoint is determined by the Saia PG5 Data Import Wizard dur-

point ing impo

rt. (changeable)

2. Facets This property allows you to configure how the value of the compo-
nent is displayed. For example, on a Numeric Writable component
you can set the units, precision, minimum and maximum value for
the Out property value.

In case of the example we can use the following settings. We use
three decimal precision. The “-inf and +inf” are the +/- infinity. As
it is @ measurement which comes from the PCD controller we do
not need to set min and max. But for a writable parameter for a
setpoint or for an output it makes sense to define the min / max
parameter in order to ensure the operator typed value never goes
out of its borders (e.g. by misstyping). The engineering unit can
also be selected.

Property Sheet

(Wl Facets

out
In1
In2
In3
Ind
In5

Physval (Numeric Writable)

units="C,precision=3 *C,min=-inf °C,max=+inf °C |

[3 Proxy Ext SBCProxyExt
[ status {ok}
[ Fault Cause
[ Enabled @ true
[l Device Facats > 0O
@l conversion A Linesr Scale 0.1
[ Tuning Policy Name  [Default Policy
Read Value -133.00 {ok)
Write Value ~ {null} @ def
[ Memory Address 102

[l Data Format Signed Int,

-13.300 °C {ok} @ def
- {null}
- {null}
- {null}
- {null}

- {nm1}

o -

DR

Offset 0.0

-

Key Type Value [

units Unit *C

precision Integer 3

min Double -inf

max Double +inf

e|x|o-
oK Cancel
-y B4
temperature (K) celsius (°C) o -
OK Cancel

Unfortunately the Facets settings are not set automati-
cally for the imported points. This means that the Facets
parameters must be set for every each imported points

manually.
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We use in the Saia PCD® Supervisor so called Proxy Points (this is
a feature of the Niagara framework). The function of the Proxy Point
is to show the values of the symbols from different controllers in a
uniformed way. The Proxy Points then are behaving in the same
way inside of the Saia PCD® Supervisor regardless if they come
from a SBC PCD controller or from a third party device.

1.

10.

Status

Fault cause

Enabled

. Device

Facets

Conversion

Tuning
Policy

Read Value

Write Value

Memory
Address

Data Format

{ok} communicating and ok

{fault} communicating but the value is
not correct

{down} no communication

{disabled} point is disabled

{stale} the value of the point is not
trustworthy

Possible cause of the fault

Enable / Disable the communication of this
datapoint (Save it if modified)

In cases for drivers that support a “Dis-
covery” mechanism, a proxy point may be
created with its facets (units) already de-
fined—these reflect its “Device Facets” (in
its ProxyExt). Not applicable for Saia PCD
Devices due to no discovery.

(Type, Scale and Offset): the raw value
comes from the PCD controller can be con-
verted using different mathematical transfor-
mation.

If other tuning policy has been defined it can
be selected here. The Tuning Policy is used
to define how frequently the datapoint is
communicated.

Value from the controller as it is.

The type of the datapoint is Numeric Writ-
able. So it possible to write back value to
the PCD Controller. Because the connected
variable in the PCD controller is a freely
readable and writable Register. Other hand
it can happen the user program in the PCD
controller s just cyclically overwriting this
Register.

The address of the memory slot in the PCD
controller to communicate with.

How the value is represented in the memory
slot in the PCD controller.
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4.

5.

9.

10.

Out

In1 to In16

Fallback

Override
Expiration

Media Type

Comments

Icon

This is the value which can be visible in the Saia PCD® Supervisor
and be used/connected to other place (e.g. creating logic in the
Wire Sheet”

These are inputs of this Proxy Point, if we see it as a Function
box. The inputs can be connected to somewhere to get values or
it is possible to define the value directly. There is a defined prior-
ity between the inputs (lowest In16). The values of the inputs can
be enabled / disabled with checking the checkbox “null”. Then the
values which is the highest priority will be downloaded to the PCD
controller.

. Property Sheet
Wire Sheet il beaal
PhysVal (Numeric Writable)
[ Facets units="C,precision=3 “C,min=-inf ‘Cmax==inf'C D -
P 1 (3 Proxy Ext SBCProxyExt
hysVal [ Status [ok)
Numeric Writab .
Out -13.300 °C ok} @ Ul Fault Cause
Ini - {rull] [l Enabled @ e
Iz 32.000°C {ok! .
[ Device Facet I

= ] B Device Facets » 0
Ina - [rull}] [l conversion [ Linear Scale 0.1 Offset|0.0
In5 - {null} [l Tuning Policy Name  Default Policy
Ing - {muill Read Value -133.00 [ok}
:g '{:::} Write Value 320.00 {ok} @ 2
e —{rull} :. Memory Address 102
Inid - {1} [ pata Format signed Int
Inii - [rull] out -13.300 °C {ok} @ 2
Ini2 - {null} n1 ~ [nuil}
Ini3 iul ] 32.000 °C {ok} *
Ini4 - {ull} n2 O null |32.000 B
Ini5 - {1} — *
Inig = [uall}]

174.000 °C {ok} z
Fallback - [rull} na o nall [78 W“DI <

- {oull} ¥

When any of the Input are not applied the Fallback value is ap-
plied.

It is possible to command Permanent or Time-duration bound
override. When Time bound override is applied, then the Override
Expiration shows the time and date when the override goes back
to Auto automatically.

The type of the memory slot in the PCD controller. Needed for the
correct communication.

Imported comment from the PG5 project.

Internal picture associated to this type of variable.

Certainly the other type of datapoints have a bit different looking Property Sheets. | do
not describe every each of them. To get familiar with them needs self-study and read-
ing the manuals.
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6.3.3 Alarming
Importing Alarm list generated in the PG5 project
There are at least two possible ways to handle the Alarms in the Saia PCD® Supervisor.

1. The Alarms are generated in the PCD controller. They are organized to a memory
territory, with Alarm text, time stamp, status (Acknowledged, Deleted, New, etc.)
and comment. This information can be then imported to Saia PCD® Supervisor.

Only SBC Web-Editor 8 generated Alarm lists are supported. SBC DDC
n Suite based alarms are not supported. Before importing the Alarm list and
the HD Logs the web project in the Web-Editor 8 must be compiled. Take
care to select the language for the Alarm list before compile in the Web-
n Editor 8. The up to date configuration files (csv files) must be available for
import.

2. In the Saia PCD® Supervisor there is alarm service which can be used to set
Alarms for individual datapoints, regardless if the datapoint is considered alarm or
not at the start of the engineering. For example the Outside air temperature can
generate an alarm when it is crossing the -20°C. For that we need to set monitoring
of this temperature in the Saia PCD® Supervisor. So the Alarm is generated in the
Saia PCD® Supervisor not in the PCD controller. Therefore this alarm can not be
seen for example in the SWeb application.

Here in this chapter we will see how to import the Alarm list form the PCD controller.
1. The Saia PG5 Data Import Wizard must be started.
2. The right PG5 project file must be selected in the File edit field.
3. Check the Alarm List checkbox

Saia PG5® Data Import Wizard

Choose the projeet filc (.saia5pi) to import data

file:"Saia_ PCD_Supervisor_Sbus_Demo_HC/Saia_PCD_Supervisor_Sby File
L O S —

Enable all
Datapoints
v Alarmlists

HD Logs
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4. Press Scan. The Alarm list of the selected PG5 project is being scanned.

Saia PG5@ Data Import Wizard
3 4 5 6 7
Data Points Alarm HD Logs Import Finish
Scanning complete
0 0
Datapoints Alarm List HD Logs
Back Next

5. Select the Alarm list to be imported.

Choose Alarmlist to import

Device count: 1 Alarmlist count: 1

Device o Alarm List Alarm Type DE EN FR Alarm List

v A Alarm myAlarmList MyName 1

v CPU00L

Vizualisation

Back

Selected Alarmlists: 1

A Alarm myAlarmList...

Device Language

CPU001

Next Reset Selection

6. If the Alarm list is generated with more languages then select the required languge.

Choose Alarmlist to import

Device count: 1 Alarmlist count: 1

Selected Alarmlists: 1

Device v Alarm List Alarm Type DE EN FR Alarm List Device Language
Y AdemmlamLahiNome 1 * AdlmmyAlrmlis . CPUML EN
Vizualisation
Back Next Reset Selecti
7. Press Next. And confirm to overwrite the Alarmlist.
Overwrite Alarmlist (A Alarm myAlarmList MyName) for the device (CPU001) during import if exists?
¥| Do this for all conflicts
OVERWRITE SKIP
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8. The Import is running

Data import is in progress, this will take a while

00of0 1of1 00of0
0% 100% 0%
Datapoints Alarm List HD Logs

Import is ready. The details can be checked under the Device/Alarms folder.

More details are not available.

™ Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window Help

127.0.0.1 (Demo_Station) . Station (Demo_Station) I Config . Drivers . SBClpNetwork . CPUOD1 o Alarms o Aalarm.myAlarmList. MyName
- Nav Property Sheet
P O () My Network © Aalarm.myAlarmList.MyName (SBCAlarmlList)
E Alarm List Name myAlarmlist
@ My Host: SZ43LTJ06GWF2.global.dz.haneywell.com m Alarm List Number 0
@ 127.0.0.1 (Demo_Station) (@ Memory Address 3000
# Station (Demo_Station) m Language EN
‘. Alarm
@ Config
@ Services
e Drivers
G NiagaraMetwork
© seCsystems

 seciphetwork
I Tuning Policies
@ cruon
o Alarm Source Info
IO- Poll Scheduler
e Points
@ Alarms

° A.Alarm.myAlarmList. MyName
@ Histories
m Device Information
Q Data Poll Frequency
Apps

e Files

E Hierarchy

@ History

9. Check the Alarming behaviour by generating test alarms in the corresponding SBC
PCD controller.
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6.3.4 Importing Historically logged data so called HD Logs

There are at least two possible ways to handle the Historically logged data in the
Saia PCD® Supervisor.

1. The HD Logs are generated in the PCD controller. The HD Log data can be saved
in different format and into different memory territory in the PCD device. The
Saia PCD® Supervisor supports only "csv" file based log data which are saved to
the Flash File System of the PCD device. (This means that, the HDLog 3.0 Fbox
generated logs, which are saved to INTFLASH, M1_2FLASH and SLOTO_3FLASH
can be imported.)

2. In the Saia PCD® Supervisor there is History Service which can be used to log the
interesting values to the hard drive of the PC. So the logged data then any time can
be retrieved and can be displayed e.g. as a trend curve. So the Historical Log is
generated in the Saia PCD® Supervisor not in the PCD controller. n

Here in this chapter we will see how to import the HD Logs form the PCD controller.
1. The Saia PG5 Data Import Wizard must be started.

2. The right PG5 project file must be selected in the File edit field.

3. Check the HD Logs check box, and press Scan

Saia PG5® Data Import Wizard

Choose the project file (.saiaSpj) to import data

file:*Saia PCD_Supervisor Sbus Demo HC/Saia PCD_Supervisor Sbt File

Enable all
Datapoints
Alarmlists

¥ HD Logs

4. Press Proceed or select the right codepage manually and press Proceed.

Verify Code Page

Code Page

1252 - Western European (Windows)

Data Point Sample Text

Code page detected from PGS project

PROCEED CANCEL
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5. Summary of the found HD Logs is displayed, press Next

Saia PG5® Data Import Wizard

Data Points Alarm

HD Logs

Import Finish

Scanning complete

6. The detail view of the HD Logs is displayed. Select the needed HD Log files. Inside
of one HD log file can be many different data points logged (symbols). Then press

Next.

Choose HDLogs to import

Device count: 1

Device

b CPUO0L

HDLogs count: 1

v HDLog Name

v Logfile

Points: 5

B Seclected HDLogs: 1 ]

HDLog Name Device

Logfile CPU001

Back Next Reset Selection

7. Check the check box and press Overwrite to proceed. The existing configuration
will be overwritten.

v| Do this for all conflicts

OVERWRITE

SKIP

Overwrite hdlog (Logfile) for the device (CPU00L) dunng import if exists?

8. The Import Wizard reports the successful import.

‘Tmport complete.

< [

HD Logs

Import is ready. The details can be checked under the Device/Alarms folder.
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6.3.5

9. Check the result in the NAV tree / Device / Histories.

10. The default settings is to get the data from the PCD device (controller) once per
day. This can be changed to get the data faster for example every 10 minutes.

i Station (Demo_Station) R : Drivers  SBClpNetwork 1 cPUGHL

- Nav Property Sheet
B O D My Network 2 Logfile (sBCHDLog)
(3l Hd Log Name Logfile

Gl Hd Log Poll Frequency  2:00 AM {Sun Mon Tue Wed
@ 127.0.0.1 [Demo_Station) Time Of Day
& station (Demo_station] Randomization

@ My Host : SZ43LTI06GWF2.global.ds.honeywell.com

(g Trigger Mode Daily
A alarm Days Of Week
O config [l Last Trigger  [mull

@ services (ol Mext Trigger 14-Apr-2017 02:00 AM CEST

) niagaranetwork
© sBC systems
® secipretwork
X TuningPolicies
@ crPuooy
© alarm Source Info
B« Pollscheduler
&5 raints
(@ Alarms
©® Histories
<k |ogfile
[l pevice Infarmation
Gl Data Poll Frequency:
© apes
& Files
Hierarchy
@ nistory

Starting the communication after the import

Drivers can be seen effectively as language packs. After the execution of the

Saia PG5 Data Import Wizard we have got a new driver called the SBCIpNetwork.
Once a driver is in place and configured the Saia PCD Supervisor can speak to that
protocol.

The PG import wizard works offline. It does not require a network connection to the
PCD.

If the IP address and S-Bus station number of the Saia PCD was correctly configured
in the Device configurator and the PCD with the Saia PCD® Supervisor software is con-
nected to the same network and if the network setup is correct, then the communica-
tion should work directly after the execution of the “Import wizard” without problems.
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6.3.5.1 Enabling the Saia S-Bus IP-Driver

1. In the Nav tree open the Station/Drivers/SBCIpNetwork. Double click on the
Device1.

2. In the property sheet check the settings (red colour marked lines) and enable the
driver.

3. Save the modification.

m» Saia PCDE® Superviso

File Edit Search Bookmarks Tools Window  Help

127.0.0.1 (SBC_SBus_Project) : Station (SBC_SBus_Project) I Config . Drivers I SBCIpMetwork
- Nav Property Sheet
¥ O © wynetwork ) seClpMetwork (SBCIpNetwork)
[ status {ok}
@ My Host : WIN-IFE3J6TEIUL [ Enabled [ T
© wyFile system [ Fault Cause
O 1y odules 3 Health Ok [26-Apr-17 9:52 AM CEST]
& Platform © Alarm Source Info  Alarm Source Info
© 127.0.0.1 (SBC_SBus_Project) L3 monitor Ping Monitor
& Platform X Tuning Policies Tuning Policy Map
@ Application Director @ Channel Type S-Bus TCE/IP
€ certificate Management @ Devicel - Copy $BCHeadStation
@ Lexicon Installer @ Devicel SBCHeadStation
© License Manager [ Status {down, alarm, unackedh.
© Plstiorm Administration [ Enabled @ e
© ststion Copier [ Fault Cause
6 TcriP configuration 3 Health Fail [26-Apr-17 8:52 AM CEST] Timed out ...
@ Remote File System o Alarm Source Info Alarm Source Info
& station (58C_SBus_Project) B¢ Datapoints Poll Scheduler N Poll Scheduler
A Aarm m Datapoints Poll Frequency ~ Mormal
© config [ Ip Address 172.23.13.2:5050
@ services (@l IpAddress  172.23.13.6
6 orivers T Port [ unspecified 5050 [-1-85538]
© sscipnetwork [ Station1d &
X TuningPolicies & Foints SBCPointDeviceExt
@ Devicel-Copy @ Alarms Alarms
° Devicel @ Histories Histories
6 nisgeranetwork [ Device Information SBCDevicelnformation
© apps [ Ftp Username
& Files [ Ftp Password
p Q offline [@ Http Password
- Palette Gl Alarms Poll Frequency 30secs {5un Mon Tue Wed Thu FriSat }
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6.3.5.2 Checking different settings to get the communication working

The following picture shows that the communication is not working the devices are
orange colored

® Saia PCD® Supenviso

Bookmarks  Tools Window  Manager

Help

: Station (SBC_SBus_Project)  : Config @ Drivers @ SBCIpNetwork
A
Nav Database
I O @ My Network Name Type Exts Status Health

& My Host: WIN-IFE3J6TBIUL @) Devicel-Copy SBCHeadStation 4% {down} Fail [26-Apr-17 9:27 AM CEST] Timed out waiting for response.ShcPacketTraceMessage
& 1y File System @ Devicel SBCHeadStation /%  {down} Fail [26-Apr-17 9:27 AM CEST] Timed out waiting for response.ShcPacketTraceMessage
O vy Modules
& Platform

@ 127.0.0.1(SEC_SBus_Project)
& Platform

® application Director
€ certificate Management
@ Lexicon Installer
© License Manager
© Platform Administration
@ ststion Copler
 TcP/IP Configuration
) Remote File System
& station (5BC_SBus_Project)
A Alsrm
© config
@ Services
 orivers
) secipetwork
X TuningPolicies
@ Devicet - Copy

@ Devicer

The following steps are needed to do debugging communication problems.

1. Check the communication between PG5 and the Device
This only works if the PG5 is installed onto the same PC

It should be possible to go online to the PCD with the online configurator of PG5
over a “Socket connection”

I File Edit View Project Device Online Tools Help
= = = e = =
PR AP -3

i Project Tree

-HE] Project 'Project_for_Miagara' : 2 Devices
-*f  Properties

2 TCP/IP Settings Table
(3 Common Files
[tig] Library Manager

L0 Properties
L Igj: Online Settings - S-Bus USB: PGU
EZ Device Configurator

[ Build Options

4123 Program Files
-23 Listing Files

‘([ Documentation Files
[ Devicel - Copy - PCD3.M6860 - 172.2313.5, 0.0.0.0, 5-Bus 5tn 5

- Devicel - PCD3.M6860 - 172.23.13.6, 0.0.0.0. S-Bus Stn 6

Select the channel

[sooEr
E SOCKET

5-Bus Station Number 6
Auto Station Mo
IP Address or Host Name 17222136

Mumber of retries 3

IP Address or Host Name

Enter the IP Address or the domain name (without the http: part) of the
PCD.
The Host Mame must resclve to an [P Address by the DMNS server.
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. [Devicel] - Saia PGS Online Cenfigurato

General functions

File Online Tools Options Help

Online Settings
SOCKET: TCP/IP, 1722313 6. Stnb

Go Offline

Online Setings... |

Information
PCD Type: PCD3MEEED Py 12615 |m|
Prograrm: Devicel -
Date: oh42017 Day: 3 | Hodworelnfo.. |
Time: :41:15 Week: 17 ]
| Histaory: |
Status: Fun -
| Clock... |
Help | | Fun | | Stop | | Festart | | Close |

the PCD.

BN Chwindows\system32\cmd.exe

Microsoft Windows [Ue

out.
out.
out .

Request timed out.

Packets:

FPing statistics for 172.
Sent = 4. Received

on 6.1.766811

23.13.6:

C:sUsers~EB14666>ping 172.23.13.6
Pinging 172.23.13.6 with 32 bytes of data:

Copyright <c> 208? Microsoft Corporation.
C:wUsers~EB14666>ping 172.23.13.6
Pinging 1?2.23.13.6 with 32 hytes of data:

2. Ifit's not possible to go online over Socket to the PCD, try to ping the IP-address of

All rights reserved.

=4 (188» loss).

Reply from 172.23.13.6: bytes=32 time=17ms TIL=64
Reply from 172. H 32 time=14ms TTL=64
Reply from 172.23.13.6: 32 time=14ms TTL=64
Reply from 172.23.13.6: bytes=32 time=5ms TTL=64

Ping statistics for 172.
4, Received = 4, Lost = @ (Bx loss>.

Packets: 8Sent =

23.13.6:

Approximate round trip times in milli-seconds:

Minimum = 5Sms.

C:wUserssEB14666>_

Maximum

= 17ms,

Average =

12ms

If it’s not possible to PING the PCD, there must be a problem with the
network setup (e.g. IP address or Subnet mask)

or there is a problem with cabling or switches

or there is problem with Windows Firewall Settings:

- File and Printer sharing must be enabled
- ICMP Echo Requests must be enabled

6-64

Manual Saia PCD® Supervisor | Document 27-651 ENG01 | 2017-09-27



Creating/Engineering a project Saia-Burgess Controls AG

General functions

3. If there is connection to the controller but PCD Supervisor reports communication
error, check the settings in the network driver.

® Saia PCD® Superviso

File Edit Search Bookm

(oI S
127.0.0.1 (SBC_SBus_Project)
- Nav
L O (D) My Network
@ My Host: WIN-IFE3J6T6IU1
e My File System
0 My Modules
& Platform

@ 127.0.0.1(SBC_SBus_Project)
& Platform
@ Application Director
o Certificate Management
o Lexicon Installer
@ License Manager
° Platform Administration
9 Station Copier
e TCP/IP Configuration
@ Remate File System
& station (SBC_SBus_Project)
._. Alarm
e Config
@ Services
6 Drivers

) sECipNetwork
:l: TuningPolicies
° Devicel-Copy
° Devicel
e NiagaraMetwark
@ apps
a Files
b 0 offline
- Palette

: Station (SBC_SBus_Project) @ Config @ Drivers

Window  Help

0 =- @

. SBClpNetwork

Property Sheet
) sBCIpNetwork (SBCIpNetwork)

(W Status {ok}

[l Enabled @ true

(W Fault Cause

[ Health Ok [26-Apr-17 9:52 AM CEST]

© rlarm Source Info  Alarm Source Info
L1 Monitor

X Tuning Policies
W Channel Type

Ping Monitor
Tuning Policy Map
S-Bus TICE/IP

@ Devicel - Copy SBCHeadStation
@ Devicel SBCHeadStation
m Status {down, alarm, unackeda’
[Ml Enabled @ e
[l Fault Cause
3 Health Fail [26-Apr-17 9:52 AM CEST] Timed out \...

© Alarm Source Info Alarm Source Info
B+ Datapoints Poll Scheduler N Poll Scheduler

[Ml Datapoints Poll Frequency ~ Normal

Ml Ip Address 172.23.13.3:5050
@ IpAddress  [172.23.13.6
(@ Port [ unspecified 5050 [-1-65536]
(@ Station1d 5
& Foints SBCPointDeviceExt
@ Alarms Alarms
@ Histories Histories

M Device Information SBCDevicelnformation
ﬁ Fip Username

(M Ftp Password

(@l Http Password

@l Alarms Poll Frequency 30secs {Sun Mon Tue Wed Thu FriSat }

4. Restart the Platform Demon at last.

It is possible that restarting the Platform Daemon will help because the used net-

work adapter and ports settings are getting updated after restart.

L Windows Update
‘ Wireshark Legacy
‘ Wireshark
< XP5 Viewer
. T-Zip
. Accessories
. FileZilla FTP Client
. Games
. LonMark
. Maintenance
. Motepad++
. PG5 Suite V2.2.221
. SaiaPCDSupervisor

£ Alarm Portal

E Console

[="] Demo Station

[ Install Platform Daemon

“®> Saia PCD Supervisor Beta (Console)

“®> Saia PCD Supervisor Beta

G2 Uninstall

Attila

Documents

Pictures

Music

Computer

Control Panel
Devices and Printers
Default Programs

Help and Support
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The communciation is ok when the Devices are not colored and their status is
{OK}. In addition, it is possible to see valid information of the PCD in the Nav tree
Device Information subdirectory.

IR Fle Edit Scarch Bookmarks Tools  Window p Q data poll frequency

127.0.0.1 (SBC_SBus_Project)  : Station (SBC_SBus_Project)  : : Drivers  : SBCIpNetwork  : Devicel  : Devicelnformation /"  AXProperty Sheet -

Property Sheet
[ Device Information (SBCDevicelnformation)
(@ PCD status Run
0@ PCD Type PCD3.M6860
(@ PCD Clock 17-04-26T10:13:01
(@ Firmware Version  [1.26.15
(@ Time Zone Europe/Berlin (-1/-2)
Qll AlarmsPoll Frequency
© NisgaraNetwork
© 4pps
& Files
[ Hierarchy
@ nistory.

- Palette
W X B | § schedule

BB Booleanschedule

6.3.5.3 Tuning the Saia S-Bus IP-Driver

There are not so many possibilities given to fine tune the communication. It is possi-
ble to set three different kind of speeds (Fast Rate, Normal Rate, Slow Rate) as base.
Then it is possible to set up the rates for a complete device.

B+ Datapoints Poll Scheduler N Poll Scheduler
@ Poll Enabled @ true
(W Fast Rate 00000 00m 01.00082 [1ms-+inf]
(@ Normal Rate 00000Rh 00m 05.0003)2 [1ms-+inf]
[i Slow Rate 00000k 00m 30.0003 |2 [1ms-+inf]
[i Statistics Start 31-Aug-2017 10:31 AM CEST
[ Average Poll 0.0ms
li Busy Time -
[ Total Polls 3109 over (ms
[l Dibs Polls 0% (1/3109)
[ Fast Polls 0% (0/3109)
li Normal Polls 99% (3108/3109)
@ slow Folls 0% (0/3109)
[ Dibs Count current=0 average=0
li Fast Count current=0 average=0
[l Mormal Count current=1 average=0
[ slow Count current=0 average=0
li Fast Cycle Time average = 1000ms
(@l Wormal Cycle Time  |average — 5001ms
[ slow Cycle Time average = 1000ms
[ Datapoints Poll Frequency  |Normal

The polling rate is the same for all datapoints within a Device.
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For the Alarm list it is possible to set a polling rate. As default 30 seconds is set. Which
means, that the alarms located in the Saia PCD device are polled in 30 seconds. Then
the new alarms and/or acknowledgment are transferred. The polling rate can be ad-
justed or scheduled. The details of the different settings can be found in the Niagara

documentation.

@l Alarms Poll Frequency 30secs {Sun Mon Tue Wed Thu Fri Sat}
Interval 00000k 00m 3032 [Lms-+inf]
TimeOfDay [ StartTime 12:00:00 AM CEST | EndTime 11:59:59 BM CEST

Days Of Week [#] Sun [ Mon [ Tue [#] wed [ Thu [ Fri ¢ sat

[ LastTrigger  |31-Bug-2017 02:12 PM CEST

(@ Trigger Mode  |Interval

[l Next Trigger 31-Rug-2017 02:18 BM CEST

G Refresh Save

For the Histories (HD Logs) it is also possible to set a polling rate. The default set- n
tings is Daily at 2 o'clock in the morning to retrieve the HD logs from the Saia PCD

Device. This setting can be changed to e.g.: Interval, 30 seconds. Which means, that

every 30 seconds the HD Log data is polled, then the new values are uploaded to the

History files of the Saia PCD Supervisor. The details of the different settings can be

found in the Niagara documentation.

(® Histories Histories
& Fuehlerl SBCHDLog
[l HD Log Name Fuehlerl
Qll HD Log Poll Frequency  2:00 AM {Sun Mon Tue Wed Thu Fri Sat}
Time Of Day 02:00:00 RM CEST 3
. Trigger Mode Daily Randomization |+00000h 00m 003 =
Days Of Week [ Sun [#] Mon [ Tue [#] wed [#] Thu [# Fri [ sat
@i Last Trigger 31-Aug-2017 09:27 AM CEST
[l Mext Trigger 01-5ep-2017 02:00 AM CEST
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Configure Scheduled tasks

This chapter describes how to configure Schedulers to control the automations system
during occupied and non-occupied time.

Scheduler

The Scheduler provides control of values and changes setpoints based on time and
date. Lights, Fans, and HVAC equipment are turned on and off based on the time, day
of week and date. The Scheduler is also used in process control and manufacturing
applications.

Presently there is no Saia PCD Supervisor compatible Schedulers in the SBC PCD
Device. It means that, if the automation system needs high level scheduling functions,
this must be done “upstairs” in the Saia PCD Supervisor not in "downstairs” in the
PCD Device. Which has the drawback that if the Supervisory computer fails to work
the Scheduling function fails too.

There is an exception. It is possible to use the Saia PCD Device as BACnet Control-
ler, in this way the BACnet standard scheduling functions can be used. This is com-
patible with the Saia PCD Supervisor. However it needs to license and use the 3rd
party (BACnet) driver in the Saia PCD Supervisor.

Schedules are created using schedule components found in the schedule palette.
Place these components in a station, configure, and link as needed to provide schedul-
ing control of other components.

Scheduling functionality is the same whether using Workbench or an HTMLS5 web
browser with one exception. Currently, in a web browser connection, you do not have
the options to copy or paste components.
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Schedule component categories

Component category Description

Weekly Boolean Weekly schedules define regular, repeating, events
Numeric by “time-of-day” and “day-of-week.” Also, you can
Enumerated | configure any number of “special events” on a weekly
String schedule. Weekly schedules are the most used sched-

ule components. Four different types vary by data
category (Boolean, Numeric, Enum, and String). Each
is identical except for input/output.

Calendar Calendar schedules define specific days. Use a cal-
endar schedule to define days with scheduling excep-
tions (e.g. holidays), and reference them in the “spe-

cial events” setup of weekly schedules. n

Trigger Trigger schedules fire actions or topics. With a set
of pre-configured schedules and a ScheduleSelec-
tor component, you can simply choose from a list of
valid schedules to setup or change the schedule of a
device.

Selectors Schedule Selector components provide an easy way
for you to select a schedule to use for controlling a
particular component. As needed, you typically link its
output to an action of a control point or extension.
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Weekly Default view

for any weekly schedule component. In Work-
bench the Scheduler view provides four configura-
tion tabs:

Weekly Schedule

Sunday-through-Saturday (weekly) event times/
values. Use this to define the regular weekly
events.

Special Events

All exceptions to the defined weekly schedule, as
special events. Use this to define special event
times.

Properties Important properties such as default output,
schedule effective times, special event clean-up
operation, and schedule facets.

Summary for any selected day, provides a tabular summary

of all schedule events, with source. Also available
under the Scheduler view dropdown list:

Current Day
Summary

provides a simple 24-hour linear graph of schedule
event times and values for the current day.

Calendar |Default view

for a CalendarSchedule component. The Calendar
Scheduler view provides a calendar where you
can add, edit, or delete specific calendar days
(exceptions to the regular weekly schedule) and
establish relative priorities.

Trigger Default view

for a TriggerSchedule component. The Trigger
Scheduler view provides a two-part view combin-
ing a “day picker” and an event “time picker” for
specifying when topics are fired on those days.

We configure a Weekly schedule and a Calendar Schedule in this chapter.

In a web browser the Scheduler view provides two configuration tabs: Weekly Sched-

n ule and Special Events.

While the Current Day Summary and Property Sheet views are available under Sched-

uler view dropdown list.
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Examples

e Weekly Schedule
The task is to configure a weekly schedule which switches on the Light in the nor-
mal office time from Monday till Friday and from 8:00 till 17:00. Friday the office time
is reduced only from 8:00 till 14:00.

There is special event on 1st of September 2017. In this day the Light must be
switched off from 9:00 till 11:35 due to test.

e Calendar Schedule
There are known official Holidays like Christmas or the Swiss National Day where
the office is unoccupied therefore the Light must be Switched off.

The steps to add and configure Schedulers to the Saia PCD Supervisor: n
1. Creating folder for the scheduling components

. Add Weekly Scheduler component from Palette

. Configuring normal events weekly schedules

2
3
4. Configuring special events weekly schedules
5. Add Calendar Scheduler component from the Palette
6. Configuring Calendar Schedule

7

. Make the logic to control the physical point in the PCD device
or

8. Make the logic to control the physical point in the PCD device using reference be-
tween the schedulers.
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6.4.2 Creating folder for the scheduling components

Schedules can be created and added to any part of Saia PCD supervisor. However, it
makes sense to manage these in a central location.

1. In the Nav tree open 127.0.0.1(localhost) > Station > Config
2. Create there a folder called Scheduler.

3. Double click to the folder. The associated Wire Sheet will be opened.

» 5aja PCD® Supervisor

File Edit Search Bookmarks Tools Window  Wire Sheet  Help

4 B O- o O 00 =~ [
n 127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config . Schedulers

- Nav Wire Sheet

|=® o @Mer:twork

@ My Host: SZ43LTI06GWF2.global.ds. honeywell.com
@ 127.0.0.1 [Demo_Station)
# Station (Demo_Station)
.‘. Alarm
e Config
@ Services
6 Drivers
Apps
o Schematics
0 Schedulers
Q Files
E Hierarchy
@ History

More details of using Wire Sheet can be found inside of the Niagara docu-
mentation.
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6.4.3 Add Weekly Scheduler component from Palette

1. Open the schedule palette

- Palette
EI E] @ i schedule

<& Open Palette

Select one or more palettes to open, orjust start typing:

? schedule

Browse...

B Booleanschedule

B EnumSchedule

B NumericSchedule

-::] StringSchedule

A calendarschedule

=22 TriggerSchedule

B BooleanScheduleSelector
FH NumericscheduleSelector
:::] stringScheduleSelector
B EnumScheduleSelector

Module Description

Schedule Framewaork

0K Cancel

2. Drag and Drop the BooleanSchedule component to the Wire Sheet of the Schedul-

ers folder.

3. In the pop-up dialog specify the name of the component (Weekly_Schedule_Light)

[ ssis PCD® Supenizor

® Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window

Help

127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config
- Nav Wire Sheet
l=° o @ My Network

@ My Host : SZ43LTJ06GWF2.global.ds.honeywell.com
@ 127.0.0.1 (Dema_Station)
’ Station (Demo_Station)
! Alarm
@ Config
@ Services
6 Drivers
Apps
0 Schematics
0 Schedulers
Q Files
E Hierarchy

@ Histary

Weekly_Schedule_Light m
Boolean Schedule

Status

Out Source

In

et Time
NextValue
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6.4.4 Configuring normal events weekly schedules

1. Double click to the Weekly Schedule_Light function box to open the Scheduler
configuration window.
Saia PCD supervisor Schedules operate Sunday to Saturday and times
are set from top to bottom.

2. In the weekly view specify the time range for Monday. For that go to Monday 8:00
press the mouse left button and drag the mouse down till 17:00 o’clock.
The defined time range will be shown as green stripe.

< Saja PCD® Supervisor had - m] X

File Edit Search Bookmarks Tools

4 oD O- o # O 0 w- @ @ D |
127.0.0.1(Demo_Station)  © Station (Demo_Station)  © Config  : Schedulers  : Weekly Schedule Light #  scheduler -
- Nav i

P o ) My Netw

@ My Host : S743L TJO6GWF2.
@ 127.0.0.1 (Demo_Station)
, Station (Demo_Statio
A Alsrm
e Config
@ Services
© orivers
Apps
D Schematics

- Palette
w X B | schedul

B Boaleanschedule EventStart |08:00 2M
B Enumschedule EventFinish 05:00 BM

B NumericSchedule Event Output [] null | @ true
B stringschedule
B calendarschedule

B TriggerSchedule [™) save 7 Refresh

[P Weekly Schedule | [i] SpecialEvents  [8] Properties () Summary

3. Do not worry if you do not find the exact time. Below the graphical representation,
in the Event Starts and Event Finishes edit fields it is possible to type it.

In the headings of the green stripe and in the Event Output drop down box the
scheduled value can be seen (true). It is possible to invert it.

4. Define time schedule for Tuesday to Friday too in the same way. Take care the of-
fice time in Friday is until 14:00.
It is possible to do copy and paste. Right mouse click to the green stripe and select
copy day. The selected time span is then shown in blue colour. Right mouse click
to the remaining days and select paste day. Then set Friday 14:00 o"clock.
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5. Click Save at the bottom of the page.

«® Saia PCD® Supervisor

File  Edit

127.0.0.1 (Demo_Station)

 C

@ My Host: SZ43LTJ0GGWF2.
@ 127.0.0.1 (Demo_Station)
& station (Dema_Statio
‘ Alarm
@ Config
@ services
e Drivers
9 Apps

0 Schematics

(D My Netw

- Palette
W X B | # schedul

B8 Booleanschedule
B8 Enumschedule
B NumericSchedule
B8 stringschedule
B colendarschedule
=::] TriggerSchedule

6.4.5

* Station (Demo_Station)

Windoew  Help

: Config

. Schedulers

* Weekly_Schedule_Light

EventStart |08:00 AM 3
EventFinish |02:[ PM 2
EventOutput (] null (@ true

BB weekly Schedule m Special Events m Properties G-) Summary

[™) save ‘ 7 Refresh

Configuring special events weekly schedules

1. Click to Special Events at the bottom of the page.

2. The Special Events summary page opens with the Today schedule visible.

@@ Saia PCD® Supervisor

File  Edit

127.0.0.1 (Demo_Station)

¥ O

@ My Host: SZ43LTI06EWF2.
@ 127.0.0.1 (Demo_Station)

() My Netw

’ Station (Demo_Statio
._‘ Alarm
e Config
@ Services
6 orivers
@ Apps

0 Schematics

- Palette
= X 3

FH Booleanschedule
BB Enumschedule
BB NumericSchedule
m StringSchedule
B8 Calendarschedule
M| TriggerSchedule

i scheduly

- Station (Demo_Station)

Config

4 PrevPage

. Schedulers

I Weekly_Schedule_Light

4 PrevMonth  Today | NextMonth p

Next Page P

Jul 2017

Sep 2017

Name Summary

@ add

Edit

[P Weekly Schedule [ special Events
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EventStart |03:29 PM
EventFinish 03:29 PM

Event Output [] null () true
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3. Click to Add and specify the date 1st of September 2017.

File  Edit

127.0.01 (Demo_Station) ! Stetion (Demo_Station)  © Config @ Schedulers  © Weekly_Schedule_Light

4 PrevPage 4 PrevMonth  Today | MextMonth p  NextPage p

~
2 C @ My Netw Jul 2017 Sep 2017

@ My Host: SZ43LTI06GWF2.
@ 127.0.0.1 (Demo_Station)
& station (Demo_statio
‘ Alarm
@ Config
@ services
e Drivers
A @ Add

© schematics Name  Summal Name [Switch OFf due test 3:00AM

6:00 AM
Type | Date 900 AM

- Palette B 12:00PM
Any Weekday Sep s 3:00PM

W X B |8 schedul 6:00PM

9:00 PM

B Booleanschedule OK Cancel EventStart |03:29 EM

B8 Enumschedule EventFinish [03:29 PM
B Numericschedule Priority Priority Rename Delete Event Qutput[ ] null .true
B stringschedule

B8 colendarschedule

m TriggerSchedule m Save | C Refresh

B weekly Schedule m Spedial Events m Properties C‘)Summary

4. Click OK

5. Specify the schedule to switch off the Light from 9:00 till 11:35. Do this at the right
side of the window by using the mouse and typing the values by hand.
Do not forget to specify the “false” value to switch off the light

«®> Saia PCD® Supervisor A - m} ¥

File  Edit

127.0.0.1 {Demo_Station) @ Station(Demo_Station)  © Confiz  © Schedulers  © Weekly_Schedule_Light

4 PrevPage 4 PrevMonth Today | NextMonth B NextPage p

o
O & wyNety Jul 2017 Sep 2017

@ My Host : 57431 TJOGGWF2.
@ 127.0.0.1 {Demo_Station)
’ Station [Demo_Statio
‘ Alarm
© config
@ Services
6 Drivers

@Apps
O schematics Name Summary Unscheduled
3:00AM

D Schedulers Switch_Off_due_Test Date:15ep 2017 S0DAM

9:00 AM
- Palette 12:00PM
300PM

[} E] E ischeduh 6:00 PM

9:00PM

[0 Booleanschedule
B Enumschedule EventStart |04:06 EM

BB NumericSchedul EventFinish [04:06 BM
umericSchedule

@ Add ® Edit Priority Priority  [I] Rename 3¢ Delete Event Output [] null | false
m StringSchedule

B calendarschedule BB Weekly Schedule ] specialEvents  [8) Properties (D) Summary
:::] TriggerSchedule

PR RonleanScheduleselertar [ save 7 Refresh

6. Save the configuration
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7. Check the summary. Click to Summary at the Bottom of the page. Navigate to 1st
of September 2017. Then in the text summary it can be seen the Special Event

entry.

«® Saia PCD® Supervisor

B O X

b @ My Host: SZ43LTIOEGWF2.
v (@ 127.0.0.1 (Demo_Station)

File  Edit

1 {Demo_Station)

(D My Netw

v & ststion [Demo_Statio
! Alarm
- 6 Config
b @ services
; eDnvers
» gApps

© Station {Demo_Station)

: Config

. Schedulers

Schedule_Light

7

Scheduler ~

4 Prev Page

4 PrevMonth  Today | NextMonth p

Next Page p

Jul 2017

1
. AEEEH »
> EOEEE -
« DEEEE »

Aug 2017

- AEBEEHE »
» I EE EE
» HAEEE »

Sep 2017

v D EEEE
v DEEAE

Oct2017

' gEEEd -
- IEEEE -
» EEEEE
» EQEEE »

g 0 Schematics
- 0 Schedulers
| Weekly.

e Files

.

- Palette
W X B | # schedul

B Booleanschedule

B Enumschedule

BB NumericSchedule

B stringschedule

BB calendarschedule

m TriggerSchedule

B BooleanScheduleSelector

- JEOED~ |- D0EE ||+ EBE0E0E | |- 0

= [

Timestamp Output  Source

01-Sep-1712:00 AM CEST false{ok} Default Output

01-5ep-178:00AMCEST  truefok} Week: friday

01-5ep-17 ::00AM CEST  false{ok} Special Event: Switch_Off_due_Test

01-Sep-17 11:35 AM CEST  true{ok} Week: friday

FFE Weekly Schedule  [i] SpecialEvents  [8] Properties (D) Summary

7 Refresh

B Numericscheduleselector
— m Save

Manual Saia PCD® Supervisor | Document 27-651 ENGO01 | 2017-09-27 6-77



Saia-Burgess Controls AG Creating/Engineering a project

General functions

6.4.6 Add Calendar Scheduler component from the Palette
1. Open the schedule palette

2. Drag and Drop the CalendarSchedule component to the Wire Sheet of the Sched-
ulers folder.

3. In the pop-up dialog specify the name of the component (Calendar_Schedule_
Light)

4. A Calendar Schedule function box is placed to the Wire Sheet.

«® Saja PCD® Supervisor had - O X
File Edit Search Bookmarks Tools Window  Wire Sheet Help
4 O O- o A O 0 - 2 O = o »
127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config . Schedulers / Wire Sheet ~

- Nav Wire Sheet
E O ®w

- - Calendar_Schedule_Light H
Calendar Schedule
@ 127.0.0.1 (Demo_3t:

’ Station (Dema_
! Alarm
@ Config

@ a3 Weekly_Schedule_Light
G Driver Schedule
.

- Palette
w X 3 s

BB BooleanSchedule

BB EnumSchedule
BB NumericSchedule

BB civimmcrlndeln
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6.4.7 Configuring Calendar Schedule

1. Double click to the Calendar_Schedule_Light function box to open the Scheduler
configuration window.

2. Click Add to schedule the Christmas holiday from 25th of December till 31th of
December.

File Edit Search Bookmarks Tools Window  Help

127.0.0.1 (Demo_Station) : Station (Demo_Station) I Config . Calendar_Schedule_Light y Calendar Scheduler -

~ Nav %4 4 PrevPage 4 PrevMonth  Today | NextMonth p

¥ o © ynets Jul 2017 Aug 2017 Sep 2017

L

@ 127.0.0.1 (Demo_station)
, Station (Demo_Statio
A alarm
@ Config
@ Services
e Drivers
Apps
0 Schematics
o Schedulers
B weekly,

10 11 12 13 14

17 18 19 20 21
23 PLN 25 26 27T 28
30 31

Name Summary

> Add

Name Christmas_Holiday

~ Palette (A Type | DateRange

W X B @ schedul Any Year

Through
B Booleanschedule

BB Enumschedule
B Numericschedule R E—

B stringSchedule
BB calendarSchedule Edit Priority Priority Rename Delete

m TriggerSchedule
D Save c Refresh

Dec Any Year

3. Click OK and then click Save.

4. Then it makes sense to define a holiday for 1st of January.
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5. Then specify the holiday for the 1st of August (Swiss National Day)

ervisor

Window  Help

Edit

File

. Calendar_Schedule_Light Calendar Scheduler -

4 PrevPage 4 PrevMonth  Today | NextMonth b  MNextPage p

Bep 2017

127.0.0.1 (Demo_Station) . Station (Demo_Station) : Config

l=e G C;)MyNstv Jul 2017
@ 127.0.0.1 {Demo_Station)
’ Station (Demo_Statio
‘Alarm 10 11 12 13 14
eConflg
17 18 19 20 21
@Serwces
bl 25 26 27 28
eDrwers
31
eﬁ\pps
O schematics Name Stz
osd’ledulevs
FFH Weekly,

FirstOfJan_Holiday Date:lJan
Christmas_Holiday ~Date Range: 25 Dec- 31 Dec

- Palette @ Add

] E] E isthsdul

BB BooleanSchedule
B Enumschedule

BB numericschedule
0K Cancel

m StringSchedule

B calendarSchedule ® Edit Priority W Priority [[]Rename 3 Delete
-::] TriggerSchedule
m Save g Refresh

Mame Swiss_National Day_holiday

Type |Date

Any Weekday Aug

6. Click OK, Click Save, Click Refresh.

7. Check the settings. Green background of the dates means schedule is set.

®» Saia PCD® Supervisor

File  Edit

edule_Light Calendar Scheduler =

4 PrevPage 4 PrevMonth  Today | NextMonth B NextPage p

127.0.0.1 (Demo_Station) © Station (Demo_Station)

Sep 2017 Dec 2017

¥ O (D) My Nety

@ 127.0.0.1 {Demo_Station)
’ Station (Demao_Statio
‘ Alarm
e Config
@ Services
e Drivers
6 Apps
0 SRt Name Summary
© schedulers
FFH weekly

Swiss_Mational_Day_holiday Date:1Aug
FirstOfJan_Holiday Date:1Jan

Christmas_Holiday Date Range: 25 Dec- 31 Dec

- Palette
[~} E] E ischedul

B8 Booleanschedule
BB Enumschedule
BB numericschedule
B stringSchedule
B calendarschedule

m TriggerSchedule
m Save c Refresh

Priority Priority Rename Delete

Short summary is in the middle of the page
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6.4.8 Make the logic to control the physical point in the PCD device

The previous steps are describing how to add and configure the needed schedulers.
It is needed to transfer the Schedulers combined Out value to the data point which
is really communicated to the PCD Device. This point is called Enable_Light in the
Saia PCD Supervisor. In the PCD Device the application program monitors this Flag
and according to its state enables the light on/off.

Keep in mind. In the Calendar schedules we specified the Holidays, when there is
nobody in the building. During the specified time the Calendar Schedule output will be
high. We need to negate the output of the Calendar Schedule to get the correct logic.

1. Navigate in the Nav tree to the Scheduler folder. n
2. Double click to the Scheduler folder. The Wire Sheet pops up.

3. Open the kitControl Palette.
4

. Drag and drop the “And” and “Not” function block form the Logic folder to the Wire
Sheet.

5. Connect the function block together as the picture shows.

<> Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window Wire Sheet Help

= O ) My Network Calendar_Schedule_Light  [r5 Not [1]
Calendar Schedule Mot

Status [ok] Ot true fok]
B+ Datapoints Poll Scheduler in ~Jnull] In Talze {ok)]
-~ Out false [ok]
¥ Points Next Time ©1-Aug 17 12:00 AM CEST|
Next Value true Jok}|
© analoginput_1 |
© oigitalinput_ o

@ Digitalinput_1

. Weekly_Schedule_Light m
@ pigitalinput_2 Boolean Sched e
fok}

HRE
@

@ pigitalinput_3
@ pigitalinput 4 nut ""ﬂ
@ pigitalinput 5 mm: mﬂ».lut—ﬂm;:eﬁ
@ oizitalinput & J
© oigitalinput_7
0 enable_Light
[ Proxy Ext
& alarms
(O Histories

[l Device Infarmation

Gl Alarms Poll Frequency
6 secipnetwork
€ BacnetNetwork
Apps
© schematics
© schedulers
BB weekly_Schedule_Light
B8 calendar_Schedule_Light

The Out pin of the And Function box must be connected to the Enable_Light pin
IN16. But these Function Boxes are located in two different Wire Sheets.
We need to link these two pins together.

6. Open the Wire Sheet for the Scheduler folder (if it is not open). And select the And-
Function Box.
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7. Right mouse click to the Out pin of the And Function box, then select the Link
Mark command from the context menu.

Wire Sheet
Calendar_Schedule_Light Not
CalendarSchedule E | Not n l
o] true [ok
In falze [ok]

Weekly_Schedule_Light m
Boolean Schedule

Edit Tags
Make Template

Cut Ctrl+X

Copy Ctrl+C
Paste Ctrl+v
Paste Special

Duplicate

Delete

Link Mark

Link From "And"

Link To "And"

8. Navigate to the Points folder of the Device where the Enable_Light point is located.

9. Right mouse click to the Points folder and select the Wire Sheet form the views
menu.

10. Organize the Function Boxes on the sheet to get some spaces between them.

At first time you open this Wire Sheet the Function Boxes which are represent-
ing the Points in that folder are overlapping each other. The Function Boxes are
configured that way that the Out, In10, In16 pins are visible. Right now these pins
are enough for our work. But keep in mind that, the visibility of the pins are config-
urable, so many other pins can be set to be displayed.

The meaning of the pins can be checked deeply in the Niagara manual.

11. Right mouse click to the In16 pin of the Enable_Light Function Box.
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12. Select the Link from “And” command form the context menu.

<®» Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window  WireSheet Help

< o O0O-o a O 0 - B ¥ © 0 B X %
127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config . Drivers . SBCSystems . SBClpMetwork_Demo
- Nav Wire Sheet
Enable_Lighl

E@ O @Mer:twork dﬁeﬂnwﬁlgh

@ Services T

Views
'B Drivers -

6 NiagaraNetwork Actions

© secsystems  Edit Tags
6 SBClpNetwork_Demo ]

X TuningPolicies Make Template

Analoginput_
° Devicel fhimenciNi=t: FE  Cut Ctrl+X
o Alarm Source Info Ctrl+C
4= Datapoints Poll Schedul
I atapointsFo eduler EEEtE |:tl'l+"'il
Y Foints Digitallnput_
Eoalean Writab Paste Special
GAnaloglnput_l @ def
] ica Ctrl+
o p— ; Duplicate tri+D
o Digitallnput_1 Delete Delete
- Digitallmput_
o Digitalinput_2 Boolean Writab Find
@ pigitalinput_3 ol
o Digitalinput_4 | Link Mark
- —__ LinkFrom "And"
o Digitalinput_5 Digitalinput_ =
© pizitalinput e

13. In the pop-up window the link between the two Function Boxes must be defined as
the picture shows. The link can be checked by reading the text at the bottom left
corner of the window.

™ Link X
And [Source] Enable_Light [Target]
Facets e ing
|— Out e Inl0
[ NullOn Inactive = In11
Propagate Flags e ni12
e n A = |n13
w0 B e nld
-
= |nC == |nl5
= |n D e In16
we Fallback
Owverride Expiration
Min Active Time
Min Inactive Time
[ SetMin Inactive Time On Start
Link And.out-» Enable_Light.in16
OK Cancel

14. Click OK. The pop-up will be closed

15. In the Wire Sheet check the marks of the link and also check that the link is live. It
means that the Points/Enable_Light function box In16 pin follows the Schedulers/
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16.

17.
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And Function Box Out pin of the And function box.

@ SaiaPCD® Supervisor

<@ Saia PCD® Supervisor

File Edit Search

Bookmarks  Tools ~ Window  WireSheet  Help File Edit Search Bookmarks Tools Window WireSheet Help

@ wyetwork
w apps -
Q schematics O orivers
© schedulers O nisgaraNetwork
B Weekly_Schedule_Light © sec systems
B Calendar_Schedule_Light @ sscioNetwork Demo
Bnot X TuningPolicies
Bland @ Devicet
B Files © alarm sourcelnfo
(&) Hierarchy ¢ Datapoints Poll Scheduler
@ History £ points

The state Out pin of the Enable_Light function box normally follows the state In16
pin. The Out pin shows directly which value is downloaded the PCD device.

If the state of the Out pin has different value then the In16 pin the following can
happen.

A. The Out pin is forced by operator -> set back to Auto

Wire Sheet

fiEnable_Light Gllﬁ
Boolean Writab

Out_ truefok @1

Inio - Il

@[In1e true {ok
| Actions P Emergency Active
Digitall Ju r Inactil
Edit Tags Emergency Inacti

Out true falarm,unach ETTIEFEEF'I cy ﬂthD

Make Template .
Active

( Ctrl+X activ
Analoginput_ e
Numeric Writab

Ctr+C  Auto

B. - Other higher level of InX pin is getting value from somewhere.
- Check the logic if it is valid

Wire Sheet

Digital Input_ Enable_Lighd
Boolean Writab Boolean Writab
Out falsejuk[ﬂdeﬂ%ﬂut false Jok] @ 10

Init — Jrull}y Inic False ok
Ini& —{rull} & Ini6 true fok
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C. - Inside of the Function Box other InX pin is selected with value to override
the output.

- To check it double click to the Function Box.
The prioritized override technique of the Out pin is described in the Niagara

manual.
- The picture shows that, In2 overrides In10 and In16 to command the Out
pin.
. Drivers I SBC Systems o SBClpMNetwaork_Demo o Devicel . Points . Enable_Light
Property Sheet
@ Enable_Light (Boolean Writable)

[ Facets trueText=true falseText=false 3 @) -
[3 Proxy ext SBCProxyExt

ﬁ Status {ok}

[ Fault Cause

@ Enabled @ true

M Device Facets » o -

M conversion 12 pefault

Ml Tuning Policy Mame  |Default Policy

w= Read Value false {ok}

= \Write Value false {ok} @ 2

[ Memory Address 999

m Data Format Boolean
== Out false {ok} @ 2
= nl - [null}

false [ok] E3
== In2 [ null .fﬂlse
= |n3 - {null} ¥
w—nd - [null} ¥
= n5 - [null} ¥
= |nG - {mull}
= n7 - {null} ¥
= |ng - [null}
= |ng - [null} ¥
= nl0 false [ok} ¥
= nll - {null} ¥
= nl2 - [null} ¥
= nl3 - [null} ¥
- nld - {null} ¥
= nl5 - {null} ¥
= nl6 true {ok} ¥
we Fallback true {ok} ¥
W Override Expiration null
[l Min Active Time +00000h 00m 003
@ Min Inactive Time +00000h 00m 003]3]
ﬁ Set Min Inactive Time On Start . false
[ Media Type Flag
[l Comments
0 Refresh D Save
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Make the logic to control the physical point in the PCD device
using reference between the schedulers.

The previous steps are describing how to add and configure the needed schedulers.
It is needed to transfer the Schedulers combined Out value to the data point which
is really communicated to the PCD Device. This point is called Enable_Light in the
Saia PCD Supervisor. In the PCD Device the application program monitors this Flag
and according to its state enables the light on/off.

Keep in mind. In the Calendar schedules we specified the Holidays, when there is
nobody in the building. During the specified time the Calendar Schedule output will be
high. We need to negate the output of the Calendar Schedule to get the correct logic.

There is another more elegant way to make the connection between the Calendar
Scheduler and the Weekly Scheduler. The way is to define reference between them.

The Calendar Scheduler is higher in priority, so we need to make a reference from the
Weekly Scheduler to the Calendar Scheduler.

1. Navigate in the Nav tree to the Scheduler folder.
2. Double click to the Scheduler folder. The Wire Sheet pops up.

3. Double click to the Weekly_Schedule_Light. This will open the configuration win-
dow of the Scheduler.

4. Click to Special Events at the bottom of the page
5. Click to Add

6. In the pop-up window go to the Type and select Reference then click to OK.

™ Add X

Name Ewvent
Type Date

Date

Any Jul 2017 s
Date Range m

Week And Day
OK Cancel
Custom

7. In the next pop-up window it is possible to select to which Scheduler the reference
must be added. Here there is only one scheduler listed. Select Calendar_Sched-
ule_Light then click OK.

mr Add X

Mame Event

Type Reference

Calendars

slot:/Schedulers/Calendar_Schedule_Light

oK Cancel ‘

Manual Saia PCD® Supervisor | Document 27-651 ENG01 | 2017-09-27



Creating/Engineering a project Saia-Burgess Controls AG

Connect to 3rd Party Systems

8. The Event = Reference to the weekly scheduler is added. But it is “Unscheduled”,
can be seen in the right side.

<@ Saia PCD® Supervisor

File  Edit
127.0.0.1{Demo_Station]

() My Network
——
(O Histories
[ Device Inforn
Gl Mlarms Poll F
6 sacipletwork
 BacnetNetwork
Apps
© schematics
© schedulers
BB weekly_Schedule_Light
B calendar_Schedule_Light
& Files
(&) Hierarchy

@ History

- Palette
w X B |# rtcontrol

Q conversion
0 Energy
Q Hvac

O Latches

: Config

Help

: Schedulers I Weekly_Schedule_Light

4 PrevPage 4 PrevMonth  Today | NextMonth p

#  Scheduler ~

Next Page

Jul 2017

Sep 2017

Name

Event

Summary

Reference: slot:/Schedulers/Calendar_Schedule_Light

Switch_Off_due_Test Date:1Sep2017

® Add @ Edit

[ weekly Schedule | [#f] SpecialEvents | [H] Properties  (E) Summary

[™] save 7 Refresh

Priority W Priority  [T] Rename

K pelete

Unscheduled

3:00AM

&:00AM

9:00AM

12:00PM

3:00PM

6:00PM

9:00PM

EventStart |02:24 EM
EventFinish 02:24 PM

EventOutput [ ] null @ true

9. We need to define that during the Holidays, when the Calendar_Schedule_Light
is high the Weekly_Schedule_Light must be low. For that the complete time range
has to be defined to false.

127.0.0.1 (Demo_Station) . Station (Demo_Station)

() My Network

oo
® Histories
[ Device Inforn
‘ﬁ Alarms PollF
€ sBCipNetwork
© Bacnethetwork
Apps
o schematics
© schedulers
B8 Weekly_Schedule_Light
BB calendar_schedule_Light
@ Files
(&) Hierarchy

@ History

- Palette

W X DB |#§ vtcontrol

Q conversion
Q Energy
Q Hvac

O Latches

: Config

: Schedulers I Weekly_Schedule_Light

4 PrevPage 4 PrevMonth  Today | NextMonth p

#  Scheduler ~

Next Page

Jul 2017

Sep 2017

Name

Event

Summary

Reference: slot:/Schedulers/Calendar_Schedule_Light

Switch_Off_due_Test Date:1Sep2017

® Add

@ Edit

[ weekly Schedule | [#f] SpecialEvents | [H] Properties  (E) Summary

7 Refresh

[™] save
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Priority W Priority  [T] Rename

K pelete

3:00AM
&:00AM
5:00AM
12:00PM
3:00PM

6:00PM

EventStart [02:30 EM
EventFinish [02:30 BM
EventOutput [ ] null @ false
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11.

12.
13.
14.
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Save the settings

Test the configuration by adding the today to the Calendar_Schedule_Light. This
means create today as Holiday day.

Check that the Weekly _Schedule_Light Out pin goes low.
Remove the test setting from the Calandar_Schedule_Light.

Create reference between the Weekly Schedule_Light Out pin and the Enable_
Light In16 pin in the same way as it was described above.

As you see the Not and the And Function Boxes are not needed to realize the
same function.

@ Saiz PCD® Supervisor
< {:]
File Edit Search Bookmarks Tools Window WireSheet Help 5213 PCD® Supervisor
N File Edit Search Bookmarks Tools Window WireSheet  Help
4 O- o A O [ -~ = O
127.0.0.1 (Demo_Station)  © Station(Demo_Station)  : Config  : Schedulers
. 127.0.0.1 (Demo_Station)  © Station(Demo_Station) @ Config  : Drivers  : SBCSystems
~ Nav Wire Sheet
- Nav Wire Sheet
L O @ wmy Network Calendar_Schedule_Light  f17) @
= P Enable_Lighi
= Sats o ¥ O @ My Network Semenitngn @
O Histories n ~ [rull _ Ot false (o @3]
Out false {ok] In10 = i}
[l Device Information NextTime SiAug7 1200 A 10 Alsrm Source Info ©{ims True fokd
NextValue true Jok]
Gl Alarms Poll Frequency B¢ Datapoints Poll Scheduler
 seciphetwork % Points
 Bacnethetwork © Analoginput_1
Apps Yaakly_Schedule Light @ oizitalinput_
Joolean Schedule -
Q) schematics @ oisitalinput 1 —
Numeric Writab
Q) schedulers @ vigitalinput_2 .,
B8 Weekly_Schedule_Light @ vigitalinput_3 = i
B calendar schedule Light B nicitalinnut 2
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6.5

6.5.1

Manual Saia PCD® Supervisor | Document 27-651 ENG01 | 2017-09-27

Connect to 3rd Party Systems

If you have purchased an OPEN license and want to use values from non-Saia Bur-
gess Controls systems it is necessary to connect to the 3rd-party systems and add the

required points to the Saia PCD® Supervisor database.

Add the Required 3rd Party Drivers

1. In the Nav tree open the Station folder.

2. Open the Config folder.

3. Double click on Drivers. The view pane will show a list of installed Drivers (Driver

Manager).

4. Click on the New button. The New dialogue box is displayed.

amr Mew

Typeto Add 6 Bacnet Metwork
Mumberto Add |1 [1-100]

OK | Cancel |

x

In the Type to Add box select the required driver, e.g. ‘BacnetNetwork’.

5. Click OK. The following dialogue box is displayed.

" MNew

Name Type Enabled
GﬂacnetNetwcrk BacnetNetwork  true

. Name BacnetlNetwork

. Type Bacnet Network
. Enabled ‘ true
0K Cancel

X

B

Change the default network Name to be a meaningful name.

6. Click OK. The Driver Manager will now show the driver.

Name Type
6 MWiagaraMetwork Miagara Metwaork

) Bacnetietwork  Bacnet Network

Status
ok}
ok}

Enabled Fault Cause

7. You now need to configure the driver
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Configure 3rd Party Drivers

The configuration of each 3rd party driver is different, refer to the Tridium Niagara docu-
mentation for the details of the driver.

Add 3rd Party Points to the Database

The method of adding points to the database for each 3rd party driver is different, refer
to the Tridium Niagara documentation for the details of the driver.

Using the BACnet Driver

The ability to use values from a BACnet system is quite common and is supported by
Saia PCD® Supervisor. This section provides an overview of how to use the BACnet
driver with Saia PCD® Supervisor. For full details refer to the Tridium Niagara documen-
tation.

Configure the BACnet Driver
1. In the Nav tree open the Station folder.
2. Open the Config folder.

3. Double click on Drivers. The view pane will show a list of installed Drivers
(Driver Manager).

4. In the Nav tree open the folder for the already added BACnet driver (BacnetNet-
work) and double click Local Device.

5. Set the Object Id to the Saia PCD® Supervisor address on the BACnet network
(range 1-4194302).

Property Sheet
Bl Local Device {Local Bacnet Device)
(@ Status {fault}
Ml Fault Cause Invalid Object ID
[l Object Id device =i
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6. In the Nav tree open the BACnet Comm folder and double click Network and ex-
pand the IP port section also the adapter has to be chosen.

Property Sheet
Q Bacnet Comm (Bacnet Stack)
[l comm Control  Enable
li Client Bacnet Client Layer
li Server Bacnet Server Layer
li Transport Bacnet Transport Layer
W Network Bacnet Network Layer
[@ Router Table Bacnet Router Table
'. Ip Port NetworkPort: id=1 net=1 enabled max=2...
@ Network Number |1
M Link BfIP (none:0xBACO) Standard
[ Adapter Thinkpad USB 3.0 Ethernet Adapter
M Ip Address none
[ Udp Port 0xBACO
m Ip Device Type Standard
@l Bbmd Address null
@ Registration Lifetime +00000n 15m 005 3
E Broadcast Distribution Table  BDT: 0 entries
(Wl Foreign Device Table Foreign Device Table
[l Bbmd Debug @ false
[ Status [fault}
m Fault Cause java.lang.IllegalStateException: BACnet/
|+ Poll Service BacnetMultiPoll
[l Max Devices max
E Enabled . true
@ Port1d 1
W Port Info Annex J IP
[ Routing Enabled ®true
[l Maintain Routing Enabled @ false
W Minimum Router Update Time  [s00 ms
[ Router Discovery Timeout 5000 ms
@ Termination Time Value 120 s

7. Set the Network Number to 1.
8. Set Enabled to true.
9. Click 1.

File Edit Search Bookmarks Tools Window  PxEditor Help
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6.5.4.2 Discover and add BACnet Devices
In the Nav tree, open the Drivers folder and double click the BACnet driver. The view
pane will display the Bacnet Device Manager.
1. Click to Discover
The Configure Device Discovery dialogue box is displayed.
File Edit Search Bookmarks Tools Window Manager Help
127.0.0.1 [Demo_Station)  : Station (Demo_Station)  : Config  : Drivers  : BacnetNetwork
P o (& My Network Discovered
eMyHn&t:5243LTJDEGWFZ‘gLnbahds‘hnr\sywEll‘mm Device Name DeviceID Netwk MACAddr Vendor Model Objects
@ 127.0.0.1 (Dema_station)
& station (Demo_station)
A Alam
© config
@ services
 orivers
O niagaranetnork @ Configure Device Discavery X
g :j:nz:::‘:urk [l Device Discovery Config
B LocslDevice (Wl Device Low Limit [}
B BscnetComm (Wi Device High Limit 4194302
Ement TR Networks [ send Globalz slzelle;ctnll Clear All
Emr:;m (@i Wait Response Time 10 s
B EM::tfrTuhls ﬁ ﬂ
[ o Port
3 Monitor Database
X Tuning Polices Name Exts DevicelD Status MNetwk MACAddr Vendor Model FirmwareRev App SWVersion
© Apps
@ Files
(& Hierarchy
@ History
- Palette
W [X] B @ sbeoffineengineering BENew Folder | [J] New | & edit M cancel
B Ssis PG5 Data Import Wizard ©rsvach N =
If the address range of controllers is known then the Device Low Limit and Device

High Limit can be edited to reduce discovery time.

. Click OK.

The discovery process starts. A progress bar at the top of the pane indicates the
status of the discovery. Once the discovery is complete the devices that have been
discovered are displayed in the Discovered list.

®» Job Log

Status Timestamp Message Details

o Running
m Message
m Message
m Message

13-Apr-17 11:00 AM CEST
13-Apr-17 11:00 AM CEST
13-Apr-17 11:00 AM CEST

13-Apr-17 11:00 AM CEST

Finding BACnet Devices...
Who-ls: Local Broadcast All Devices
Found BACnet device (object!d device:1) at address 1:172.23.13.4:47808...

Reading parameters for device:1, 1of 1

ok
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ﬂ During the discovery process you can click on the »» button at the top
right corner to display a Job Log giving details about the discovery pro-

cess so far.

In the Discovered list select the device(s) from which values are required. To
select more than one device hold down the CTRL key and click on the required

devices.

<@ Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window Manager Help

127.0.0.1 (Demo_Station] ~ : Station (Demo_Station) @ Config  : Drivers @ BacnetNetwork

- Nav € /* Bacnet Discover Devices

P O () My Network Discovered
e My Host: 5Z43LTJOSGWF2.global.ds.haneywellcom Device Name Device D Metwk MAC Addr Vendor Model Objects
; Trainingscenter  device:l 1 172.23.13.4:04BACO  SBC Saiz Burgess Controls  PCD3.M5560 244

@ 127.0.0.1 [Demo_Station)
& station (Demo_station)
A alarm
© confie
@ services
 orivers
6 Nisgarahetwork
© s systems
9 Bacnethetwork
Bl LocalDevice

The discovery will also find SBC Saia Burgess Controls deivces that have
BACnet compatibility. In order to easily identify these devices sort the list
by Vendor by clicking on the Vendor column.

Click Add or drag the selected device(s) to the Database list.
The Add dialogue box is displayed.

t Search Bookmarks Tools Window Manager Help
@/ Bacnet DiscoverDevices
¥ O & My Network Discovered
e oo e Y SR Device Name Device D Netwk MACAddr Vendor Model Objects
@ 127.0.0.1 (Demo_Station) & Trainingscenter  device:t 1 17223.13.4:06ACD  SBC Saia Burgess Controls. PCD3.MSS60 244
<@ Add X
@ services Name Type DevicelD Netwk  MAC Addr Ensbled UseCov Max Cov Subscriptions &
O oners i@ Troiningscenter!  Hon Bocnet Deviee device:l 1 17225.1340BAC0 tue  tue  max
O nisgsraNetwork
[ Name =
© s system:
[ Type Hor
6 Bacnethvetwe
[ Device ID Gevice 1
Bl Local D
[l Netwk 1 [0-55535]
B sacnetcomm
[ MAC Addr 172.23.13.4: 0XBACO
(3l client.
[l Enabled @ true
[ Server
use Cov true
R Tensport L °
R Network (gl Max Cov Subscriptions  max
[l RouterTable
(g pPort oK Cancel
L3 monitor Database
X Tuning policies Name Exts DevicelD Status Nefwk  MACAddr Vendor Model FirmwareRev App SW Version
- t - .
9 () Wt & Tenngcenter @Q @O @ devieel R 1 172231340840
App:
& Files
(& Hierarchy
& History
- Palette
W [x] B @ sbooffineEngineering
KoNewFolder | [INew | #cdit @ Discover | M Concel _@Add | 3 Maich
B ssia PGS Data Import Wizard
@ Tsynch | A peviceld
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Review the settings for each device:

e |f required, change the device name in the Name box.

e [f multiple devices are listed, click on the device in the list (to highlight it) to view
its settings.

Check that the required devices have been added.

Add the required BACnet Points to the Database

This process allows you to add points, alarm configuration, schedules and histories
from previously discovered devices.

1. In the Nav tree, open the Drivers folder and double click the BACnet driver. The
view pane will display the Bacnet Device Manager.

2. In the Exts column of the Database list double click the required icon.

@ = Points

o = Alarm Configuration
@ = Schedules
O = Histories

The BACnet Point Manager is displayed.

[@ Saia PCD® Supenisor

File Edit Search Bookmarks Tools Window Manager Help

- Nav Database

¥ O (® My Network Name Qut ObjectlD PropertylD Index Read Write

(@ My Host : S43L TIOSGINF2.global.ds hon eywell.com

© spps
@ Files
(& Hierarchy

@ History

- Palette
W [X] D) @ sbeofflineEngineering

3 sai PGS Data Import Wizard

M New Folder | [l New | # Edit  §fiDiscover | M cancel (Dadd b Match B Tagit

L= ———— —

3. Click Discover
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4. The discovery process starts. A progress bar at the top to the pane indicates the
status of the discovery.

Once the discovery is complete, points are displayed in the Discovered list:

it Search  Bookmarks Tools Window Manager Help

n O- o A O [ g

| station)  : Station (Demo_Station)  © Config  : Drvers  © Bac

© / sanetbiscoverpoints
@ yetwork Discovered
P . Object Name Object ID PropertylD Index Value Description
P e o1 ns. multstatevaluet  presentisiue 1 secmuen sfungor
sc___ac Lo AKsas_ multstatevslues pr 2 sscmuen sfungor
s ™ — mulistatevslue2 presentislue 2 sscmuen shungor
SBC. :TC, *PCD_ ABSISBY:HMI multiStateValue:l  presentValue 3 SBCMurten
sc___ac Peo_amssaiim multstatevalues  presentisiue s sscmuen
e Lo p— oop 000 sechuren sfungor o2Regler
e Lo vE_RLT_PD oopss . 10000 schurten shungor
SBC_ :TC 101, VE_:PID loop:s 100.00  SBCMurten’ Luftung01 Regler
SBC_ :TC, 01, WT_:PID. loop:4 15.00 SBCMurten aftung01 Regler
e Lo kP oops . 000 sechuren sfungor
e o1 FrRT_P1D oop2 resentisioe 200 sschurten sfungor " Regler
e Lot ABLD_PD PyTem——— I Lofungor
SBC. :TC. 101, RL_T__:PID. 0.00 SBCMurten aftung01 E
Osc___c Lo FricUAREN nsctve SECHurten sfungor
Osc e Lot T_MOTSMRM_ ;1 Inoctive SBCMurten sftungor
Cancel
Database
Nome Out ObjectiD PropertylD ndex Read Write

5. In the Discovered list select the required points (values). To select more than one
point hold down the CTRL key and click on the required points.

Remember that Saia PCD® Supervisor is licensed for use up to a specific

n number of points. It is good practice, therefore, to only add points that are
actually required. Adding points that won’t be used by Saia PCD® Super-
visor will not only waste resources but also generate unnecessary extra
network traffic.

6. Click to Add or drag the selected point(s) to the Database pane.
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8. The Add dialogue box is displayed.

Saia PCD® Supervisor automatically chooses the most suitable writable
point type. However, this can be manually changed by selecting a point in
the list and choosing a different Item Type

<> Add X
Name Type Enabled Object ID Property ID Index  Tuning Policy
0 SBC, :TC, :PCD AULTT__ 1 NumericPoint  true analoginput:0  PresentValue -1 defaultPolicy
[ Name SBC, 1TC 1 EBCD,

li Type Numeric Point

[l Enabled @ true

[ object 1D Znalog Input o
li Property ID Present Value

[l Index —1

Ii Tuning Policy Name Default Folicy

li Data Type RERL

li Read unsubscribed

li Write readonly

li Device Facets min=-inf *C,max=80.0 *C,precision=1 *C,units="C,re... » -
li Facets min=-inf *C,max=80.0 *C,precision=1 *C,units="C,re... » ’9 -
Ii Conversion ’E Default

OK Cancel

9. Click to OK
10. The selected point(s) is added to the database.

Manager  Help

/' HonBacnetPointManager +

Nav 0 @/ secnettiscoverpoints swcess [
¥ o ® ynetwork Discovered 192 objects
ObjectName ObjectiD Property D Index Valu "

© iy Host SzLTI08GN el

e don____selmpry au S——_ sl am
B () sec. e, w01 2uiu @ A% X BuluftmotorOrehzshlRackmeldung.
CIE o1 011 chulungsraum TemperaturSolluersteller
Name Type Ensbled ObjectD Property
@ s < Ao moamd Kafferaum Temp.
s o s Eumpoint e muiSttelalies Presenty
BOsc___wc on 017 Sehulungsraum Temperatur
sec___c Lo aksas. Eumeoint e mutsatelalies Presenty
(s . 01 8L hbluftdruck
sec e ™ ks
(s e w01 2uL Buluftdruck
sec. o PCO____essavhm
(s e, w01, VE_RL Voreshitzer Rocklauftemperatur
sec e Peo____aessesmn
8 Local Device. & () sec. TC. Lo ABLTE Bbluftemperatur
O sec. o Lot RO0:CO2PID
B sscnctcomm CIE— o 2 Bulemperstur
O sec. Tc 101 VE_RL_T_iPID
B0 o1 03] Staungsraum Temp.
CIE Ao auun hussenlufcemperstur
BOsc___c or 001 Raumtenmpersturitshwertfo Frie Kahlung
o (s . w01 PR Fahrungstemperstur Mittehwert
X s e PeD_ vt
= ‘ Database Oobjects
O alem source nfo
®

Name Out ObjectiD PropertylD index

@ roms
© vl
O tams sinaneluesss
© schedules ——
© TrendLogs
@ confie O sec. e Lot. AULKLPISM_RMZ
© rors O sec. e Lot. AULKLPISM_RMA
g e O sec. TC. 01, NE_Y_SM_RMZ
= P
O sec. TC. 01, E
(- L — o z R T T —
Osc w01 P —
- Palette =]

® © B |§ booineengneerng

[ Pee—

MaNewFolder | QNew | & cdit  viscover | m conc Puatch @ Tapit

11. Repeat the above process to add points for each controller.
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6.6 Creating Schematics (Operator Views)

Schematics within Saia PCD® Supervisor are known as Operator Views
(Presentation XML -- Px).

This section describes how to create the most commonly required features of Operator
Views. For more in depth information please refer to the Tridium documentation.

It is recommended that you create a template page that contains features that are
needed on each page, e.g. a logo, outside temperature, navigation buttons, etc. It is
also recommended that you create a folder to store all the Operator Views, and another
folder to store any images used on the pages.

The following steps are required to create Operator Views:

6.6.1 Prepare the folder structures

Preparing a good folder structure for the used Images and Operator views will help
keeping the project clear and understable. The engineering work will be faster because
used elements can be easily found.

6.6.1.1 Create a Folder for the Operator Views

Operator Views can be created at any point within Saia PCD® Supervisor e.g. added to
a folder, device or a module. However, this can make engineering unnecessarily com-
plicated so it is recommend that a folder is created to contain them.

1. In the Nav tree open localhost > Station.

2. Right click Config and select New> Folder. The Name dialogue box is displayed.

- Nav A px

¥ O (%) My Network e

@ My Host: 57431 TID6GWF2.global.ds.honeywell.com
@ 127.0.0.1 (Demo_Station)
@ Station (Demo_Station)
A Alsrm
6 Config

© orivers <> Name x

ewlagarawemork ® Schematicsl

© sBcsystems
6 SBClpNetwork_Demao oK Cancel
6 Bacnethietwork
€ secipNetwark
@ pps

A Files

Hierarchy

@ History

Specify the folders’s name e.g. ‘Schematics’.

3. Click to OK.
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1. In the Nav tree open 127.0.0.1(localhost)>Station(Demo_Station).

2. Right click Files and select New> Folder. The Name dialogue box is displayed.

»

EO O @ My Network

@ My Host: SZ43LTJ0GGWF2.global.ds.honeywell.com

HF o owi

@ 127.0.0.1 [Demo_Station)
# Station (Demo_Station)
.‘ Alarm
6 Config
@ Services
6 Drivers
6 NiagaraNetwork
© sBCsystems
 seCipietwork_Demo
6 BacnetMetwork
 secipNetwork
@ apps
0 Schematics
B Files
@ Hierarchy
eHistor}‘ <™ Name for Mew Folder

@ Images

oK Cancel

3. Specify the folders’s name e.g. ‘Images’.

4. Click to OK.

Prepare Images

Any external images that are to be used on Operator Views must be created using a
3rd party graphics package and sized to the size required on the Operator Views.

Once the images have been added to Saia PCD® Supervisor they cannot be
changed. SVG (Scaled Vector Graphics) images can be used and scaled inside in the

Saia PCD® Supervisor.

Add Images to Saia PCD® Supervisor

To use images within Saia PCD® Supervisor they must exist within the file structure of

Saia PCD® Supervisor.

1. In the Nav tree open My Host > My File System and navigate to the file that is to
be added (this could be a folder containing multiple graphics).

2. Right click the file or folder and select Copy.

3. In the Nav tree open My Host > Station(Saia PCD Supervisor) > Files and navi-

gate to the location the image(s) are to be stored

4. Right click the location (e.g. images) and select Paste.
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6.6.1.5

Customize the basic PX Template Page

Operator Views are created using the template PX Page (located - My Host > Sys
Home > defaults > workbench > newfiles > PxFile.px). By editing this page all future
Operator Views created will have this format.

1. In the Nav tree open My Host > My File System > Sys Home > defaults > work-

bench > newfiles.
2. Double click the PxFile.px file.

3. On the menu bar click the # icon to switch to PX Editor view.

File Edit Search Bookmarks Tools Window  PxEditor  Help

. defaults  : workbench  © newfiles

* Pafile.px

My Host: SZA3LTJ06GNF2 globaldshoneywellcom @ MyFileSystem @ SysHome

¥ C ) My Network
@) myFile System
1 sysHome -
© usertome ® Properties X
c
e CanvasPane ‘ @ B
(-]
£ CanvasPane
O background [ ] cefaut)
s S ™ iewsie x
(=34
Y halign Center Width |g00 [0.00-10000.00]
i Height |g00] [0.00-20000.00]
O vyModules nyes
&Y Platiorm scale flone 0K Cancel
@ 127.00.1 (Demo_Station) valign Center
B station (Demo_Station) viewSize  |500.04000 E
A e visble  |true
© config
@ sences ok | cancel
6 orivers
6 NisgaraNetwork
Q sBCsystems

6 sBCipNetwork Demo

6 Bacnethietwork

6 saciphetwork
Apps
© schematics

B ries

Q resources
() saia_PCD_Supenvisor_Sbus Demo_HC
Q offline
a1

Qaaqk g

n The grid in the middle of the screen is the viewable area of the page.

4. Design the page layout as required.

5. Save the file (select File> Save, or press CTRL+S).

Manual Saia PCD® Supervisor | Document 27-651 ENG01 | 2017-09-27

6-99



Saia-Burgess Controls AG Creating/Engineering a project

Creating Schematics (Operator Views)

6.6.2 Create a PX Page

Operator Views are created by making a new view of an element in the Nav tree and
once a PX view is added it is the new default view of the element.

Operator Views are stored in the Saia PCD® Supervisor file structure, but are linked to
the element where the view has been attached.

To keep structure simple it is a good idea to create subfolders. These subfolders hold
the various schematics you want to create.

1. In the Nav tree open 127.0.0.1(localhost) > Station > Config and navigate to
where the PX Page is to be located

n 2. Right click the folder and select New > Folder. The Name dialogue box is dis-
played.

3. Specify the page’s name e.g. ‘HeatingCircuit1’.

P
- Nav 2]

L C ) My Network

@ My Host: SZ43LTJ06GWF2.global.ds.honeywell.com
Q My File System
0 My Modules
& Platform
@ 127.0.0.1 {Demo_Station)
@ Station (Demao_Station)
._‘ Alarm
e Config
@ Services
6 Drivers
@ Apps
o Schematics
© HeatingCircuti1

Q Files
D Images

D offline @ HesatingCircuitl

O e
D 0K Cancel
resources

© saia_Pco_supenvisor_Sbus_Demo_HC

> Name X

4. Click OK A folder is created.

5. Right click the folder you have just created and select Views > New View.
The New Px View dialogue box is displayed.

- Nav 3| Slot Sheet
siot " Name DisployNome  Definkion Flags Type  Facets

O Property 0 HeatingCireuts HestingCireutt Dynamic bajrolder

ok | _caneat
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6. Enter the name of the page (same as the folder just created) in the View Name
box.

7. Click OK The PX Page will be created based on the template page.

6.6.3 Edit a PX Page
The PX Editor is used to edit a PX Page.
1. In the Nav tree locate the PX file and double click on it.
2. On the menu bar click the # icon to switch to PX Editor view.

3. Change the page layout as required n
4. Save the file (select File> Save, or press CTRL+S).

6.6.3.1 Create or Change PX Page Elements

After creating a new PX Page or opening an existing page for editing use the following
procedures to design the page layout and content.

6.6.3.2 Setting the Page Size and Background
To set the viewable area size:

1. Double click the layout grid to open the Properties dialogue box.
2. Click viewSize to set the visible screen size in pixels (maximum 10000 x 10000).

3. Click OK.

To set the background colour:

1. Double click the layout grid to open the Properties dialogue box.

2. Click the background as required and select either Solid or Gradient and use the
colour picker to set the required colour(s).

3. Click OK.

To set the background image:

1. Double click the layout grid to open the Properties dialogue box.
2. Click the background as required and select Image.
3. Select the required image file and alignment settings.

4. Click OK.
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1. Right click the page and select New > Label. A label is added to the page.

2. Double click the label. The Properties dialogue box is displayed.

“®» Properties

Label

% Label

background l:l #ffffcd
blink false
enabled frue

font (default)

foreground l:l {default)

halign Center

image null
layer
layout

textlconGap 4.00

textTolconAlig Right

valizn Center

visible ftrue

wordWrapEna false

300.0,20.0,130.0,30.0

s

0K Cancel

e"

A
Z

1

X

3. Enter the required text in the text box.

4. Click OK.

6.6.3.4 Add an Image

Add your own image

Images are sized on the screen based on their native dimensions (pixel size) - you can-
not scale the image. Therefore, you may need to resize the image using your preferred
graphics editor before adding to the page.

1. Navigate to the required image using the Nav tree.

2. Click and drag the file to the layout grid and position as required.
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6.6.3.5

Add an Saia PCD® Supervisor

Saia PCD® Supervisor has some built in images that can be added to a PX Page.

Image

Open the palette containing the required graphics. The following palettes contains use-

ful images, but there are others

kitPx
etc

kitPxHvac
kitPxN4svg

available

(scalable vector graphics)

1. Navigate to the required image using the palette.

2. Click and drag the image to the layout grid and position as required.

Add a Dynamic Object (Value)

1. Navigate to the required value using the Nav tree.

2. Click and drag the value to the layout grid and position as required.

Covers elements like — logoff, buttons, PxInclude, line, rectangle

is a library of various hardware graphics — pumps, boilers etc
is similar to kitPx but all the graphics are SVG

3. When you release the mouse button the Make Widget dialogue box is displayed.

4. Select Bound Label.

oK Cancel

popupEnable(true

statuseffect |None

“®> Make Widget >
" Make Widget
Make = new widget that is bound to the ord.
station:|slot:/Drivers/SBC520Systems/SBCIpNetwork_Demo/Devicel/points/Heatingl/Outside/Temperature/PhysVal
@ Bound Label BoundLabel 21 S!
<> Include PxFile 2 Bound Label
<> From Palette background |[-] (default)
<> workbench view B false
P rti
<> Properties border 0.0 none black
<> Actions
bled true
<> TimePlot e
font (default)
& Format Text |2out.Values foreground [ ] (default
[ status None halign Center
[ Hyperlink image null
[ Mouse Over Mone layer
[ Border 0.0 none black mouseOver |None
[# Make Display Mame Label padding 0.0
text <ord> [ ]
texticonGap |%-00
textTolconalig Right
velign Center
visible true
wordWrapEnal false
% Bound Label Binding
ord <ord>
degradeBehay Mone
hyperlink null
TS sedisplayNameTtypeDisplayN:

5. Select Format Text and choose %out.value% to display the value.

6. Select Make Display Name Label to display the label.

7. Click OK.
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6.6.3.6 Add an Animated Image

Saia PCD® Supervisor has some built in images that can be animated depending on
value from the system.

1. Navigate to the value that is to be linked to the image using the Nav tree.

2. Click and drag the value to the layout grid and position as required.

3. When you release the mouse button the Make Widget dialogue box is displayed.
4

. Select From Palette.

80000000

z
HI

. Open the palette containing the required graphics
. Navigate to the required image using the palette.
. Select the required image.

. Click OK.

0 N O O
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6.6.3.7 Add a Setpoint Slider

A slider can be added to enable an analogue value to be adjusted.

1. Navigate to the value that is to be linked to the slider using the Nav tree.

Click and drag the value to the layout grid and position as required.

>~ wn

Select From Palette.

When you release the mouse button the Make Widget dialogue box is displayed.

5. Open the KitPx palette
6. Select SetPointSlider.
7. Click OK.
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[
@ Make Widget X
File Edit Search Bookmarks Tools Window PxEditor  Help = .
y Make Widget
Make a new widget that is bound to the ord.
4 oD O0O- o a O M - =
127.0.0. (Demo_Station) @ Station (Demo_Station)  : Config  : Schematics station:|slot:/Drivers/SBCS20Systems/SBCIpNetwork_Demo /Device Lip 1/Room/ Offset
<> Bound Label Slider oo
< Include PacFile Ao
K o (D My Network @ FromPalette enabled true
5 . .
@ roms < Workbench View nerement 1400
& Properties
[ Hesting! layer
£ Actions
0 sk — 100.00
< TimePlot
EH opMode min 0.00
B outside X B # ke arientation | Horizontal
A Return - -
B supel (B eoundiabel thumbBrush [ (default
upply
Mr ActionButton trackBrush  |<ord>
oom
EA Temperature HyperlinkButton alve S0.00
@ Basesetpaint ,I‘—l] saveButton visible true
() setpointoffset »J RefreshButtan £ SetPoint Binding
E Web Ej e ord <ord>
BackButton
® storms degradeBehay None
© Histories P ForwardButton
null
R Device Inform ¥ Logsffautton hypertink
evice Information
P . RebootButton summary  %edisplayName?typeDisplayNe |
DataPoll Frequency
© pseudo_Points [ uttoncroup popupEnablettrue
O Bacnethetwork @ Analogmeter widestEvent | octionPerformed
@ secipnetwork 11 sargresh widgetProper value
=] = setPointslider
pps
O schemati SetPointTogeleBution
chematics
SetPointCheckBox
Q) HeatingCircuitL =
@ Properties x
Slider - B %
2 Slider
Physval 5.4 enabled true
increment  |9-50
layer
layout 20.0,260.0,20.0,150.0
e 3.00
= -3.00
orientation  |Vertical
thumbBrush 1] (default
trackBrush | station:|slot:/Drivers/SBC IpNetwork_Demo/Devicel/points/Hi
value 0.00
visible true
% setPointBinding x
ard station:|slot:/Drivers/SBC IpNetwark_Demo/Ds 1/points/He
0.0
degradeBehay None
hyperlink | null
summary 95displayName?typeDisplayNamed =%.%
popupEnable| e
widgetEvent |ectionPerformed
widgetProper{ value
oK Cancel
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6.6.3.8 Add a Button to Adjust a Value

1. Navigate to the value that is to be adjusted using the Nav tree.
2. Click and drag the value to the layout grid and position as required.
3. When you release the mouse button the Make Widget dialogue box is displayed.

4. Select Actions.

window  Pxkditor  Help

<@ Make Widget

& ake widser
Make 2 new widgeL that s bound 1 theord,

IpNetwork 1 T

Actions

© setpointotrset
B wich

O cocnethictmork
© secipnetwork

ok Cancel

5. Select Set.
6. Click OK.
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6.6.3.9 Add a Link to Another Page
1. Navigate to the PX Page that is to be linked to using the Nav tree.

2. Click and drag the PX Page to the layout grid and position as required.
3. When you release the mouse button the Make Widget dialogue box is displayed.

4. Select From Palette.

< [ =R - I s 0 w- 1O B ¥ @ B X N a2 ¢ 0- Thaaanx g en

e

Open
Cancel

Open the KitPx palette.

Select HyperlinkButton.

Select the Hyperlink check box.
Enter the required text in the text box.

Click OK.

© ® N o o
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1. Navigate to the required history using the Nav tree.
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2. Click and drag the history to the layout grid and position as required.

3. When you release the mouse button the Make Widget dialogue box is displayed.

4. Select From Palette.

127.0.0.1 (Demo_station)

© Station (Demo_Station)

o () My Network

O niagaranetwork
Q secsystems
 secipietwork_bemo
X TuningPolicies
@ Devicel
© 4larm Source Info
¢ Poll scheduler
& Points

@ Alarms

@ nistories
& Logfile
(i pevice Information
Qll Data Poll Frequency
© Pseudo_Points
6 BacnetNetwork
@ Apps
© schematics
© HeatingCircuitt
& Files
(& Hierarchy

& History

~ Palette
w X 3§ ke

[A) BoundLabel
ActionButton
HyperlinkButton
™ savegutton

Z Refreshutton
[3 Exportutton

4 BackButton

P ForwardButton

i Config  : Schematics

© Aalerm.myalarmListMyName

© HeatingCircuitl

[ wbViewBinding
@ circulsrGauge

[0 Hyperlink

@ Make Widget x
" Make Widget
Make anewwidget thatis bound to the ord.
station:[slot:/Drivers/SBCS20Systems/SBCIpNetwork_Demo/Devicel/histories/Logfile
<> Bound Label WebWidget = 2 2
<> Include PxFile 2 Web Widget
& From Pslette enabled true
< Workbench View s viewwebChart:ChartWidget
<> Properties
layer
& Actions
visible true
W X D § webchart 2 WbYView Binding
<ord=
@ chart erd

oK Cancel

degradeBehay Mone

5. Open the webChart palette

6. Select Chart.
7. Click OK.
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6.6.4 Reuse Operator Views

Operator Views can be reused, saving significant engineering time.

Normally Operator Views are created by using a new view attached to a folder in a
centralised structure. However, as each PX Page is created in the file system in the ‘px’
folder, it is possible for a page to be reused by copying the file in the px folder and at-
taching it to the required folder.

1. Create a PX Page as required - see chapter 6.6.2 Create a PX Page
. In the Nav tree open 127.0.0.1 (localhost) > Station(Demo_Station) > Files > px.

2
3. Right click the PX Page that is to be reused and select Copy.
4

. Right click px and select Paste. The Name dialogue box is displayed. n
127.0.0.1 [Demo_Station) . Station (Demo_Station) : Files Lopx
- Nav
E@ o @MyNetwork

D Pseudo_Points
e BacnetNetwork
@ apps
D Schematics
O HeatingCircuit,
OHa
Qe
@ Files
D Images
Q offline
Q px
HC|
E=_
.
Q resourc Copy
Q saia_rcj
@ Hierarchy
@ Histary

- Palette Rename

Duplicate
Delete

I~ BEICIE WES Refresh Tree Node

@ HistoryService

@ Name X

@ ==

0K Cancel

5. Enter a name for the pasted PX Page.
6. Click to OK. The PX Page will be added.

7. In the Nav tree open 127.0.0.1 (localhost) > Station(Demo_Station) > Config
and navigate to where the new PX Page is to be located.
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8. Right click the folder and select New> Folder.
The Name dialogue box is displayed.

. Station (Demo_Station) : Config . Schematics

127.0.0.1 (Demo_Station)

) My Network

Q Pseudo_Points
6 BacnetMetwork

| cditTags lconFolder
1 TextBlock
Make Template
BooleanWritable
cut NumericWritable
Copy

EnumWritable

Paste

Paste Special

& Name *

@ Jslosr]|
OK Cancel

9. Specify the folder’s name e.g. ‘HC2'.
10. Click OK A folder is created.

11. Right click the folder you have just created and select Views > New View.

The New Px View dialogue box is displayed.

127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config

- Nav
E@ o @ My Network
D Pseudo_Points
6 BacnetNetwork
ADDS
D Schematics
© HeatingCircuit1
QHa
O Hea
@ Files ire Sheet
© images AX Property Sheet
Q offline [T roperty Sheet
O e :
] Edit Tags
Bh \ake Templat telation S
UEL plate Relation Sheet
(7]
&) 1 Cut New View
Copy
O resoun By Guide Help
DSaia_P Paste )
Bajadoc Help
[E) Hierarchy [ Special
o~ Spy Local
Duplicate
- Palette plica Spy Remote
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> Mew Px View b4

m New Px View
Create a new view on the component using a px file

View Name HC2

View lcon module://icona/xlé6/views,/view.png [

TargetMedia < Workbench PxMedia

Source & PxFile [~}
<> DynamicView
0K | Cancel |
12. Enter the name of the page created above in the View Name box. n

13. Click OK The File already exists dialogue box is displayed.

™ File already exists. x

File already exists.

A Reuse existing file unmodified.

Owverwrite existing file contents.

Reuse | Overwrite Cancel

14. Click Reuse.

15. Edit the page as required.
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Reuse a Generic PX Page

SBC PCD controllers often have the same control program and the associated Opera-
tor Views are identical, but reference data from different controllers. Or it is also possi-
ble that one controller has the same control program multiple times for multiple equip-
ment.

To reduce engineering time a PX Page with generic references to data in the controller
can be re-used for multiple controllers by attaching it to the required controllers (points)
in the Nav tree. In order to do this every reference from the PX page to the controller
(points) must be made generic, and the PX Page must be associated with the controller
or points folder.

Create generic PX page and make the ORDs relative:
1. Create a PX Page as required - see chapter 6.6.2 Create a PX Page.
2. Open the Bound Ords pane.

3. Double click on the first ord that references a value in the controller. The Edit ord
dialogue box is displayed.

<

atation: |slot:/Drivers/SBCS205ystems/SBCIpNetwork_Demo/Devici [ —  (Defaultview) -
> 0O-
OK Cancel

Original ORD in the Editfield:
"station:|slot:/Drivers/SBC$20Systems/SBClpNetwork_Demo/Device1/points/Heat-
ing1/Outside/Temperature/PhysVal"

4. Edit the ORD to make it generic by removing references to the site, LAN, and con-
troller. For example

1 Untitled - Notepad - O x

File Edit Format VYiew Help
station: |slot: /Drivers/SBC$28Systems/SBCIpNetwork_Demo/Devicel/points/Heatingl/Outside/Temperature/PhysVal

™ ord x
alot:butside/Temperature/Physval B - (DefaultView) =
> O-
OK Cancel
5. Click OK.

6. Press CTRL+S to save the page.
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Using Text Editor to make the ORDs relative

Text Editor can be used if more ORD has to be modified or the Relativize command

can be used.

Right mouse click to the page in the px folder to relativize
Select Views -> Text Editor

The content of the px file is shown in XML format.

[ 55 PCD Supervior 8 X
File Edt Search Bookmarks Tools Text Editor
127001 (0emo_Station) : Sttion (demo_Station) © Flles x <_se 7 Tectdtor -
T ncoding="UTF-5" 2>
- Nav =] 2 on XL -->
5 nedia-ruorkbench:iupiiedia®>
¥ o ® nynetvork s
= s
6
O sacnettietwork g
Avps 8
© aep: H
O sematics 10
1.
O Heatingcircuity 7 P
» Owar i
16+ cConvespane nomescontent” viewsizes"
(=1} 5
@ ries 16 <Plcture loyout="270.0,265.0,165.0,150. —Fie: Inages/SOC_sve_Files/GES002_6 M. 5vg" scale="Fit"/>
)
O mses 3B cpicture 1 350.0,230.0,150.0, 260, —File: MTnages/SBC_svg_F11es/GES0R1_6 M. svg” scale
19
O offline 20 <Picture 1 290.0,395.9,250.0, 150. i1e:ATnages/SBC_svg_Files/GES002_1 M. svs
2
Oe 3 cricture loyout-"160.0,640.0,250.0,150.4 *Files N Tnages/S0C_ove_Files/GE9002_6 1. v
Brciex )
26 cPlcture loyout-"190.0,235.0,150.0, 230. -Fide: Inoges/SOC_sve_Files/GES001 1 H.vg" scale="Fit"/>
B estingciruit px %
B Homesn % clabel lay .0,20.0,130.0,50. ating Clrcult * background="$¢£¢ce™/>
z
B Hezpx 2 <Label layout= 80.0,100.0,20.. =Pnysval®/>
»
[ e seneriepx 30 <SoundLabel layout="130.0,100.0,100.0,20.0"
O resources 510 BoundLabeldinding ord='station: | slot:Outside/ Temperature/PhysVal statustffect="none™>
2 Objectiostring nase."text” format--%out Valuek/>
© ssle_PCD_Supervisor_Sbus_Demo_HC 33 </BoundLabelBinding>
3 «/roundlesens
& ierrch e
36-  <Slider layout="750.0,240.0,20.0,150.0° min="-3.0" mox="3.0" increnent="0.5" value="3.0" orlentation="vertical">
- Palette @ 7 ord- i Toletuork. i — yervatues
E <IStatusToBrush nane-"trackBrush/>
39 </setpointpinging
® X B # ey 1o Ginnotation name-*usAmotstion” velue-"54,54,8°/>
s suaen
@ istoryservice b
3. CInagebutton 1ayout="630.0,100.0,100.0,20.0" text="Set>
© huditistorssenvice P "station: |slot:/oré Tptetuori T " widgetevent=" >
I 45 /Imagebucon
© Logtistoryser 23
O Histonpaintiis 47 clabel layoute"630.0,60.8,100.,20.0" texts"BaseSetpoint™/>
i
L3 HistoryPointistitem 49-  <BoundLabel layou 109.0,20.
+ O stensions so- SoundLavel S Iptesiork ctatusefect-tnonets
£ “ObjectTostrin Tornat=-Rout Naluex/>
3 Wumesinteral 2 </BoundLabelsinding>
535 </Bowndanel>
3 Nmericcov s
N —— S5. cImagebutton layout="10.0,569.0,100.0,3 —
s ‘Walucbinging hyperLini--filei px/Home.
» 3 eooieancor s izhnnotation name. wshmnotstion” valus."10,10,8°/>
3 enuminterval Ee </InageButton>
» 3 enumcov S chicture 1 290.0,155.0,140.0,100.0" inage="File: Images/SC_sva_Files/ACSO00_S. svE"
5
3 singreerval 8 clabel lajout:"640.0,200.0,100.0,20.8" text:"SetpointOffset />
&
3 suinecor 6. <BoundLebel loyou , >
@ HistoryGroup o5 EoundLavel 21050 Iptesiork Ststuseffect-tnone"s
5 <ObjectTostring nome="text- format=-Kout.Valuek"/>
B History v Shorteuts & </oundLsbersinding:
& </Boundlavel>
E
“Fithatio"/>

webEdtors-TextFicEdtorttheme=

<> Saia PCD'® Supervisor

File  Edit

Search

127.0.0.1 (Demo_Station)

Bookm Tools

! Station (Demo_Station)

Text Editor

Window
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5. fill up the Find edit filed and the Replace with edit field.

- Palette

]
®

000000

<Slider layout="750.8,248.0,20.98,158.8" min="-3.8" max="3.8" increment="8.5" value="3.8" orientation="vertical’
<SetPointBinding ord="slot:/Drivers/SBC$285ystems/SBCIphetuork Demo/Devicel/points/Heatingl/Room/Temperature
<IStatusToBrush name="trackBrush"/>

ReplaceAll

Associate a PX Page with a controller:

1.

o a &~ »w

Right click the PX Page that is to be reused and select Copy.

Right click the px folder in the Nav tree and select Paste. The Name dialogue box
is displayed.

Enter a name for the PX Page (e.g. HC_generic).
Click OK.
In the Nav tree navigate to the controller that the page is to be associated.

Right click the controller and select Views > New View. The New Px View dia-
logue box is displayed.

o New Px View x

m New Px View
Create a new view on the component using a pxfile

View Name

View lcon module://icons/x16/views/view.png ]

Target Media  <#» Workbench PxMedia

@ PxFile file:~pu/HC generic.px -
Source
&> DynamicView
0K Cancel
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7. Enter the name of the page created above in the View Name box.

8. Click OK The File already exists dialogue box is displayed.

4 File already exists. X
File already exists.
Reuse existing file unmodified.
Owverwrite existing file contents.
| Overwrite Cancel
e Edit  Sear okmarks  Tools  Window elp
S > T aaa ks 6
on) : Station ation)  © : oriver ems  : SECIpNetwork Demo  : Devicel 3
¥ C © My Network
© secsystems
O sBeipNetwork_Demo @ Properties s
X Tuningpolices Soundabel s R
© peviee 2 BoundLabel
© Alarm Sourcelnfo badkground [ ] (defaul)
Be pollscheduter ErE fose
@ points
borcer |0.0n0ne black [
B Heating1
Py bled k
N (default) []
B opode
B outide nd [ ety
A Temperature center
B retm il [
B suonly
2 room 1500,1000,1000.200 ]
Bw 4 e e over None
Aams
® g |00 [ ]
© Histories
=i sotOutsde/Tempersture/Physial [
- Palette ,, L 100
W X O @ sty | tertToix Right
Center
@ rstoryservice -
© auditHistoryservice o
O Lo b
el Binding x
slot:Outside/Temperature/Physval [ ]
degradeBehayNone.
) hyperlink  |null [ ]
A umma | displayName?ty peDisplayNamess =55 [ |
Hom popupEnablefrue.
statuskffect | None:
0K Cancel
[ stringcov

9. Click Reuse.
6.6.6 Dashboards

A Dashboard is an element on a PX Page which each user can customise to their re-
quirements.

To use dashboards the Dashboard palette needs to be opened and the Dashboard
Service needs to be added to the Services section of Saia PCD® Supervisor.

Dashboard panes are added to the PX view like any other Graphic, but it requires
some extra configuration.
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1. In the Nav tree open 127.0.0.1(localhost)>Stataion(Demo_Station) > Config >

Services.

2. Open the Dashboard palette and drag DashboardService onto Services. The

Name dialogue box is displayed.

127.0.0.1 (Demo_Station) : Config

* Station (Demo_Station)

- Nav

EQ O @ My Network

’ Station (Demo_Station)
‘ Alarm
e Config
@ Services

o AlarmService
@ BackupService
® CategoryService
@ JobService
@ RoleService
o UserService
o AuthenticationService
£|’ DebugService
@ BoxService

 Drivers

v FoxSend «s» Name
@ Hierard

@ History! @
O zudithi
© LogHistryoerm

DashboardService

OK Cancel

@ ProgramService
0 SearchService
o TagDictionaryService
TemplateService
@ WebService

-~ Palette

[} E] E idashboard

[ } DashboardService
. DashboardPane

3. Click OK.
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6.6.6.2 Add a Dashboard to a PX Page
1. Create the PX Page as required.

2. Open the Dashboard palette and drag DashboardPane onto the page.
3. Open the webChart palette.
4

. Drag either Chart or Circular Gauge onto the content of the Dashboard pane in
the widget tree.

- Widget Tree

D ScrollPane (Root)

% CanvasPane (Content)
. DashboardPane
E content

< o O0-ofC 0 w- @ B % © X N 0 ¢ o- Qaak o8
= = stion) ¢ Fil

B - Bound Ords 5]

- Properties a

[e— EN K1

2 webvndget

5. Go online
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6. Drag & Drop an analog value to the gouge

[t Sai2 PCD® Supervior

e’ " @CERANONE 3 Qo
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6.7

Set Up Saia PCD® Supervisor Users

Security of Saia PCD® Supervisor is controlled by users. The access rights of each
user determines what information the user can access and what things they are able to
change/configure.

To achieve this the security within Saia PCD® Supervisor is managed using three ser-
vices:

1. Categories

Categories define what areas of the system a user can access.

2. Roles

Roles are used to group the categories together that are required for a particular
job and to define the level of access to those categories.

E.g. a boiler engineer would only need access to the boilers but would require a
high level of access. Therefore a role would be required for the engineers that gave
high level access to the category that gave access to the boilers.

An energy manager would need information from all the plant but with a lower level
of access. Therefore a role would be required for the energy manager that gave
low level access to a number of categories covering all the plant.

Categories are assigned to roles using the Category Browser which is just another
way of looking at the Nav tree.

. Users

Users define which roles the user has, their password, expiry, web access view.
The ‘admin’ user is a superuser level access which has access to the whole sys-
tem. Because of this details of the admin user’s password should carefully con-
trolled.

To configure users the required steps should be followed:
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Configure Categories

Before creating the necessary categories it is necessary to plan what is required, you
should consider the users and the distinct areas, then work out ‘\Where’ needs to be
granted access and create a category for each of these.

To configure categories the required steps should be followed:

Add a Category

User and Admin categories are created by default and additional categories are added
using the Category Manager.

The Admin category does not relate to the Admin user used to engineer Saia PCD®
Supervisor.

1. In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config >
Services.

2. Double click CategoryService
The CategoryBrowser is displayed in the view pane.

3. Click the view changer box and select Category Manager.
The Category Manager is displayed in the view pane.

®> Saia PCD® Supervisor

Tools  Window

Search  Bookmarks CategoryBrowser  Help

File  Edit

127.0.0.1 (Demo_Station)

! Station (Demo_Station)  © Config

- Nav Category Browser
¥ o () My Network Inherit User Admin Category3 Category4 Categorys Category6 Category7 Categorys
- & Ao B Anism  nja )
© confi Oconfie  nia )
@ services S Files nfa )
O alsrmservice @History  n/a L]
@ Backupservice
@ CategorySenvice
@D user
D admin
@ sobservice

€D Roleservice
© userservice

Category Browser

Inherit User Admin Category3 Category4 Categorys Categorys Category7 Categorys

Awem s @
©config  nja (] .
Property Shaet
B iles nia L ]
cet

@nisoy s @
X Slot Sheet
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4. Click New The New dialogue box is displayed.

o Mew ot

Typeto Add ;5 Category
Mumberto Add |1 [1-100]

OK | Cancel |

5. Click OK The dialogue box changes.

W New *

Index Name ]
eS Heating_Circuits

F‘ Index 3

F‘ Name |Heating Circui tal

OK Cancel

6. Enter the name of the category in the Name box.

7. Click OK.

6.7.1.2 Set up the Categories

1. In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config >
Services.

2. Double click CategoryService
The CategoryBrowser is displayed in the view pane.

[ Saia PCD® Supenvisor
File Edit Search Bookmarks Tools Window CategoryBrowser Help
- Nav
¥ C ® My Network Inherit  User Admin Heating Circuits Category4 Categorys Category6 Category7 Categoryd
- - A narm nja
A alam ~ AL *
© confic O config nla e o
@ services Serices v
1Q alsrmservice Drivers v
@ Backupservice Apps. v
© Categorysenvice Oschematics e o o
HeatingCircuit v
Het v
its
He2 v
@ Files nfa o
0 vresre v
® Authenticationservice offline v
7 oebugsenice O e o o
ice HCLpx v
HC2px v
HC_generiepx v
HeatingCircuitLpx v
Home.px v
v
Saia_PCD_Supervisor_Sbus_Demo_HC v
Q) TagbictionaryService @wistory na LI )
- Palette & Demo_ststion e o o
W X D) [# webchat AuditHistory v
Hestingl_Outside_Temperature_PhysVal
@ chart
LogHisto
@ circularGauge Eristen v
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3. Grant each category access to the required areas of the system by clicking the

required rows in the column for each category. To grant access to elements lower
in the hierarchy expand the appropriate row and click.

Categories are a parent child system so selecting the top level will grant
access to every child element under that level.

The inherit feature enables the access of the User category to be copied to another
category. If there is a tick on the Inherit column for a row when that row is selected
for another category the access from the User category is copied to the other cat-
egory and removed from the User category. To reinstate access to the User cat-
egory click the row in the User column.

n Due to this it is potentially easy to accidentally remove rights.

A dot in a cell indicates access to that specific area. If the dot is black the access
will not be affected by the Inherit tick, if it is grey it will be affected.

It is recommended that the Admin category is given the same access in the Config
row as the User category i.e. leave the Inherit rows in the Config row are they are.
For the other rows (Alarm, Files, and History) the Inherit rows can be unticked to
enable you to specify the access more easily.

n By default the ‘Admin’ and ‘New’ categories will have no access.

It is recommended that the ‘Admin’ category has access to some of
the more complex areas of Saia PCD® Supervisor but not the whole of
Saia PCD® Supervisor.

4. Click M.

o0
mmx Sgia PCD® Supenvisar

Edit Search  Bookmarks Toolk  Window  Categoryg
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6.7.2 Configure Roles

Roles use the categories to define what areas of the system can be accessed. They
can have multiple categories assigned. It is best to configure Roles with job roles in
mind rather than specific areas like categories.

1. In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config >

Services.

2. Double click RoleService

The Role Manager is displayed in the view pane.

[® Saia PCD® Supervisar

File Edit Search  Bookmarks ools  Window

® My Network

A Aerm
© config
@ services
© Alarmsenvice
@ Backupservice
@ catezoryService

@ Hesting_Circuits
© Jobsenice

€ Roleservice

© usersenvice

O auth
&J pebugservice
@ Boxsenvice
¥ Foxservice

@ Hierarchyservice

© Tagdictioneysenvce

- Palette
- X
@ chart

@ circularGauge

D) | § webChart

CategoryBrowser  Help

Category Browser

A Alarm
O config
Services
Drivers
Apps.
O schematics
HeatingCircuitl
HCL
HC2
SFiles
Images
offline
Oex
HCLpx
HC2.px
HC_genericpx
HeatingCircuitLpx
Home.px
sssssssss
Saia_PCD_Supervisor_Sbus_Demo_HC
@ History
i Demo_Station
AuditHistory
Heatingl_Outside_Temperature_PhysVal

LogHistory

Inkerit U
n/a L
n/a L
v
v
v
L
v
v
v
nia
v
v
L
v
v
v
v
v
v
v
nla L
L
v
v
v

ser Admin Heating Circuits Category4 Categorys Categoryé Category7 Categorys

‘ n

3. Click New

imr [ew =

Typeto Add F. Role

Mumberto Add 1 [1-100]
OK | Cancel

4. Click OK

The dialogue box changes.

The New dialogue box is displayed.

™ New
Name Permissions \iewable Hierarchies
[ HVC O None
I'—'- Name HVC Operators

l'—. Permissions

l'i Viewable Hierarchies )}

[ superUser{access entire station, file system)

0K Cancel

»
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check box is NOT selected.

n It is recommended that the SuperUser (access entire station, file system)

5. Click >> next to Permissions.

The Permissions dialogue box is displayed.

< Permissions
Category CI;PF{'\TTD[ R-'llcll];:rlrl |
User
Admin
Heating_Circuits ¢
Category 4
Category 5
Category 6
Category 7
Category 8
oK | Cancel|

6. Specify the permissions for each category by clicking the appropriate column for

each category.

When you assign permissions, higher-level permissions (green check marks)

automatically include the lower level ones (grey check marks). For example, if you
enable admin level write (W), the system automatically enables admin level read
(R), as well as operator level read and write (RW).

The first column, Category, lists the groups to which you may grant permission.
The Operator and Admin columns relate to the permissions level configured on
each component. Below these headings are the cells to use for assigning one of
three permissions to each category:

R Read allows the user to view the object.
W  Write allows the user to change the object.
I Invoke allows the user to initiate an action related to the object.

Depending on how the permission level is set on the role, six permissions are de-
rived:

Permission Description
To allow a user to view operator level Check the Operator config flag on the slot and select the Operator R
information column on the permission map.

To allow a user to modify operator level
information (if it is not read only)

Check the Operator config flag on the slot and select the Operator
W column on the permission map.

To allow the user to view and invoke
operator-level operations (actions)

Check the Operator config flag on the slot and select the Operator |
column on the permission map

To allow the user to view admin level
information

Leave the Operator config flag unchecked on the slot and select the
Admin R column on the permission map.

To allow the user to modify admin level
information (if it is not read only)

Leave the Operator config flag unchecked on the slot and
select the Admin W column on the permission map.

To allow the user to view and invoke
admin-level operations (actions)

Leave the Operator config flag unchecked on the slot and select the
Admin | column on the permission map.
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7. Click OK.
8. Click OK A confirmation dialogue box is displayed.

9. Click Yes.

6.7.3 Configure Users

To configure users the required steps should be followed:

see chapter 6.7.4 Add Users 6.7.4

6.7.3.1 Configure NAV Files n

NAV files are used to define the PX Page that is displayed when a user logs in. Each
user must have a NAV file assigned. It is recommend that a folder is created to store all

the NAV files.

6.7.3.2 Create a Folder for the NAV Files
1. Right click Files and select New> Folder. The Name dialogue box is displayed.

«» Mame for Mew Folder x

o=

OK Cancel

2. Specify the folders’s name e.g. ‘NAV'.
3. Click OK.
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6.7.3.3 Create NAV Files

1. In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config and
navigate to where the NAV file is to be located

2. Right click the folder and select New> NavFile.nav. The Name dialogue box is
displayed.

127.0.0.1(Demo_Station)  : Station (Demo_Station)  : Files  © NAV

K o () MyNetwork

Apps
© schematics
© HeatingCireuits
QHeL
[=]¥>)
& Files
© Images

(=1
[ HeLex
(7 HeatingCircuitLpx
[ Home.px

[ Hez.ex
(3 He_genericpx
© resourees
O saia_PCD_supenvisor_Sbus_Demo_HC

O offline

New Folder

BogFilebog

HtmlFilehtml

Duplicate
* Palette pca
Delete

=X D A—

® chare Refresh Tree Node

CircularGas -
@ creorcouge (SRS

SyntheticModulesjar

Textile.xt

> Name for Mew File x

® Homel nav
OK Cancel

Specify the file’s name e.g. ‘Home’.
Click OK The file is created.
Open the folder containing the NAV file.

o a & ©»

Doubile click the NAV file. The Nav File Editor is displayed in the view pane.

@ Saia PCD® Supervisor hd - O X

File Edit Search Bookmarks Tools Window  Help

4 oD O- o & O [ - 2 0 a

127.00.1(Demo_Station)  © Ststion (Demo_Station)  © Files  : NAV  © Homenav #  NavFileEditor -

Result Tree 1objects

(@ My Network Display Name Target Ord ]

© schedulers
@ Files

Q) images

O offline

Qex

P Home  station:|sloty/

© resources
Q) szia_PCD_Supervisor_Sbus_Dema_HC

O nav

) Home.nav
(&) Hierarchy
~

- Palette

= G T (M kicontol ©®New | #Edit ) Delete 4 MoveUp ¥ MoveDown [ Show Components | [ Show Files
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7. Click Show Components.
8. In the Result Tree double click to the NAV file. The Edit dialogue box is displayed.

< Edit x

Display Name
& - (DefaultView) -

station: [slot:/

> 0-

module://icons/x16/home.png

OK Cancel

Target Ord

lcon

9. Click ™ - next to DefaultView. The Select Ord dialogue box is displayed. n

X

< Select Ord

e Config
. Station Name
. Sys Info
@ Services
. Save
6 Drivers
@ Apps

D Schematics

Type
@ slot
¢ Handle

0K Cancel

10. Navigate to the PX Page that is to be referenced by the NAV page and select it.

11. Click OK.
12. Click OK.
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6.7.4 Add Users

1. In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config >
Services.

2. Right click UserService and select Views > AX User Manager. The Ax User Man-
ager is displayed in the view pane.

«® Saia PCD® Supervisor s

File Edit Search Bookmarks  Tools  Window User Manager Help

4 o O-onf O [N e B g0 & XK

127.00.1 (Demo_Station) ~ : Siation (Demo_Station)  : Config  © Services  : UserService #  UserManager -

- Nav 7] Name Full Name Enabled Expiration Allow Concurrent Sessions Network User Languac ¥
[e] () My Network guest false Never true false

@ 127.0.0.1 {Demo_Station) admin true Never true false

& station (Demo_station) BACnet true Never true false
A tarm User Operator 1 true Never true true
© config

@ services

Q alarmservice

® Backupservice

® categoryservice
@ Jobservice

€D RoleService

1O userservice

® authenticationSery

- Palette

w [ A [l kcontrol # EDIT X REMOVE Bfy DUPLICATE

hitps://127.0.0.1/bajaux/webwidget/viewwebEditors:UserManagertheme=SBC&formFactor-maxguseL ocalWbRe=truedattach Afterinit=false

3. Click New. The New dialogue box is displayed.

™ MNew x

Typeto Add a User
Mumberto Add 1 [1-100]

OK | Cancel

Several users can be added at the same time. However, it is recommend-

ed to add users individually to prevent confusion when specifying pass-
words.

4. Click OK The dialogue box changes.
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5. Double click of the new user

Station (Demo_Station) . Config ! Services I UserService

Property Sheet

& Userl (User)
[ Full Name Operator 1
[ Enabled @ true
[ Expiration @ NeverExpires <> ExpiresOn [24-Jul-2017 11:59 BM CEST
[ Lock out @ false
[@ Language
[ Email

Password sessssss
Confirm ssssssss
[ Authenticator
Force Reset At Next Login .fﬂlse

@ NeverExpires < ExpiresOn [24-Jul-2017 11:59 EM CEST

Time Format {default)
li Facets
UnitConversion  Mone
[ Nav File null - )

li Prototype Name defaultPrototype
[ Network User @ true
@ Cell Phone Number

li Authentication Scheme Name DigestScheme

admin

[ Roles Engineer »
Energy manager

[ Allow Concurrent Sessions @ true

Type HTMLS Hx Profile

HxTheme SBC
Enable HxWorkbench Views . Yes

Enable Nav Tree Side Bar . Yes
Enable Search Side Bar . Yes
Enable Palette Side Bar . Yes
li Default Web Profile
Enable Mav File Tree . Yes
Enable Config Tree . Yes
EnableFiles Tree . Yes
Enable Histories Tree O
Enable Hierarchies Tree . Yes
Enable View Selection . Yes
Mobile NavFile |null - - )
li Mobile Web Profile Type Default Hx Profile

HxTheme

[l User Pin Level Galileo User Pin

O Refresh D Save

6. Enter the user’s username in the Name box.
7. Enter the users full name in the Full Name box.

8. If the user is to expire on a specific date select the Expires On option and specify
the required date.

9. Select the roles for the user in the Roles box.

10. Enter the user’s password in the Password box.

n Passwords must be 10 digits alpha numeric with one or more capital
letter.

11. Re-enter the user’s password in the Confirm box.
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To force the user to change the password when they next login set Force Reset At
Next Login to frue.

To force the user to change the password on a specific date, select the Expires On
option and specify the required date.

If the password is to expire on a specific date select the Expires On option and
specify the required date.

Specify the NAV file that is linked to the PX Page that is to be displayed when the
user logs in in the Nav file box.

Specify what happens when a user logs in from a web browser in the Default Web
Profile box.

In the Type box select the required option.

It is recommend that you select HTML5 Hx Profile as it will render the graphics in a
HTML5 format avoiding Java issues.

In the Hx Theme box select “SBC”.

Select Yes or No to specify whether the user has access to the following features:

- Hx workbench views
- Nav tree side bar

- search side bar

- palette side bar

- Nav file tree

- Config tree

- Files tree

- Histories tree

- Hierarchies tree

Click OK.
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6.8 Backup & Restore

To ensure that the Saia PCD® Supervisor configuration can be restored in the event of
hardware or software failure it is recommended that the Saia PCD® Supervisor station
is backed up. To reduce the risk it is recommended that the backup is performed in two

ways:

visor installation, platform password (normally PC login credentials) and the password
for the ‘admin’ user (specified when creating the Saia PCD® Supervisor station) are

available for use during any restore procedure.

n It is also important to ensure that the passphrase entered during the Saia PCD® Super-
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Backup the Configuration

Using the Station Copier
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The Saia PCD® Supervisor configuration can be copied from the localhost back to the
local computer. This is not a true back up but it is useful as it makes the configuration
available offline and thus reusable in future Saia PCD® Supervisor installations.

1. In the Nav tree right-click on Platform and select Views > Station Copier. The
Station Copier is displayed in the view pane.

® Saia PCD® Supervisor

File Edit Search Bookmarks

4 O- o & O
My Host: SZ43LTJ0BGWF2. global.ds.honeywell.com
- Nav
& o ) My Network
@ Wy File System
O wymModules
& Platform

@ Application Director

@ Certificate Management

@ Lesicon Installer

© License Manager

© Platform administration

@ station Copier

@ 1cr/iP Configuration

@) Remote File System

@ 127.0.0.1 (Demo_Station)
& station (Demo_station)
A Alsrm
© config
@ services
© Alarmservice
@ BackupSenvice
@ categoryService
@ Jobservice
€D Roleservice
© userservice
© Authenticationservice
- Palette

W [X] B | @§ webchart
@ chart

@ CircularGauge

Station Copier
5 Stationson thiscomputer

/C:/Users/EB14666/Niagaras.2/tridium/stations

Attila_test2

CertLab_04
Demo_Station

JACEO4

JACEQ4_final
SBC_SBUS_Test1
SBC_SBUS_Test2
SBC_TM2016_Workshop
StationSup04
Training_Center_V1

/  station Copier -

& Stationson "localhost”
-stations

Attila_test2

CertLab_o4

JACED4

JACED4.final
SBC_SBUS_Test1
SBC_TM2016_Workshop
StationSup04
Training_Center_V1

. In the right-hand column (Stations on “localhost”) click the station to be copied (e.g.
Saia PCD® Supervisor).

The Localhost is the live version of Saia PCD® Supervisor. Copying from left to
right will overwrite the live version with an older PC version. To copy the live ver-
sion to the PC it is RIGHT to LEFT

3. Click < Copy. The Station Transfer Wizard is displayed.

<®> Station Transfer Wizard

™ Transferring station "Demo_Station™
What name would you like the new station to have?

Station name Demo Station

4 Back | P Next

/ Finish X cancel
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4. Enter the name of the backup copy (e.g. Saia PCD® Supervisor Backup).

5. Click Next.

“®» Station Transfer Wizard

Which station files are to be copied?

% Transferring station "Demo_Station™

&> Copy files from selected directories

&> Copy only the "config.bog" station database file

4 Back ’

&> Copy every file in the station directory and its subdirectories

Finish K cancel

“®» Station Transfer Wizard

f'\ Transferring station "Demo_Station™
How do you want to deal with any existing files?

&> Delete the existing "Demo_Station" directory before copying

& :Overwrite existing station files with new files, while leaving otherfiles intact;

4 Back P Next

Finish X cancel

6. Select Copy every file in the station directory and its subdirectories.

7. Click Next.

8. If the station already exists in the destination you will be prompted to delete the
entire station, or just overwrite duplicate files. Select the required option and click

Next.

<@ Station Transfer Wizard

Please review yourchanges

('\ Transferring station "Demo_Station®

Please select the "Finish" button to start the transfer.

Allstation files will be copied from "localhost” to the local computer

‘ Back Next \/ FII\ISh ’ x Cancel
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9. Click Finish to start copying the files. Once the copy is complete the following dia-
logue box is displayed.

<®» Transferring station X

‘. ] Transferring station

Completing transfer:

° Savestation  Success
€D Transferfiles  Success

B L T e R L i T e e e P Ll o
~3tations/Demo Station/shared/Saia PCD Supervisor Sbus Demo HC/CPU001/ TCPIPDBX.src
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_ CFU001.inc
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_ CFU001.src
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_ CFU001_HLKSE M1
~3tations/Demo_Station/shared/Saia PCD Supervisor Sbus Demo HC/CEU001/_ CPUO01_ HLKSE M1
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_ CPFU001_Heating 1
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_ CPFU001_Heating 1
~atations/Demo_Station/shared/Saia PCD Supervisor Sbus Demo HC/CEU001/_CPU0O1 Heizung 1
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_ CFU001_Heizung 1
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/hdlog.fxp
~3tations/Demo_Station/shared/Saia_ PCD Supervisor_Sbus_Demo HC/CFUO001l/hdlogl.fxp
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/heating circuit.fs
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/Libs

~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/Saia PCD Supervisor Sbus
~stations/Demo Station/shared/Saia PCD Supervisor Sbus Demo HC/ lastopen
~3tations/Demo_Station/shared/offline/alarmdata/CFU00L.xml
~3tations/Demo_Station/shared/offline/engineering/system.bog

~3tations/Demo Station/shared/offline/hdlogsdata/CPU00L.xml
~3tations/Demo_Station/shared/offline/pointdata/CPU00L.xml

~stations/Demo Station/shared/px/HCl.px

~gtations/Demo_Station/shared/px/HC2.px

~3tations/Demo_Station/shared/px/HC generic.px
~3tations/Demo_Station/shared/px/HeatingCircuitl.px
~3tations/Demo_Station/shared/px/Home.px
~3tations/Demo_Station/shared/resources/AlarmTexts/CPU00L.xml

~stations/Demo Station/shared/resources/encodings.xml

Transfer complete.

Close

10. Click Close.

11. In the Nav tree open My File System and navigate to
C:/Users/MyUserName/Niagara4.3/Saia Burgess Controls/stations

12. Right-click the required station folder and select Copy.
13. Navigate to the required storage location (e.g. a plug-in memory device).

14. Right-click and select Paste.
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6.8.2 Using the Backup Service

Using the Backup Service the backup file has not only the content of the station but
also the default settings of the Workbench where the station was created and backed

up.
The user can as well specify, if the alarm or histories database should be a part of the
backup .dist file.

Doing a station backup, will prevent data-lose of the running station in case of hard-
ware or system failure.

Station backups are stored as ‘.dist’ files in
C:/Users/MyUserName/Niagara4.3/Saia Burgess Controls/backups

1. In the Nav tree open Station > Config > Services. n
2. Right click BackupServices and choose Views > Ax Property Sheet.

<@ Saia PCD® Supervisor - X

File Edit Search Bookmarks Tools Window Help

4 O 0O- B A O [ - [ a

127.0.0.1 {Demo_Station) @ Station (Demo_Station)  © Config @ Services  : BackupService #  AXProperty Sheet +

~ Nav Property Sheet
|=. o @ My Network @ BackupService (Backup Service)
- - (@ status {ok}
@ services (M Fault Cause
O alarmsenvice [l Enabled @ e
© Backupservice [l Exclude Files *.hdb; *.adb; *. Lock; *backup* ; console. *;col
@ categoryservice fle~history ® X
@ Jobservice fileshnalarm
D Roleservice (M Exclude Directories
O userservice
© AuthenticationService
LT pebugservice [ Offline Exclude Files *.lock; *backup*; console. *; config.bog.b* ;|
@ Boxservice ® X
¥ Foxservice
@ Hierarchyservice [ Offline Exclude Directories

@) HistoryService

© auditHistoryService
© LogHistoryservice
@) Programservice

8 searchsenvice

© Tsebictionsnysenvice
TemplateService
@ websenvice

3 saia PG5 Data Import Wizard
T PlatformServices

{ 1} pashboardservice

- Palette
w X B | § webchart
@ chart

@ circularGauge

7 Refresh [™) save

3. In the Exclude Directories box click file:*history and click .
4. In the Exclude Directories box click file:Aalarm and click .

5. Click Save.
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6. In the Nav tree double click BackupService. The Backup Manager is displayed in
the view pane.

4® Saia PCD® Supervisor - X

File Edit Search Bookmarks Tools Window  Help

127.00.1(Demo_Station) ~ : Station (Demo_Station]  : Config  : Services  : BackupService #  Badwp Manager -

K o () My Network Backups 3objects
@ services Timestamp Host  Path User ®

O Alarmservice ¥D) 12-Apr-178:27AMCEST  127.0.0.1  files/C:/00_SBC/01_Projects/Niagara_user_manual_pictures/backup_Demo_Station_170412_0826.dist  admin

@ Backupservice ¥D) 12-Apr-175:33PMCEST  137.0.0.1  files/C:/00_SBC/01_Projects/Ni anual_pictures/backup_Demo_Station_170412_1732.dist admin

D) 13-Apr-17 10:31 AMCEST  127.0.0.1  file:/C:/00_SBC/01_Projects/Niagara_user_manual_picturesfbackup_Demo_Station_170413_1030.dist admin

© huthenticationservice
& pebugservice
® Boxsenvice

¥ Foxservice

@ Hierarchyservice
@ Historyservice

Q) AuditHistoryService

Q) LogHistoryService

@ Programsenvice

@ Searchsenvice

Q) TagbictionaryService
TemplateService

@ webservice

B3 Saia PGS Data Import Wizard
 platformservices

b { ] pashboardservice

- Palette
W X B | § webchan

@ chart

@ circularcauge

“T) Backup

7. Click Backup. The File Chooser dialogue is displayed.

“® File Chooser X

E File Spaces Current Path
~backups

Syriesysen IR IR

A Bookmarks

o
o

Filename: backup Demo_Station_170501_1647.dist Save

Files of type: | Distribution File Cancel

8. If required rename the backup in the File name box.
9. Click Save.

10. Ensure the backup file is stored securely.
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6.8.3
6.8.3.1

Restore the Configuration

Restore Using the Station Copier

To restore a station copy follow the procedure described in chapter
6.8.1 Backup the Configuration but copy the station from left to right.

6.8.3.2

Restore the Station Using the dist file

1. Rename the backup.dist file to a zip by renaming the extension and unzip it.

2. Copy the unziped station to the User home station folder.

| @ 9 = | stations
Home Share View
* u o Cut x I New item = @ Open FH select all
w-| Copy path ﬁ Easy access = Edit Select non
Pin to Quick Copy Paste Move Copy Delete Rename New Froperties
access E] Paste shortcut ta to - folder - £ History DD Invert seleq
Clipboard Organize Mew Open Select
“ v P » ThisPC » OSDISK(C:) » Users » EB1 » Miagarad.3 » tridium » stations »
# Quick access MName Date modified Type
[ Desktop - DDC_Suite_27_EM_06 File folder
; Downloads P Demo_Station File folder
@ Documents - Derno_Station_from_backup File folder
. SBC_SUP_TrainingCenter_SBUS File folder
&=/ Pictures *

3. Use the station copier to copy it to the daemon home and start.

@ Saia PCD® Supervisor

File Edit Search Bookmarks

Tools  Window

0 -

My Host: S743LTJ06GWF2.global.ds.honeywell.com (Demo_Station)

Help

4 (7

~

> O- o A

o Platform

Station Copier

(& stationson thiscomputer

N
@ My Host: 52431710

&) My File System
A sysHome

/C:/Users/EB14666/Niagarad.3/tri o

DDC_Suite_27_EN_06

Dema_Station

Demo_station_from_backup

© usertom
S
(=]

SBC_SUP_TrainingCenter_SBUS

~ Palette
L

2

4

Station Copier -

& Stationson "localhost”
~a3tations

DDC_Suite_27_EN_06

Demo_Station
Demo_Station_2
p copy
SBC_SUP_TrainingCenter_SBUS
4 Copy
[I] Rename
X pelete
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7 Using Saia PCD® Supervisor

This section covers the general procedures for day-to-day use of Saia PCD® Supervi-
Sor.

Once configured Saia PCD® Supervisor needs to be running all the time to enable to

collect logged data, control occupation times, process alarms and allow users to ac-
cess information.

If AUTO-START was selected when the Saia PCD® Supervisor station was created, the
Station will be running whenever the PC is started and running.

If this is not the case the Saia PCD® Supervisor station must be started manually
see chapter “7.3 Manual start the Saia PCD® Supervisor Station”

Goto ..

7.1 Access Saia PCD® Supervisor
7.2 Use Saia PCD® Supervisor

7.3 Manual start the Saia PCD® Supervisor Station
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71 Access Saia PCD® Supervisor

Saia PCD® Supervisor can be accessed from a PC using the Saia PCD® Supervisor ap-
plication or from a web browser.

n When accessing Saia PCD® Supervisor from a web browser not all features are avail-
able.

711 Launch the Saia PCD® Supervisor Application
1. Click Start and choose All Programs.

2. Navigate to the Saia PCD Supervisor folder
3. Click Saia PCD Supervisor v1.0R
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4. The Saia PCD® Supervisor application window will open:

::-J Windows Update
M Wireshark Legacy
‘ Wireshark Attila

< XPS Viewer
7-Zip Documents

. Accessories

, FileZilla FTP Client Pictures
| Games

. LonMark

. Maintenance

Music

Notepad++ Computer

. PG5 Suite V2,2.221
. SaiaPCDSupervisor
L4 Alarm Portal

B Conscle

=] Demo Station Default Programs
[ Install Platform Daemen
“#» Saia PCD Supervisor Beta (Console) Help and Support
“#> Saia PCD Supervisor Beta

&% Uninstall 7

4 Back

Control Panel

Devices and Printers

| |Search programs and files Shut down

<®» Saia PCD'® Supervisor

File Edit

Web Browser View -

SoC

O My Ne
}:s o @ v SAIA BURGESS CONTROLS

SBChome.html

@ My Hast: STA3LTIOEEWFL
127.0.0.1 {Demo_Station)

@
supervisor

Saia PCD*

Host ID: Win-BCEF-FASD-6162-2CA6

Version: 1.0

D e magara4
- Palette End User Licence Agreement Version: 4.3.58.18
w X B 8kt

[A] BoundLabel Copyright Tridium, Inc 1996-2017
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7111 Log on

(of course the Platform must be running always).

1. In the Nav tree double click on Station. The Authentication dialogue box is dis-
played with a default user selected:

File Edit Search Bookmarks Tools Windoew  Help

127.0.0.1 [Demo_Station)

- Nav 127.0.0.1 (Demo_Station) 1 objects

¥ O &) My e Name Description "

@& Station {Demo_Station] Foxsession to a Miagara station
@ MyHast: SZ43LTJOEGWF2 5

|
127.0.0.1 (Demo_Station) |
@ Station (Demo_Station “®r Authentication x

| % Authentication
I Logon required for access
7 Realm
Name ip:127.0.0.1 [fozs:
Scheme  Fox(n4digest)

Credentials

Username

Change User
Password  [TTTTTIN]

[ Remember these credentials

OK Cancel

2. To select a different user click Change User, otherwise go to step 5.

5
4 Authentication M
% Authentication
Logon required for access
Realm

Name ip:127.0.0.1|foxs:
Scheme  Fox

Credentials

Username |

[#] Rememberthis user

OK Cancel

ﬂ Select the Remember this user tickbox to make this the default username.

3. Enter a new Username.

4. Click OK.

5. Type the appropriate password in the Password box.

6. Click OK The user associated navigation (and start page) will be invoked

71.1.2 Log off

1. When you have finished using Saia PCD® Supervisor it is important to log off from
Saia PCD® Supervisor to ensure that the system cannot be accessed by unau-
thorised users. Logging off requires you to disconnect from both the Platform and
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Station.

2. In the Nav tree right-click on My Host and select Disconnect. The Disconnect

dialogue box is displayed.

ﬁ Saia PCD® Supervisol

File Edit Search Bookmarks Tools Window Help

127.0.0.1 (SBC_SBus_Project) - Station (SBC_SBus_Project)

- Nav H%  Station (SBC_SBus_Project)

¥ O ) My Network Name Description

A Alarm Alarm Database
@ My Host: WIN-IFE3JET6IU

Disconnect
@ 127.0.0.1 (SBC_SBus_Proj i 54 The station configuration d

Open Platform File System accessed over Fi

Open Station Diagnostics information for
Hierarchy views of remote
My Spy

History database

Refresh Tree Node

Go Into

«m» Disconnect ‘ E

@ Disconnect from host "My Host: WIN-IFE3JETEIUL"T

3. Click Yes to disconnect.

7.1.2 Access Saia PCD® Supervisor from a Web Browser
1. Go to the IP address of the PC running Saia PCD® Supervisor. The Saia PCD®

Supervisor log on page is displayed.

B Cromy x % 1
& C | A Notsecure | b#tpg//localhost/ord

Your connection is not private
passwords, messages, or credit cards). NET:ERR_CERT_AUTHORITY_INVALID

O Automatically report details of possible security incidents to Google. Privacy policy

intercepting your connection. Learn more.

Proceed to localhost {unsafe

Attackers might be trying to steal your information from localhost (for example,

HIDE ADVANCED Back to safety

This server could not prove that it is localhost; its security certificate is not trusted by your
computer's operating system. This may be caused by a misconfiguration or an attacker

) (= o]

n Please contact your local IT-department to get certificate!

Manual Saia PCD® Supervisor | Document 27-651 ENGO01 | 2017-09-27
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2. Proceed to localhost

— [} x
<@ Login =
< C 1 | A Notsecure | b#ps//127.0.0.1/prelogin +r
an
Sr
SAIA BURGESS CONTROLS
Demo_Station
Username: | |
Use of this software is subject to the
End User License Agreement and other Third Party Licenses
© 2017 Saia Burgess Controls. All Rights Reserved | Data privacy and Imprint
- O X
«®» Config x
< C Y | A Notsecure | h#ps//127.0.0.1/ord/station:%7 Csloty/ g g
Config O ® 1} Property Sheet v [X]
QActions & Topics  [8 Slot Details
Display Name Value Commands

(@ Station Name Demo_Station
(@ Sys Info rd
@ Services Service Container
 Drivers Driver Container
Apps App Container
© Schematics Folder

3. Enter your user name.

4. Click Login.

5. Enter your password.

6. Click Login.

7-6 Manual Saia PCD®

If the correct certificates, are installed then the security warning is not
coming up. The connection is immediately built from the browser to the
server.
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71.21 Log off

1. Click “X”

: ; BB - o
«® Config x
& c 0O ‘ A Notsecure | b#fE://127.0.0.1 ford/station: % 7Cslot/ hid ! -
Config

Are you sure you want to log off?

YES NO

-~
2. Click Yes.
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Use Saia PCD® Supervisor

Once you have accessed Saia PCD® Supervisor it can be used in two different ways:

- 7.2.1 Using Saia PCD® Supervisor via Operator Views
-> 7.2.2.2Nav Tree

The method you use will depend on how Saia PCD® Supervisor has been configured,
your level of access and the tasks you want to do.

Using Saia PCD® Supervisor via Operator Views

Use of Saia PCD® Supervisor via Operator Views (PX Pages) requires more initial
configuration, but enables users to access the system using graphical pages tailored to
their requirements in a controlled way.

The Operator Views will have been designed to provide clickable links to either move
between pages or select particular controls (e.g. to change a set point, change occu-
pancy times, etc). When you log in you will be taken to a landing page from which you
can navigate to the required information and, if allowed, make adjustments. Simply
click on the links provided; the user interface should make it obvious what the link does.

Access the Operator Views
When you log on a PX Page will normally be displayed allowing you to navigate to
parts of the system that you have access to.

If a PX Page is not displayed and you want to navigate the system using Operator
Views you will need to display the required page from the Nav tree.

1. In the Nav tree open
127.0.0.1(localhost) > Station(Demo_Station) > Files > PX > and navigate to the
required PX Page (start page).

2. Double click the page.

Use the Operator Views
Navigation

Once a PX Page is displayed you will be able to navigate to other parts of the system
by clicking on the links provided. These links may be in the form of text hyperlinks but-
tons, or graphics with hyperlinks depending on how the page has been configured. The
display should make it clear the function of each item on the page.
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File  Edit Search Bookmarks Tools  Window Hel

The next and previous buttons ( * * ) can be used to move between the pages you
have already viewed.
Adjustments

If you have the authority and the page has been configured appropriately you may be
able to make adjustments by clicking on various graphical elements, e.g. sliders and
buttons.

I s |

The meaning and use of such items should be intuitive.

7.21.3 Use Dashboards

A Dashboard is an item on a PX Page that enables you to choose the information that
is displayed. Once you have set up the item it can be saved so that next time you visit
the page your selections are visible. Selections made by other users do not affect
yours. A PX Page may contain one or more dashboard items.

There are two types of dashboard item; Gauges and Charts.

Gauge

A gauge type dashboard appears as shown below and enables an analogue value to
be represented in a graphical way.

Un configured Configured
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Chart

A chart type dashboard appears as shown below and enables values to be represented
as a graph, e.g. histories. Time schedules can also be added enabling you to view the
occupancy state and when a parameter is at a certain value.

) B Today @ e ABO O = ® B Today @ ABOoO® ®©
Heatingl_Outside_Temperature_@hysVal

Un configured Configured

Configuring a Dashboard

Configuring a dashboard requires access to the Nav free.

Adding an item to a Dashboard

- Use the Nav tree to locate the point required.

- Drag the point onto the dashboard. For charts you can add more than one value.
Save a Dashboard
« Click ™ on the dashboard.

» Saia PCD® Supervisor

File Edit Search Bookmarks  Tools
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7.2.2

7.2.21

7.2.2.2

7.2.2.3

7.2.2.4

Using Saia PCD® Supervisor via the Nav Tree

Basic Controls and Navigation

To see the location of the following Saia PCD® Supervisor controls and features, refer

to the diagram on chapter “2.2 _User Interface Application (Host PC)”

Nav Tree
To show the side bar:

- On the menu bar select Window > Side Bars and ensure Show Side Bars is
checked.

To add a Nav tree to the side bar:
- On the menu bar select Window > Side Bars > Nav.
To remove a Nav tree from the side bar:

- Click the arrow to the left of the Nav tree title and select Close.

Palettes
To show the side bar:

- On the menu bar select Window > Side Bars and ensure Show Side Bars is
checked.

To add a Palette to the side bar:

- On the menu bar select Window > Side Bars > Palette.

- Click the file icon and select the Palette type from the displayed options.

To remove a Palette from the side bar:

- Click the arrow to the left of the Palette title and select Close.

Locator Bar
To navigate down the hierarchy:

- Holding the mouse over an item: a small arrow will appear.

- Click the arrow to reveal a drop down box and select the required option.
To navigate up the hierarchy:

- Click on an item in the bar to navigate back to that level.

Manual Saia PCD® Supervisor | Document 27-651 ENG01 | 2017-09-27 7-11



Saia-Burgess Controls AG Using Saia PCD® Supervisor

7.2.2.5

7.2.2.6

7-12

Use Saia PCD® Supervisor

To navigate to specific location:

- Click in a blank area of the locator bar and type the path directly into the box.

View Pane & View Changer
To change the view of a selected item:

- Click the view changer box and choose the required view.
Or

Right-click the item (e.g. in the Nav tree), then select Views > and the required
view.

Viewing and Changing values of a Point
To view a point value:

- Use the Nav tree to locate the point required.

- Double click the point (or right-click and select Views > AX Property Sheet) to view
its Property Sheet. The Out item will indicate the current point value.

To change a point value (writable points only):

1. Use the Nav tree to locate the point required, right-click the point and select
Actions > Set Value.
Or
Click the button that allows the value to be adjusted.

The Set dialogue box is displayed.

im» Set b4
3. 000 C
oK | Cancel ‘

2. Type the required value.

As default Saia PCD® Supervisor does not check that the value entered is
valid. The limits can be set for Numeric Writable. When the operator types
value outside of the limits the value will not be accepted.

3. Click OK.
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7.2.2.7 Viewing Alarms

Viewing Alarms Using the Alarm History

1. In the Nav tree open the Services folder (under Station > Config).

2. Right-click AlarmService and select Views > Alarm Db View. The Alarm History
is displayed in the view pane.

[«@> Saia PCD® Supervisor

File Edit Search  Bookmarks

4 B O~ o n

127.0.0.1{Demo_station)

- Nav
o]

=3 @ My Network

& My File System

@ My Modules

& My Tools

& Platiorm

@ 127.0.0.1 (Demo_Station)
& station (Demo_station)
A alerm
© config
@ services
© Alarmsenvice
@ BackupService
@ categoryService
@ Jobservice
D Roleservice
© userservice
© authenticationService
LT Debugservice
@ soxsenvice
¥ Foxserviee
@ Hierarchyservice
@ HistoryService
© AuditHistoryService
@ Loghistorysenvice
- Palette

L INES|
@ chart

[Jl whViewBinding
@ CircularGauge

D) | @ webChart

<

© Station (Demo_Station)

Tools  Window

: Config

Help

: services

B

: Alarmservice

Today

Alarm History
Timestamp

A 02-May-177:21:26 AM CEST
A\ 02-Moy-177:21:27 AM CEST
A 02-May-177:23:57 AM CEST
A\ 02-Moy-177:24:00 AM CEST
A 02-May-177:24:01 AM CEST
A 02-May-17 8:14:13AM CEST
A 02-May-175:33:57 AM CEST
R 02-May-17 9:33:52AM CEST
A 02-May-179:33:52 AM CEST

Source State
Normal
HNormal
Normal
HNormal
Normal
Normal
offnormal
Offnormal

offnormal

Ack State
Unacked
Unacked
Unacked
Unacked
Unacked
Unacked
Unacked
Unacked

Unacked

ayY 2 ®

Source
172.23.13.18: 19/ myAlarmList/ 7
172.23.13.18: 18/ myAlarmList/8
172.23.13.18: 19/ myAlarmList/ 5
172.23.13.18: 19/ myAlarmList/3
172.23.13.18: 19/ myAlarmList/ 2
SBCIpNetwork_Demo Devicel
Alarm

172.23.13.19: 19/ myAlarmList /4

172.23.13.19: 19/ myAlarmList/ 1

7 AlamDbView -

9 Alarms
Alarm Class Priority Message Text B
Default Alarm Class 255 ErrorT

DefaultAlarm Class 255 Errors

Default Alarm Class 255 Generalerror

DefaultAlarm Class 255 Powerbreakdown

DefaultAlarm Class 255 Short dircuit

DefaultAlarm Class 255 Ping Success

Critical Alarms. 55 Pump Error

DefaultAlarm Class 255 Window open

DefaultAlarm Class 255 Errorin Pump Heating

3. Use the selector box (top left) to choose the required period.
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Using the Alarm Console

To view specific alarm details:

Use Saia PCD® Supervisor

In the Nav tree open the Station > Config > Services folder.

The Alarm Console allows you to view details of each alarm, acknowledge an alarm or
add notes to alarms. Notes are useful to record actions (particularly for critical alarms)
such as who has been notified, contact numbers and agreed timescales for fixing the

problem.

Double click AlarmService. The view pane will display the Alarm Service wire

sheet.

Double click on the required ConsoleRecipient to open the Alarm Console:

® Saia PCD® Supervisor

File Edit Search

127.0.0.1 (Demo_Station)

Bookmarks

Tools  window

: Station (Demo_Station)

Wire Sheet

Help

- Nav 7 | wire Sheet
P O () My Network
File Alarm Bb Cortlz
) wyFile system I
O vy Modules Default Alarm Clazs
Alarm Class A
& MyTools
. 1
& Platform
@ 127.0.0.1 (Demo_Station) e ‘I s Tre =
& siation (Demo_station) ‘:'"“c"” BrrieR e
jarm I
A Alarm L J [Status {udJ
© config
@ services
O Alarmservice
@ BackupService
@ categoryservice
@ Jobservice
-
SBC Alarm Console
Time Range Tto 7 G)
Timestamp Source State  Ack State Source Alarm Class Priority Message Text
A 02-May-179:33:52 AMCEST  Offnormal OAcked/1Unacked 172.23.13.19:19/myAlarmList/4 Default Alarm Class 255 Window open
A 02-May-179:33:52 AMCEST  Offnormal OAcked/1Unacked 172.23.13.19:19/myAlarmList/1 Default Alarm Class 255 Errorin Pump Hesting
.‘ 02-May-17 8:33:5TAMCEST  Offnormal OAcked/11Unacked Alarm Critical Alarms 255 Pump Error
A 02-May-17 8:14:13 AMCEST  Mormal OAcked /2 Unacked  SBClpMetwork_Demo Devicel Defsult Alarm Class 255 Ping Success
A 02-May-17 7:24:01 AMCEST  Mormal OAcked/1Unacked  172.23.13.19:19/myAlarmList /2 Defsult Alarm Class 255 Shortcircuit
A 02-May-17 7:24:00 AMCEST  Normal OAcked/1Unacked 172.23.13.19:19/myAlarmList/3 DefaultAlarm Class 255 Power breakdown
! 02-May-17 T:23:5TAMCEST  Normal OAcked/1Unacked 172.23.13.19:1%/myAlarmList/5 DefaultAlarm Class 255 General error
‘ 02-May-17 7:21:27TAMCEST ~ Normal OAcked/1Unacked 172.23.13.19:1%/myAlarmList/8 Default Alarm Class 255 Error@
1_‘ 02-May-17 7:21:26 AM CEST Normal OAcked/1Unacked 172.23.13.19:1%/myAlarmList/7 Default Alarm Class 255 Error?
A 01-May-17 10:00:37 AM CEST  Offnormal 0Acked/1Unacked BacnetNetwork Trainingscenter Defsult Alarm Class 255 Ping Failed
A 01-May-178:32:22 AMCEST  Normal OAcked/1Unacked 172.23.13.19:19/myAlarmList/6 Default Alarm Class 255 Erroré
A 18-Apr-17 7:50:44 AM CEST Normal OAcked/1Unacked SBCIpMetwork CPUOOL Default Alarm Class 255 Ping Success
A 13-Apr-17 4:19:14 PM CEST Normal OAcked /36 Unacked slot:/Drivers/BacnetNetwork/Trainingscenter/alarms  DefaultAlarm Class 255 Narmal
.. 12-Apr-17 12:47:14PM CEST  Offnormal 1Acked /0 Unacked  172.23.13.19:19/myAlarmList/1 Default Alarm Class 255 Errorin Pump Heating
.‘ 12-Apr-17 :43:29 AM CEST offnormal 1Acked /0Unacked  172.23.13.19:19/myAlarmList/2 DefaultAlarm Class 255 Shortcircuit
.‘ 12-Apr-17 ::43:29 AM CEST Offnormal 1Acked /0Unacked  172.23.13.19:1%/myAlarmList /& Default Alarm Class 255 Erroré
.‘ 12-Apr-17 4323 AM CEST Offnormal 1Acked /OUnacked  172.23.13.19:1%/myAlarmList/5 DefaultAlarm Class 255 General error

Current alarms are indicated by a red icon, retuned to Normal alarms are
indicated by a green icon.

Manual Saia PCD® Supervisor | Document 27-651 ENG01 | 2017-09-27



Using Saia PCD® Supervisor

Saia-Burgess Controls AG

Use Saia PCD® Supervisor

4. Double click an alarm line to open the Alarm Viewer. This will list all current and

cleared alarms related to the same alarm condition:

® local| slot:/Drivers/SBCS2 SBClpNetwork_Demo/Devicel/points/Heating1/Supply/Pump/Alarm/Alarm x
Timestamp Source State AckState Source Alarm Class  Priority Message Text =
A 02-May-178:33:5TAMCEST  Offnormal  Unacked  Alarm  CriticalAlarms 255 Pump Error
A 15-Apr-17 10:45:40 AM CEST  Normal Unacked Alarm  CriticalAlarms 255 Pump Ok
A 18-Apr- Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok
A 18-Apr-17 Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok
A 18-Apr- Normal Unacked ~ Alarm  CriticalAlarms 255 Pump Ok
A 18-Apr- Normal Unacked ~ Alarm  CriticalAlarms 255 Pump Ok
A 18-Apr- Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok
A 18-Apr-17 Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok
A 18-Apr- Normal Unacked ~ Alarm  CriticalAlarms 255 Pump Ok
A 13-Apr- Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok
A 13-Apr-172:3T:58PMCEST  Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok
& Acknowledge Hyperlink P nNotes Review Video [¥] close
7
5. Double click an alarm to open the Alarm Record, giving full details of the alarm. .
<® Alarm Record X
Timestamp b2-May-17 8:33:57 AM CEST
Uuid 11£20d495-73ab-4601-82d8-8e650d54cabd
Source State Offnormal
Ack State Unacked
Ack Required true
Source Rlarm
local: |station: |slot:/Drivers/SBC Systems/SBCIpNetwork Demo/Devicel/points/Heatingl/Supply/Pump/Alarm/ilarm
Alarm Class Critical Alarms
Priority 255
Normal Time null
Ack Time null
User Unknown User
Alarm Data Alarm Value true
Count 21
Escalated
From State normal
Message Text Pump Error
Notes ))
Numeric Value 1
Offnormal Value true
Present Value true
Source Name Alarm
Status {ok}l @ def
Time Zone Eurcpe/Berlin (+1/+2)
To State offnormal
Alarm Transition Cffnormal
Last Update 02-May-17 8:33:57 EM CEST
4 | a Acknowledgze Hyperlink P Notes E] Close

To acknowledge an alarm:

1. Click the alarm in the Alarm Console or Alarm Viewer or open the Alarm Record

for a specific alarm.

2. Click the Acknowledge button.

Multiple alarms can be selected and acknowledged at the same time in
the Alarm Console or Alarm Viewer by clicking in conjunction with CTRL

and/or Shift keys.
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To view or add notes for an alarm:

1. Click the alarm in the Alarm Console or Alarm Viewer or open the Alarm Record
for a specific alarm.

2. Click the Notes button. The Notes window is displayed and any previously added
notes will be shown with a timestamp in the top section:

» Notes X

## 02-May-17 8:39 BM CEST - admin ##
There i3 a serious bug in the syatem. Do not panic!

My shift is over. I drink a beer.

P Add Note | E] Close |

3. Type any new details in the lower section and click the Add Note button to save, or
click Close to close the window without adding a new note.

ﬂ You cannot add notes to multiple alarms.

Viewing and changing Occupation Times (Scheduler and Calendar)
in Saia PCD® Supervisor

Changing the Weekly Schedule

The weekly schedule determines the occupation times for a normal week, i.e. no Spe-
cial Events apply.

1. In the Nav tree open Localhost > Station(Demo_station), navigate to the re-
quired WeeklySchedule.

2. Double click the WeeklySchedule. The Scheduler is displayed in the view pane.
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3. Select the Weekly Schedule tab.

4. Specify the required occupation times:

To add a new time period:
Drag the mouse in the required white area of the grid.

To make adjustments to existing time periods:
Drag the top or bottom edge of the green rectangles to the required time.

To set all day occupation:
Right click the day and select All Day Event.

To a apply a period a day’s times Monday to Friday:
Right click the day and select Apply M-F.

To remove a time period:
Right-click the rectangle and select Delete Event.

To remove all time periods for a day:
Right click the day and select Clear Day.

To copy a day:
Right click the day and select Copy Day then right click the day the times
are to be copied to and select Paste Day.

5. Click Save.

Editing Special Events

Special events enable different occupation times to be used on specific days.

1. In the Nav tree open Localhost > Station(Demo_station), navigate to the re-
quired BooleanSchedule.

2. Double click the WeeklySchedule. The Scheduler is displayed in the view pane.
3. Select the Special Events tab.
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4. Specify the required Special Events:

Add a special event
1. Click Add. The Add dialogue box is displayed.

4 Add *
Name Christmas

Type |DateRange

25 Dec Any Year m
Through
26 Dec Any Year m

oK | Cancel ‘

2. Specify a name for the special event in the Name box.

3. Select Date or Date Range in the Type box.

Specify the date(s) the special event applies to:

Date: Specify the day month and year in the appropriate box.

Date Range: Specify the day month and year for the beginning of the range in the
appropriate box in the top row and specify the day month and year for the end of
the range in the appropriate box in the bottom row

4. Click OK.
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Edit the times
» Click the special event for which the times are to be edited.
To add a new time period:
Drag the mouse in the required white area of the grid.

To make adjustments to existing time periods:
Drag the top or bottom edge of the green rectangles to the required time.

To set all day occupation:
Right click the day and select All Day Event.

To remove a time period:
Right-click the rectangle and select Delete Event.

To remove all time periods:
Right click the rectangle and select Clear Day.

To ensure non-occupancy outside the specified periods
Right click the day and select Schedule Defaults.

Rename a special event

1. Right click the special event that is to be renamed.

2. Click Rename. The Rename dialogue box is displayed.

Name Summary

Christmas = g nge: 25 Dec- 26 Dec
Add

Swiss52420Mational 524 Aug 2017
Edit
Rename

Priority
Delete

3. Enter the new name.

4®» Rename *

@ EnterMame

OK | Cancel

4. Click OK.
5. Delete a special event

6. Right click the special event that is to be deleted.
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7. Click Delete. The Confirm dialogue box is displayed.

™ Confirm x

@ Delete "Swiss52420National52420Day"
Yes ’ No

8. Click Yes.
9. Click Save.

Editing the CalendarSchedule

Use Saia PCD® Supervisor

If a CalendarSchedule has been added to specify days different occupation times are
used, these days can be edited by add or removing events from the CalendarSchedule.

1. In the Nav tree open Localhost > Station(Demo_station), navigate to the required

CalendarSchedule.

2. Double click the CalendarSchedule. The Scheduler is displayed in the view pane..

[c> Saia PCD® Superisor
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Use Saia PCD® Supervisor

Add a date
1. Click Add. The Add dialogue box is displayed.

@ Add X

Name Event

Type Date

Any Weekday 2 May 2017 m

OK Cancel

2. Specify a name for the special event in the Name box.

3. Select Date or Date Range in the Type box.

Specify the date(s) the special event applies to:

Date: Specify the day month and year in the appropriate box.

Date Range: Specify the day month and year for the beginning of the range in the
appropriate box in the top row and specify the day month and year for the end of
the range in the appropriate box in the bottom row.

4. Click OK.

Edit a date
1. Double click the date that is to be edited.

2. Edit the date as required.

Rename a date
1. Right click the date that is to be renamed.

2. Click Rename. The Rename dialogue box is displayed.

Name Summary

Christmas i rioe: 25 Dec- 26 Dec
Add

Swiss52420Mational 524 Aug 2017
Edit
Rename

3. Enter the new name.

<®» Rename X
@ EnterMame

OK Cancel

4. Click OK
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Delete a date
1. Right click the date that is to be deleted.

2. Click Delete. The Confirm dialogue box is displayed.
3. Click Yes.
4. Click Save.

7.2.210 Viewing a History (Graph)
1. In the Nav tree open the History folder (Station > History).

2. Open the folder for the required controller.

3. Double click on the history that you wish to view. The Chart view is displayed.

. [c> Saia PCD® Superisor - X

B @ B Today @ ABOO &
Heatingl_Outside_Temperature_PhysVal @ Heatingl_Outside_Temperature_Physval

40.000

20.000

0.000

20,000
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Use Saia PCD® Supervisor

Viewing Multiple Plot Graphs

To add another plot to the same chart:
Drag the required history from the Nav tree onto the Chart view.

Adjusting the Displayed Information

To change the displayed time period:
Use the selector (at the top left of the Chart view) to choose the required
time period.

To change the horizontal scale:
Mouse over the appropriate scale until the cursor changes to a double ar-
row.
Drag the mouse left or right to change the scale.

To change the vertical scale:
Mouse over the appropriate scale until the cursor changes to a double ar-
row.
Drag the mouse up or down to change the scale.

Viewing the Source Data

To view the source data in table form:
Click the View Changer and select History Table.

Exporting a Graph or Data Table

1. In the Nav tree, right-click on the required history and select Export. The Export
dialogue box is displayed.

2. In the Select Exporter box select the required export type and file format.
3. Choose the export method (e.g. Save to File).
4. Click OK.

Viewing Live Updates

1. View the desired plot (as described above) and change the view to History Chart.

2. Click the Play button » to start getting history updates. At the bottom right corner
of the window the message ‘Waiting on first Live Update...” will appear.

3. When the time period has elapsed the message will change to show ‘Last Live
Update’ with the date and time of the update.

If you zoom in on the chart, live updates will not be visible anymore. If you

need to see values that are not visible on the chart you need to switch to
History Table view
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7.3 Manual start the Saia PCD® Supervisor Station

1. In the Nav tree open
My Host > Station(Saia PCD® Supervisor) > Platform > Services.

2. Double click Application Director. The Application Director is displayed in the
view pane.

[ Sa PCDO Supenisor -8 X

Fle Edit Search Bookmarks Tools Windoy

4 D-o A O o =~ B b B
My Host: SASLTIO6GNF2 gobaldshoneywellcom © Platforn 7 hopliestionDirectr +
- Nav [ Applicat rector
¥ o © wyvework Connecedtolocathost
Name Type Status  Detals AutoStart Restarton Fallure "
X o M P o
Oesie Hcenn o soion e foxnlafooniptpnitpes fobe e
£ iyTonts 5 bemo_Station station lde  foreISlLfonmOIL hipen/ahtipt3 tue e
e plaiom SN sation dle  fornafomsniohtpn/ofitpna  false  tue
® applicston birector 5 sacee final station ldle  foen/afos=n/ahtip=n/ahttpsn/a  false e
Q cenicteansgement P —— e me
© tesconstler SRR ——, e e
O S sttionsupos saton 1dle e e

O Putomadninisiaten
© sstoncoper

E roining Center 1 saton I e we

© cp/p configuration TED (10300 1: nz my-n cn:sr Shoiplriver] +eves Signed value in converclvukuv‘lnsiwnedlnt i 3 -ie B Auto-start
3 Fo 10 2 s+xes Signed value in cor 15
@ RemoteFilesystem TEQ [10; SoclpDriver] *k4+ Signed value in [ Restarton Failure
e 10 Sbclpbriver] +++++ Signed value in mvmnyumumsmmm
= R0 [10! Schbriver] e Sied value in comverananesnedtns 1o (i 17
& Station (Demo_Sation) o 10 #1445 Signed value in cor edlns is stop
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R0 [10! Shclpbriver] *++++ Signed value in converthycehrrayToSignedlnt Restart
meo 10 #1445 Signed value in comvertByteArrayloSignedInt s 9
10 Sbclpbriver] +++++ Signed value in convercBytenrrayToSignedin: ia ::: -187 Reboot
1E0 (10! Tobriver] whes in convertByceher 1
R0 10 = il
Sbclpbriver] tiees
ko SoctuDriver] euess Dump Threads
)
1E0 Sbclpbriver] tiees Sarcbod]
o ScTpbriver] tiass Verify Software
SocTplriver] *ekes ue 1
1F0 SocTplriver] *hies value Clear Output
e #1445 Signed value in convertBycehrr
. SocTplriver] *+++ Signed value Pause Output
Palette B i Sbcpbriver] 4+t Signed value
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NE0 SbclpDriver] #++++ Signed value Stream To File.
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B8 Booleanschediie e Soclpbriver] 444+ Signed value in edlnt i3 .
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3. Click Start.
The station will be started, check that a ‘Station Started’ message is shown.
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A Annex

A1 Ilcons

In manuals, this symbol refers the reader to further information in this man-
ual or other manuals or technical information documents. As a rule there is
no direct link to such documents.

n This sign accompanies instructions that must always be followed.

A.2 Using the Extended Support Options

Saia PCD® Supervisor has the following extended support options that can be pur-
chased:

PCD8.SUP-OPC Extend the open protocol points with OPC client connectivity

PCD8.SUP-DB-CSV Extend the capability for the supervisor to interact with Microsoft
Excel

PCD8.SUP-DB-SQL Extend the capability for the supervisor to communicate SQL
Server

In order to use these options it is necessary to license Saia PCD® Supervisor with the
appropriate license.
See chapter 5 Licensing Saia PCD® Supervisor

For details of configuring and using these option refer to the Saia Burgess Controls
documentation.
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A3

A-2

Contact

Saia-Burgess Controls AG
Bahnhofstrasse 18

3280 Murten

Switzerland

Phone........ccceeeeiieeeeee +41 265803000
Phone support.................ooee. +41 265803100

FaX ..o +41 265803499

Email support: .........coevieeeens support@saia-pcd.com
Supportsite: ... www.sbc-support.com
SBC site: .ooeoiiiiiiieeeeeeees www.saia-pcd.com

International Represetatives &
SBC Sales Companies: ......... www.saia-pcd.com/contact

Saia Burgess Controls Technical Support are only able to provide support for

Saia PCD® Supervisor and the Saia Burgess Controls driver features described in this
manual. They are unable to provide support for 3rd party drivers and undocumented
aspects of Saia PCD® Supervisor’s operation.

Technical Publications
Please send any comments on this or any other Saia Burgess Controls technical publi-

cation to support@saia-pcd.com.
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